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Preface

Intended Audience

Welcome to Release 11i of the Oracle Partner Management Implementation Guide.

This guide is intended for members of the vendor organization who are responsible for
implementing and administering the Oracle Partner Management application.

This guide assumes that you have a working knowledge of the following:

The principles and customary practices of your business area.
The Oracle Partner Management application.
Oracle Self-Service Web Applications.

To learn more about Oracle Self-Service Web Applications, read the Oracle Self-Service
Web Applications Implementation Manual.

The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the
Oracle Applications User’s Guide.

How To Use This Guide

The Oracle Partner Management Implementation Guide contains the information you
need to implement and administer the Oracle Partner Management application. The
guide contains the following chapters:

Chapter 1 provides a brief introduction to Oracle Partner Management and
highlights the key features of the application.

Chapter 2 provides an overview of other Oracle applications that must be installed
and implemented before you can implement Oracle Partner Management. The
chapter also describes the applications with which Oracle Partner Management
integrates.

Chapter 3 describes implementation and administration tasks that you might need
to perform for multiple Oracle Partner Management business flows.

Chapter 4 describes how to create vendor users and then assign
responsibilities, roles, and permissions.

Chapter 5 describes partner profile attributes and explains how to set up and
administer seeded profile attributes and create customized attributes.

Chapter 6 explains how to set up the partner dashboard and create partner
organizations and partner users.

Chapter 7 explains how to set up and maintain the channel manager dashboard.

XV



e Chapter 8 explains how to set up the various features of partner programs.

e Chapter 9 explains how to set up the various features that are used in the partner
program enrollment process.

e Chapter 10 describes the opportunity routing process and describes how to create
opportunity matching rules. It also describes how to set up and administer other
opportunity management features, such as opportunity-related notifications, channel
types, and timeout periods.

e Chapter 11 explains how to set up and perform on-going administration for
opportunity and lead referral benefits.

e Chapter 12 explains how to set up and perform on-going administration for deal
registration benefits.

e Chapter 13 explains how to set up and perform on-going administration for special
pricing benefits.

e Chapter 14 explains how to set up and perform on-going administration for partner
marketing fund benefits.

e Chapter 15 explains how to set up the partner locator, which allows potential
customers to use a variety of criteria to locate a partner that sells the vendor’s
products.

e Chapter 16 describes the process for integrating Oracle Partner Management with
Oracle Sales. This chapter applies to integration with Oracle Sales Patchset B
specifically.

See Related Documents on page [xvii for more Oracle Applications product information.

TTY Access to Oracle Support Services

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services
within the United States of America 24 hours a day, seven days a week. For TTY support,
call 800.446.2398.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible,
with good usability, to the disabled community. To that end, our documentation
includes features that make information available to users of assistive technology.

This documentation is available in HTML format, and contains markup to facilitate
access by the disabled community. Accessibility standards will continue to evolve over
time, and Oracle is actively engaged with other market-leading technology vendors to
address technical obstacles so that our documentation can be accessible to all of our
customers. For more information, visit the Oracle Accessibility Program Web site at
http:/ /www.oracle.com/accessibility / .

Accessibility of Code Examples in Documentation

XVi

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise
empty line; however, some screen readers may not always read a line of text that consists
solely of a bracket or brace.



Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or organizations
that Oracle does not own or control. Oracle neither evaluates nor makes any
representations regarding the accessibility of these Web sites.
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ICl [Summary of Gdncurrent Programs

Glossary

Related Documents

You can choose from many sources of information to increase your knowledge and
understanding of Oracle Partner Management. When you are referred to other Oracle
Applications documentation, make sure to use the Release 11i versions only.

Online Documentation
All Oracle Applications documentation is available online (in HTML or PDF versions).

¢ PDF Documentation: A Documentation CD is provided with each release. Refer
to this for current documentation for Oracle Applications products. The
Documentation CD is also available from OracleMetaLink and is updated frequently.

*  Online Help: You can refer to Oracle iHelp for HTML-based online help for Oracle
Partner Management. Oracle provides patchable online help, which you can apply
to your system for updated implementation and end user documentation.

Accessing Additional Guides

Oracle Partner Management shares business and set up information with other Oracle
Applications products. Therefore, you might want to refer to other guides when you set
up and use Oracle Partner Management.

You can read the guides online by choosing Library from the expandable menu on your
HTML help window, by reading from the Oracle Applications Document Library CD
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included in your media pack, or by using a Web browser with a URL that your system
administrator provides.

Printed guides can be purchased from the Oracle Store at http:/ /oraclestore.oracle.com.
Guides Related to All Oracle Products
Oracle Applications User’s Guide

This guide explains how to enter data, query, run reports, and navigate using the
graphical user interface (GUI). The guide also includes information on setting user
profiles, as well as running and reviewing reports and concurrent processes.

You can access this guide online by choosing "Getting Started with Oracle Applications"
from any Oracle Applications help file.

Guides Related to This Product

Oracle Sales Implementation Guide

This guide describes how to set up and administer the Oracle Sales application. Oracle
Sales is used to manage an organization’s direct sales channel. It is used to create and
manage leads and opportunities, customers and customer contacts, and sales campaigns.

Oracle Approvals Management Implementation Guide

Oracle Approvals Management is used to create and maintain approval rules and
approvers. Oracle Partner Management uses Oracle Approvals Management to manage
the approval process for deal registration, lead and opportunity referrals, partner
funds, partner program enrollments, and special pricing.

Oracle iStore Implementation Guide

This guide provides complete information on creating web sites based on the iStore
framework. Oracle Partner Management uses Oracle iStore to create the partner
dashboard and enrollment requests flows.

Oracle Marketing Implementation Guide

Oracle Partner Management integrates with Oracle Marketing to allow a vendor to create
marketing campaigns targeted toward partners. Refer to this guide for information on
setting up marketing campaigns.

Oracle Trade Management Implementation Guide

Oracle Partner Management integrates with Oracle Trade Management for

budgets, claims, and offers associated with partner funds, special pricing requests, and
opportunity and lead referrals. Refer to this guide for complete information on creating
budgets, claims, and offers.

Oracle Content Management Implementation Guide

Oracle Content Manager is used as an information repository for information that
appears on the partner dashboard and to store information associated with partner
programs. Refer to this guide for complete information on setting up and administering
a content repository.

Oracle Advanced Pricing Implementation Guide

Oracle Advanced Pricing is used to set up price lists and manage pricing for partner
programs. Refer to this guide for compete information on creating price lists that
calculate taxes, track customer discounts, and perform currency conversion.



Oracle Contract Management Implementation Guide

Oracle Partner Management integrates with Oracle Contract Management to provide
legal terms and conditions associated with partner programs. Refer to this guide for
complete information on creating and administering contracts and contract templates.

Oracle Trading Community Architecture Data Quality Management User Guide

Oracle Partner Management integrates with Oracle Data Quality Management to check
for duplicate customers, contacts, opportunities, and leads.

Oracle iPayment Implementation Guide

Oracle Partner Management integrates with Oracle iPayment to enable partners to pay
for partner program enrollment using electronic payment methods. Refer to this guide
for information on setting up the iPayment server.

Oracle Order Management

Oracle Order Management allows you to efficiently capture customer orders from
multiple sales channels and fulfill the orders. Oracle Partner Management integrates
with Oracle Order Management to process partner program enrollments, to fulfill special
pricing requests, and to provide data that appears on the channel manager dashboard.

Oracle Quoting Implementation Guide

Oracle Partner Management integrates with Oracle Quoting to allow partners to
create quotes for opportunities. Refer to this guide for information on setting up and
maintaining the quoting mechanism.

Oracle Workflow Builder Implementation Guide

Oracle Partner Management integrates with Oracle Workflow Builder to provide
notifications and notification flows for deal registrations, referrals, partner funds, partner
programs, and special pricing. Refer to this guide for information on creating new
notification flows, messages, and other notification-related tasks.

Oracle Territory Manager Implementation Guide

Oracle Partner Management integrates with Oracle Territory Manager to create channel
teams and territories related to deal registration and referrals.

Oracle Common Application Components Implementation Guide

Oracle Partner Management uses many of the components provided by Oracle Common
Application Components, including Notes, the Resource Manager, and the Task
Manager. Refer to this guide to make sure that these components are set up correctly.

Using Oracle HRMS - The Fundamentals

Provides overview information on setting up the organization structure for your Oracle
applications implementation. If you are implementing a standalone version on Oracle
Partner Management, you will need to set up an organizational structure.

Multiple Organizations in Oracle Applications

Provides complete information about modeling, implementing, and managing your
organization structure in Oracle applications.

Oracle TeleSales Implementation Guide

Your implementation of Oracle Partner Management must contain at least one internal
organization. Internal organizations can be set up through the Oracle TeleSales
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application; refer to the Oracle TeleSales Implementation Guide for information on
creating internal organizations.

Oracle General Ledger User Guide

Basic accounting information, as well as a business unit and set of books, for Oracle
partner Management is provided by Oracle General Ledger. Refer to the Oracle General
Ledger User Guide for information on setting up required organizational units and
other accounting features.

Oracle Inventory Implementation Guide

Oracle Inventory serves as the repository for products or collateral that can be ordered
from an organization. If an organization is implementing opportunity management and
plans to charge fees for partner program enrollment, Oracle Partner Management
requires that at least one inventory organization is identified through the Oracle
Inventory organization, and that other Oracle Inventory-related set ups be completed.

Oracle Advanced Product Catalog User Guide

Oracle Partner Management derives its product data using the product catalog provided
by Product Lifecycle Management. Many of the Oracle Partner Management business
flows have products associated with them, and thus a products hierarchy is required
for most implementations. Information about setting up and managing the product
hierarchy is found in the Oracle Advanced Product User Guide.

Oracle Receivables User Guide

Oracle Receivables is used during partner program enrollment to verify partner billing
and address information against tax locations.

Installation and System Administration

Oracle Applications Concepts

This guide provides an introduction to the concepts, features, technology

stack, architecture, and terminology for Oracle Applications Release 11i. It provides a
useful first book to read before an installation of Oracle Applications. This guide also
introduces the concepts behind Applications-wide features such as Business Intelligence
(BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications

This guide provides instructions for managing the installation of Oracle Applications
products. In Release 11i, much of the installation process is handled using Oracle
Rapid Install, which minimizes the time to install Oracle Applications and the Oracle
technology stack by automating many of the required steps. This guide contains
instructions for using Oracle Rapid Install and lists the tasks you need to perform

to finish your installation. You should use this guide in conjunction with individual
product user guides and implementation guides.

Oracle Applications Implementation Wizard User Guide

If you are implementing more than one Oracle product, you can use the Oracle
Applications Implementation Wizard to coordinate your setup activities. This guide
describes how to use the wizard.

Upgrading Oracle Applications

Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or
Release 11.0 products to Release 11i. This guide describes the upgrade process and



lists database and product-specific upgrade tasks. You must be either at Release 10.7
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. You
cannot upgrade to Release 11i directly from releases prior to 10.7.

"About" Document

For information about implementation and user documentation, instructions for
applying patches, new and changed setup steps, and descriptions of software
updates, refer to the ”About” document for your product. “About” documents are
available on OracleMetaLink for most products starting with Release 11.5.8.

Maintaining Oracle Applications

Use this guide to help you run the various AD utilities, such as

AutoUpgrade, AutoPatch, AD Administration, AD Controller, AD Relink, License
Manager, and others. It contains how-to steps, screen shots, and other information that
you need to run the AD utilities. This guide also provides information on maintaining
the Oracle applications file system and database.

Oracle Applications System Administrator’s Guide

This guide provides planning and reference information for the Oracle Applications
System Administrator. It contains information on how to define security, customize
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide

This guide explains how to define periodic and event alerts to monitor the status of
your Oracle Applications data.

Oracle Applications Developer’s Guide

This guide contains the coding standards followed by the Oracle Applications
development staff and describes the Oracle Application Object Library components that
are needed to implement the Oracle Applications user interface described in the Oracle
Applications User Interface Standards for Forms-Based Products. This manual also
provides information to help you build your custom Oracle Forms Developer forms so
that the forms integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products

This guide contains the user interface (UI) standards followed by the Oracle Applications
development staff. It describes the Ul for the Oracle Applications products and how to
apply this UI to the design of an application built by using Oracle Forms.

Other Implementation Documentation

Oracle Applications Product Update Notes

Use this guide as a reference for upgrading an installation of Oracle Applications. It
provides a history of the changes to individual Oracle Applications products between
Release 11.0 and Release 11i. It includes new features, enhancements, and changes made
to database objects, profile options, and seed data for this interval.

Oracle Workflow Administrator’s Guide

This guide explains how to complete the setup steps necessary for any Oracle
Applications product that includes workflow-enabled processes, as well as how to
monitor the progress of runtime workflow processes.

Oracle Workflow Developer’s Guide
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This guide explains how to define new workflow business processes and customize
existing Oracle Applications-embedded workflow processes. It also describes how to
define and customize business events and event subscriptions.

Oracle Workflow User’s Guide

This guide describes how Oracle Applications users can view and respond to workflow
notifications and monitor the progress of their workflow processes.

Oracle Workflow API Reference

This guide describes the APIs provided for developers and administrators to access
Oracle Workflow.

Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup and reference information for the Oracle
Partner Management implementation team, as well as for users responsible for the
ongoing maintenance of Oracle Applications product data. This guide also provides
information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals

Each eTechnical Reference Manual (€TRM) contains database diagrams and a detailed
description of database tables, forms, reports, and programs for a specific Oracle
Applications product. This information helps you convert data from your existing
applications, integrate Oracle Applications data with non-Oracle applications, and
write custom reports for Oracle Applications products. Oracle eTRM is available on
OracleMetalink

Oracle Applications Message Manual

This manual describes all Oracle Applications messages. This manual is available in
HTML format on the documentation CD-ROM for Release 11i.

Training and Support

Training

Oracle offers a complete set of training courses to help you and your staff
implement, administer, and use Oracle applications. Oracle courses are organized into
functional learning paths, so you take only those courses appropriate to your job or
area of responsibility.

You have a choice of educational environments. You can attend courses offered by
Oracle University at any one of our many education centers, you can arrange for our
trainers to teach at your facility, or you can use Oracle Learning Network (OLN), Oracle
University’s online education utility. In addition, Oracle training professionals can tailor
standard courses or develop custom courses to meet your needs. For example, you
may want to use your organization structure, terminology, and data as examples in a
customized training session delivered at your own facility.

Support

From on-site support to central support, our team of experienced professionals provides
the help and information you need to keep Oracle Partner Management working for
you. The team includes your technical representative, account manager, and Oracle’s
large staff of consultants and support specialists with expertise in your business

are, managing an Oracle server, and your hardware and software environment.

OracleMetaLink




OracleMetaLink is your self-service support connection withe web, telephone, and
e-mail alternatives. Oracle supplies these technologies for your convenience, available
24 hours a day, 7 days a week. With OracleMetaLink, you can obtain information

and advice from technical libraries and forums, download patches, download the
latest documentation, looks at bug information, and create or update TARs. To user
MetaLink, register at http://metalink.oracle.com.

Do Not Use Database Tools to Modify Oracle Applications Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser,
database triggers, or any other tool to modify Oracle Applications data unless otherwise
instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and
maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus
to modify Oracle Applications data, you risk destroying the integrity of your data and
you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an
Oracle Applications form can update many tables at once. But when you modify Oracle
Applications data using anything other than Oracle Applications, you may change a row
in one table without making corresponding changes in related tables. If your tables get
out of synchronization with each other, you risk retrieving erroneous information and
you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications
automatically checks that your changes are valid. Oracle Applications also keeps track of
who changes information. If you enter information into database tables using database
tools, you may store invalid information. You also lose the ability to track who has
changed your information because SQL*Plus and other database tools do not keep a
record of changes.
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Introduction

This chapter covers the following topics:

¢ [Oracle Partner Managehent Overview

Oracle Partner Management Key Features
Partner Dashboard

Channel Manager Dashboard

Partner [Profiling | |

Programs and Enfrollment

Opportunity Management

Referral Managément

Deal Registration

Special [Pricing Management

Partner Funds Management

Partner Locator] |

Oracle Partner Management Overview

The majority of Global 5000 businesses generate more than fifty percent of their
revenue through indirect sales channels. These companies require a functionally

rich and fully integrated partner management solution. Oracle Partner Management
fills this need by enabling vendors to efficiently and effectively manage business

with indirect channel partners, resulting in more successful and lucrative channel
partnerships. Oracle Partner Management streamlines and strengthens the entire partner
lifecycle, enabling companies to better recruit new partners, to more efficiently manage
existing partnerships, to more effectively market to and through partners, to sell

more with partners, and to measure the performance of partnerships. Oracle Partner
Management is part of the Oracle E-Business Suite, an integrated set of applications that
are engineered to work together.

Oracle Partner Management Key Features

The key features are:

e Partner Dashboard, page 12 \

e Channel Manager Dashboard, page 12 I
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e Partner Profiling, page [1H3 |]

e Programs and Enrollment, page [1H3 |]

e Opportunity Management, page [1H3 [

e Referral Management, page 14 |]

e Deal Registration, page 1H4 []

* Special Pricing Management, page 145 \

e Partner Funds Management, page 145 |]

e Partner Locator, page 1H6 |]

Partner Dashboard

The partner dashboard is the single entry point for all partners into the vendor’s
system. Using the dashboards, partners can:

e Self register and enroll into partner programs.

* Manage their partner program memberships, including upgrades and renewals.

* Access vendor stores, browse catalog catalogs, and place orders.

e Accept and manage assigned sales opportunities, create quotes, and place orders.
*  Submit referrals, register deals, request partner funds, and request special pricing.
* Maintain organization and contact profiles.

* View notifications.

® Access targeted content such as product news, training information, and FAQs.

In addition, partners that are distributors can view their managed partners’ profile
information and invite new partners to join the vendor’s partner programs.

The partner dashboard displays a summary of transactions; partner users can navigate
from the dashboard to the transactional system. The list of transactions available
depends on the partner’s enrollments and role. For example, an authorized reseller
might be assigned sales opportunities.

Channel Manager Dashboard

The Channel Manager dashboard provides members of the vendor organization with an
easy to use, configurable interface. The Channel Manager dashboard provides channel
managers and channel representatives with a 360-degree view of their partners and
activities, thereby enabling them to make informed decisions.

The Channel Manager dashboard provides three main features:

* The Quick Links bin provides the user with hyperlinks to things such as
notifications, opportunities, and partner program-related benefits such as partner
referrals and special pricing.

¢ The Key Metrics bin provides the user with a consolidated view of his partners’
performance.

¢ The Partner Query tool allows vendor users to perform advanced searches for
partners based on partner profile attributes. Users can customize the criteria by
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adding or removing search attributes to tailor searches. Oracle Partner Management
integrates with Oracle Marketing to enable channel managers to generate partner
lists. These lists can then be used to run marketing campaigns and events thereby
enabling marketing to partners.

Partner Profiling

Oracle Partner Management provides a flexible profiling framework to capture

and track the attributes of a partner. The profiling framework supports fixed
attributes, information entered by the partner or channel manager, and derived
attributes, information calculated based on partner data and transactions. The profiling
framework provides a central repository to capture and track all partner related
information. Channel managers can use this information to differentiate partners and
provide better services, such as marketing funds, incentives, and opportunities.

Programs and Enroliment

Programs are used to segment partners and provide different benefits to partners. You
can create programs for existing partners as well as new partners. You can also recruit
and maintain partners with specific incentive packages. This will help increase and
maintain a strong partner community that will further help you to increase overall
market share and revenues.

Opportunity Management

A sales opportunity is pending sale that can be forecasted. Oracle Partner Management
extends the Oracle Sales opportunities model to support the assignment of indirect
opportunities to partners. New opportunities can originate from leads and marketing
campaigns, or can be entered manually. Sales representatives and channel managers can
assign opportunities to partners.

Opportunity Management provides vendors with flexibility when it comes to matching
opportunities with partners, and then routing the opportunities to the partners. Both
the partner matching process and the routing process can be automated fully by the
creation of rules. Matching and routing can also be partially automated, or can be
performed manually by a vendor user.

When you route an opportunity to a partner, the partner can view details about the
opportunity and accept or decline it. At any time, the partner can also abandon the
opportunity.

The key features are:

* A rules-based engine that can automatically processes leads, identify appropriate
partners for an opportunity, and route the opportunity to partners based on
opportunity criteria and partner profile.

¢ Workflow based approval and notifications.

e Multiple routing types allows the vendor to route an opportunity to one or multiple
partners.

e Ability to manually search for partners based on their profile.
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Referral Management

Referral Management enables partners to refer business opportunities that they
cannot fulfill directly to the vendor organization. For example, the partner learns of
an opportunity for a customer who is interested in a product that the reseller does
not sell. In this scenario, partners can submit a referral to the vendor and receive a
percentage of the revenue.

The key features are:

e Partners can submit referrals online and track the progress of the referral from
submission to acceptance to payment.

* A configurable questionnaire allows the vendor to collect relevant information
about a potential opportunity.

e Workflow driven approvals and notifications allow the vendor to assign approvers
based on multiple criteria, such as geography, product lines, or partner types. Oracle
Workflow is configured to send notifications to relevant people at each step of
the referral life cycle.

e Program managers can setup referral initiatives based on geography and/or product
lines. Users can define different commission rates based on product lines.

¢ Channel managers and registration managers can review a submitted referrals, check
for duplicate leads or opportunities, and approve or decline it.

¢ Integration with TCA to verify and merge customer and contact information and
maintain the integrity of your customer database.

¢ Integration with Oracle Sales to automatically carry over referral information to the
opportunity or lead record and through the sales cycle.

¢ Integration with Oracle Trade Management to automate referral commission
calculation and payment.

Deal Registration

When partners resell a vendor’s products, there is often a conflict between the vendor’s
direct sales force and the partner network. Deal Registration enables partners to submit
opportunities and receive a commitment from the vendor not to compete directly and to
support partners on the deal. Deal registration helps to increase partner loyalty and
allows the vendor to gain visibility into partner activity.

The key features are:

e Partners can submit deal registrations online. Once the registration is approved, the
partner can work on the indirect opportunity record that is automatically generated
and assigned to the partner.

e  Workflow driven approvals and notifications allow the vendor to assign approvers
based on multiple criteria, such as geography, product lines or partner types. Oracle
Workflow is configured to send notifications to relevant people, at each step
of the deal life cycle.

e Program managers can setup deal initiatives based on geography and/or product
lines.

e Channel Managers and Registration Managers can review a registered deal, validate
the information, check for duplicate deals, and approve or decline it.
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¢ Integration with TCA to verify and merge customer and contact information and
maintain the integrity of your customer database.

¢ Integration with Oracle Sales to automatically carry over deal information to the
opportunity record and through the sales cycle.

Special Pricing Management

Special Pricing Management streamlines the submission, approval, and tracking

of special pricing requests as well as the submission, validation, and tracking of
claims. Special Pricing Management allows the vendor organization to respond quickly
and intelligently to its partners’ requests for special, discounted pricing, thus closing
more sales and increasing partner loyalty.

The key features are:

e Partners can request special pricing, view the status of their special pricing
requests, and submit claims.

e A vendor user can submit a special pricing request on behalf of a partner.

* Special pricing request approvers can review special pricing information while
approving a special pricing request, identify similar requests, and link them.

* Automatically accrue liabilities on the maximum amount requested for similar
requests.

¢ The vendor can gather competitive information for products.

* The vendor can create claims and see outstanding special pricing requests.

Partner Funds Management

Partner Funds Management streamlines the submission, approval, and tracking of fund
requests as well as the submission, validating, and tracking of claims. It enables vendors
to better manage and distribute channel marketing funds to channel partners. With a
centralized marketing budgeting and claims management system, including a partner
self-service interface to submit fund requests and claims, the vendor can share channel
marketing funds with channel partners to motivate them, build loyalty, and financially
assist them with marketing activities that will further drive your sales. By assisting
partners financially, a partner remains motivated, and this helps in building loyalty as
well. Funds can be provided for a specific time period and based on an organization’s
fiscal cycles.

The key features are:

¢ Partners can request funds, review fund request information, view fund request
status, submit collateral for approval, and submit claims.

* Vendors can attach funds to partner programs and submit fund requests on behalf
of a partner.

* The vendor can define standard processes and for each activity type, and can define
expense breakdown, approvals, and approvers.
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Partner Locator

The Partner Locator allows a potential customer to search for partners, resellers, and
value-added resellers that are registered with the vendor organization. The Partner
Locator integrates with the vendor’s Web portal, which makes it available for customers
independent of the Partner Dashboard or the Oracle Partner Management application.

The Partner Locator allows potential customers to provide some basic search criteria, and
then returns partners that are within a vendor-specified distance of the customer. The
Partner Locator can provide driving directions and maps to better help customers

find partners.
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Overview

Prerequisites and Optional Integrations

This chapter covers the following topics:

e  Overview |

* [Prerequisites ||

¢ [Optional Integrations

Implementing Oracle Partner Management involves setting up and integrating with
various other Oracle applications. Some of the prerequisite set ups are necessary to
provide basic functionality. Other optional set ups allow you to extend the functionality
and capabilities of the Oracle Partner Management application.

Set ups that are required for Oracle Partner Management to function properly are called
mandatory prerequisites. This chapter describes these requirements and provides some
information to help you set up and implement them properly. For more thorough
information on setting up the mandatory prerequisites, you will need to refer to other
documentation.

Optional integrations refer to other Oracle applications that Oracle Partner Management
relies upon for additional functionality. Which applications you need to integrate with
depends upon which feature of Oracle Partner Management you implement.

Prerequisites

An Oracle Partner Management implementation depends upon a number of other
Oracle applications to provide things such as an organizational structure, creation and
management of employees and other resources, support for multiple currencies and
languages, accounting and inventory functions.

If you are implementing Oracle Partner Management as part of a larger Oracle HRMS
or CRM implementation, many of the prerequisites will be set up already. If you are
implementing Oracle Partner Management standalone, you will need to implement
the feature or applications described in this section. You should complete the set up
procedures discussed in this section before implementing Oracle Partner Management.

Setting up the Oracle Applications Organizational Structure

Part of implementing Oracle applications involves setting up a virtual model of your
enterprise in the Oracle Human Resources Management System (HRMS). Oracle
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applications uses the term “organization” to refer to the various business units that
make up an enterprise, and the model of the enterprise in HRMS is referred to as the
“organizational structure.” A business can support multiple organizations running
any Oracle applications product with a single installation. When you run any Oracle
Applications product, you first choose an organization, either implicitly by choosing a
responsibility or explicitly in a choose Organization window. Each window and report
then displays information for the selected organization only.

Each organizational structure contains one Business Group. The business group is the
largest organizational unit representing the enterprise. A business group may correspond
to a company or corporation, or in large enterprises, a holding or parent company. It can
be an organization with a physical location, or it may be an abstract representation of a
legal entity that employs people assigned to work in organizations beneath it.

Depending on business requirements, your organizational structure can contain one or
more Set of Books, and various organizations, such as operating units, legal entities, and
inventory organizations.

If you are implementing Oracle Partner Management as a standalone application, you
will need to creating an organizational structure. Most of the organizational structure
is set up through HRMS. (An exception is the Set of Books, which is set up through
the Oracle General Ledger application.) For more information on using HRMS, refer
to the guide Using Oracle HRMS - The Fundamentals. For complete information about
modeling, implementing, and managing your organizational structure in Oracle
Applications, refer to the guide Multiple Organizations in Oracle Applications.

Setting up an Internal Organization

An internal organization is needed for partner creation, as it allows a "partner

of" relationship to be created for each partner that is added to the database. At

least one internal organization must be set up for an Oracle Partner Management
implementation, and then the profile option PV: Default Vendor Organization must be
populated with the name of the internal organization. If only one internal organization is
set up for an implementation, the profile option is set at the application or site level. If
more than one internal organization is set up, the profile option must be set at the
responsibility level for the default partner responsibility. The internal organization
information must be set up before partners can successfully self-register. It is also
required for the Customer to Partner conversion.

Internal organizations are created through the Oracle TeleSales eBusiness Center
application. One of the following responsibilities is required to set up an internal
organization:

e TeleSales Agent
e TeleSales Manager
¢ Telemarketing Agent

For information on creating an internal organization, refer to the Oracle TeleSales
Implementation Guide.

Setting up Oracle CRM Technology Foundation

Oracle CRM Technology Foundation provides a common infrastructure on which all
CRM applications are built. By providing a set of application components, CRM
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Foundation ensures that all applications interact with key business objects in a consistent
manner.

For detailed information about Oracle CRM Foundation see, Oracle CRM Application
Foundation Implementation Guide.

Resource Manager

Resource Manager is mandatory for an Oracle Partner Management
implementation. This component enables you to use application resources regardless
of where they are created. Resource manager serves as a central repository for
resources, resource groups, teams, and roles.

Resources such as employees, suppliers, parties, or partners, that have been created in
other applications can be imported into Resource Manager. Once imported, the resource
becomes available for CRM applications.

Task Manager

Task Manager is mandatory for an Oracle Partner Management implementation. It
provides a mechanism for your application to respond to customer needs in a timely
manner by creating and distributing work assignments (such as appointments, callback
requests, and service requests) to individuals.

1-to-1 Fulfillment

If you are using email, fax, print schedules, email notifications (or if you are using

the features of email notifications on fulfillment rules) Oracle 1-to-1 Fulfillment is a
mandatory setup. The fulfillment engine supports high volume electronic fulfillment of
documents.

Notes and Note Types

A note is free-form text attached to an object that records descriptive information about
business transactions and that can be referenced across modules. Notes can be created
by both vendor and partner users.

Notes can be further defined by setting up note types. A note type is used to classify
notes, such as general note type or interaction note type. In addition to the seeded
note types, additional note types can be created during implementation to further
categorize notes, if necessary.

Oracle Notes comes with a set of predefined note types; optionally, you can create
additional note types and map note types to a source. Refer to Setting up Notes, page
3413 for more information about implementing Oracle Notes for use with Oracle
Partner Management.

Territory Manager
Territory Manager provides an infrastructure to define territories based on flexible

criteria, such as geography, zip code, area code. This engine creates automatic
assignment of transactions across the entire CRM suite.

Territory Manager is required for the channel manager dashboard since channel teams
are populated based on territory assignment. Territory Manager is also required for
referrals and deal registration, as claims are assigned based on territory definitions. It
is also needed for opportunities and leads. Refer to Setting up Territories in Oracle
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Territory Management, page 316 for more information about creating Territories for
use with Oracle Partner Management.

Note: You must create a territory with the Oracle Partner Management
usage to populate channel teams. If you are implementing referrals or
deal registration, you must also set up a second territory with the
Oracle Trade Management usage (if it has not been created already for
the Oracle Trade Management application).

Assignment Manager

Implementing Assignment Manager is optional. The Assignment engine determines
the best resource to be assigned to tasks based on availability and skill set. This engine
is used by the various CRM modules to automatically assign tasks to a resource or a
group of people.

Setting Up Application Object Library

Oracle Applications Object Library (AOL) 11i provides some of the underlying support
structures and features that are used by all Oracle applications. AOL provides the
following:

*  Multiple-currency support.

* Multiple-language support.

¢ Creation of responsibilities and association of responsibilities with users

¢ Creation of menus and the association of menus with responsibilities. - AOL

¢ Creation of users and user names - The ability to create users is provided by AOL. A
user must have a user name, and the user must be assigned at least one responsibility.

For more information see, Oracle Applications Concepts and Oracle Applications System
Administrator’s Guide.

Setting Up General Ledger

Basic accounting information for Oracle Partner Management is provided by Oracle
General Ledger (GL). Because Oracle Inventory requires at least one organization and
associated set of books, at least one business unit must be created in GL.

For specific setup information see, Oracle General Ledger User Guide.

Setting Up Oracle Inventory

In Oracle Partner Management, Oracle Inventory is necessary for the successful
functioning of various flows. Oracle Inventory serves as the repository for products
or collateral that can be ordered from an organization. Products or items in Oracle
Inventory reside in the MTL_SYSTEM_ITEMS table.

Opportunities and special pricing requests have products associated with them; these
products must be present in Oracle Inventory for them to be tracked in the system and
subsequently available for use in Oracle Partner Management. In addition, if partners
will be charged a fee to enroll in partner programs, then partner programs must be
available as items in Oracle Inventory.
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Oracle Inventory requires one inventory organization to be identified. Typically this

is the Master Inventory Organization. In a multiple operating unit environment, the
Master Inventory Organization should consist of all the products from all the operating
units, it serves as the highest organizational level.

If you need to separate products (sold from each operating unit) into different inventory
organizations, create a separate inventory organization for each operating unit. These
operating units should exist only as subsets of the Master Inventory Organization.

Implement Oracle Inventory as described in the Oracle Inventory Implementation Guide.

Setting Up Product Lifecycle Management

Oracle Partner Management derives its product data using the product catalog provided
by Product Lifecycle Management (PLM). PLM provides a product hierarchy located in
the OLTP schemas. This hierarchy is maintained by the user in a Product Catalog and is
expanded to a de-normalized table (designed for efficient traversal) by the Sales and
Marketing applications.

For information on defining product categories, see Oracle Advanced Product Catalog
User Guide.

Setting Up Oracle Receivables

Oracle Partner Management uses Oracle Receivables to record customer

information. Customer registration information is maintained in the Trading
Community Architecture (TCA). TCA stores all customer, partner, prospect, and other
customer related information in a single repository. Oracle Accounts Receivable is used
during partner program enrollment to verify partner billing and address information
against tax locations.

At a minimum, you need to perform the required Oracle Receivables setups, defining
system options including tax options and address validation, as described the Oracle
Receivables User Guide.

Optional Integrations

This section describes the Oracle applications with which Oracle Partner Management
integrates. Which applications a specific Oracle Partner Management implementation
will integrate with is determined by the flows and functionality that are set during
implementation. The following table provides an overview of Oracle Partner
Management integrations by flow or feature. In the rest of this section, more detailed
information is provided about each integrated application and how it is used by Oracle
Partner Management.
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Integration of Oracle Partner Management and Other Oracle Applications

Function or Flow Oracle Application

Channel Manager Dashboard General Ledger, Marketing, Order
Management, Sales, Trade Management,
Territory Management

Deal Registration Approvals Management, Data Quality
Management, Sales, Territory Management,
Workflow Builder

Opportunity Management Quoting, Sales, Workflow Builder

Partner Dashboard iStore, Marketing

Partner Funds Approvals Management, Inventory, Trade

Management, Workflow Builder

Partner Program Enrollment Approvals Management, iPayment, Order
Management
Partner Programs Advanced Pricing, Approvals Management,

Content Manager, Contracts, Inventory,
Marketing, Order Management, Workflow
Builder

Referrals Approvals Management, Data Quality
Management, Sales, Trade Management,
Territory Management, Workflow Builder

Special Pricing Approvals Management, Data Quality
Management, Marketing, Trade Management,
Workflow Builder

Oracle Advanced Pricing

Oracle Advanced Pricing is used to set up price lists and manage pricing for Oracle
applications. Oracle Partner Management can use Oracle Advanced Pricing to track and
manage pricing for partner programs. In addition to allowing you to set up a price list
for a partner program, Oracle Advanced Pricing can be used to calculate taxes on a state
or national level, to track customer discounts, and to perform currency conversion.

Oracle Partner Management can use either Oracle Advanced Pricing or Oracle
Order Management to create and store pricing information associated with partner
programs. Which application is used is determined by the profile option QP: Source
System Code (set at the application level).

Oracle Approvals Management

Oracle Approvals Management (AME) is a self-service web application that allows
users to define business rules governing the process for approving transactions. AME
enables business users to specify approval rules for a flow without having to write code
or customize the application.

Oracle Approvals Management is used in the following Oracle Partner Management
flows:
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¢ Deal Registration. Approvers and approval rules for deal registration requests are
created and managed through AME.

e Partner Funds. Approvers and approval rules for partner fund requests are created
and managed through AME.

e Partner Program Enrollment. Approvers and approval rules for partner program
registration requests are created and managed through AME.

e Referrals. Approvers and approval rules for lead and opportunity referral requests
are created and managed through AME.

® Special Pricing. Approvers and approval rules for special pricing requests are
created and managed through AME.

Oracle Content Manager

Oracle Content Manager (OCM) is a key component of the Sales, Marketing and
E-Commerce applications that enables content to be stored and managed in a
central repository. OCM features include work flow, versioning, translations, and
renditions. Using content types, OCM is able to keep content separated from its
presentation layer.

Oracle Content Manager is used in the following Oracle Partner Management flows:

e Partner Programs. Oracle Content Manager is used to store the HTML
content, including images, that appears in the Program Overview. The Program
Overview provides a summary of a partner program.

e Partner Dashboard. When an organization uses OCM as the information repository
for iStore, the images and text that appear on the Partner Dashboard will be stored
in OCM as well.

Oracle Contracts

Oracle Contracts provides the common infrastructure components that are used by
Oracle applications to create and manage contracts. The common components provided
by Oracle Contracts are a terms library, authoring and printing tools, and contract
document management.

A vendor organization might require its partners to agree to legal terms and conditions
as a requirement for participating in a partner program. Oracle Partner Management
uses Oracle Contracts to provide legal terms for partner programs. A partner program
can have one or more contracts associated with it. Which contract a partner sees can be
controlled by defining geographic and member type conditions for each contract.

Oracle Data Quality Management

Data Quality Management (DQM) is a tool from the Oracle Trading Community
Architecture (TC) group that is used to check for duplicate information. Oracle Partner
Management uses DQM to check for potential duplicate customers, contacts, and special
pricing requests.

Oracle DQM is used in the following Oracle Partner Management flows:

¢ Deal Registration. DQM is used to find potential customer or contact matches for
deal registration requests submitted by partners.
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e Referrals. DQM is used to find potential customer or contact matches for leads or
opportunities submitted by partners.

® Special Pricing. DQM is used to find potential customer or contact matches for
special pricing requests submitted by partners. Regulations required that the same
pricing be offered to all partners bidding on the same deal. DQM is used to identify
special pricing requests submitted by different partners for the same deal.

Oracle iPayment

Oracle iPayment is a framework that enables you to build integrations with financial
institutions and payment processors for payment and receipt processing. Oracle
iPayment provides you with out-of-the-box integrations with leading payment
vendors. You can create additional integrations as needed.

Oracle iPayment also provides you with a common payment engine for outbound
and inbound payments. It also allows you to manage credit card risk and perform
transaction reporting. Oracle iPayment also supports secure transactions.

Oracle Partner Management uses iPayment to enable electronic payment for partner
program enrollment. Before being able to accept electronic payments through
iPayment, an iPayment server must be set up. In addition, an organization will need an
SSL certificate to implement HTTPS to secure credit card transactions.

Oracle iStore

Oracle Partner Management uses iStore to build the Partner Dashboard and to set up
security for the dashboard based on partner responsibilities. If you are integrating
with Oracle Marketing, you can also create web advertisements and display them on
the Partner Dashboard. Oracle iStore is also used to create the online partner program
enrollment flow. A specific enrollment flow template has been seeded to simplify

the design of enrollment pages.

Oracle Marketing

Oracle Marketing helps marketing professionals create campaigns that are targeted
toward customers. Oracle Marketing provides numerous tools that help marketing
professionals to analyze campaign effectiveness, create and manage campaign
budgets, capture leads generated by campaigns, create a manage promotions, and
generate price lists that meet customer demands.

Oracle Marketing is used in the following Oracle Partner Management flows:

¢ Channel Manager Dashboard. A vendor user with the appropriate permission sees
a Create as List button on his Partners page. Clicking this button creates a list
containing the partners displayed on the page. The list is accessible from Oracle
Marketing, and can be used to create a marketing campaign targeting the partners.

e Opportunity Management. Opportunities generated by marketing campaigns can
routed to the indirect channel (by Oracle Sales) and subsequently routed to partners.

e Partner Dashboard. Users can create and execute web advertising campaigns
that appear on Partner Dashboards. Oracle Marketing is used to create the web
placement for the ad, create the campaign and campaign schedule, and select the ad
content. A web campaign can appear on all partner dashboards or a list of partners
can be created and a campaign can be set up that targets those partners specifically.
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e Partner Funds. A partner fund is associated with one or more budgets. In turn, each
budget is associated with one or more marketing activities. The activities are created
in Oracle Marketing, and are associated with budgets when the budgets are created
in Oracle Trade Management.

e Partner Programs. Partner program approval is managed through the Oracle
Marketing approvals process. The Oracle Marketing approvals process allows
approvers to be associated with a partner program type, and allows approval
requests to be routed sequentially. The Oracle Marketing Framework works behind
the scenes to route approval requests, send notifications, and manage approval
statuses.

Oracle Order Management

Oracle Order Management allows you to efficiently capture customer orders from
multiple sales channels and fulfill orders using any fulfillment method. Oracle Order
Management captures demand from multiple sales channels including web stores, field
sales, call centers, service centers, and customer systems. Oracle Order Management
integrates with Oracle Advanced Pricing to provide a highly flexible setup mechanism
and pricing engine that accurately applies pricing, deals and promotions to customer
orders.

Oracle Order Management is used in the following Oracle Partner Management flows:

e Channel Manager Dashboard. Oracle Order Management provides the data for
the Sales Year-to-Date key metric. This data is also used to create the graph that
appears on the dashboard.

e Partner Programs: Oracle Order Management is used process cash, check, or
credit card payment methods for partner programs. Additionally, Oracle Order
Management can be used to set up price lists for partner programs.

e Partner Program Enrollments. Oracle Order Management creates a sales order and
provides the billing functionality for partner program enrollments. Oracle Order
Management allows you to associate a sales person with enrollment request orders
and set up order cancellation reasons.

® Special Pricing. Accrual and off-invoice special pricing requests are fulfilled with
inventory that is ordered from the vendor organization (scan data special pricing
requests are fulfilled with existing partner inventory). Order Management is used to
place and manage the orders for new inventory special pricing requests.

Oracle Quoting

Oracle Sales

Oracle Quoting enables simple, secure creation and management of customer quotes
across sales and interaction channels. Oracle Quoting is used in Opportunity
Management flows. Once a partner accepts an opportunity, a partner user can create a
quote for the customer and publish it to the customer. The partner user can add products
to the quote and select a price list for the quote, and then submit the quote for approval by
the vendor. Once the partner, customer, and vendor agree on the quote, the partner user
can place an order (thought Oracle Order Management) and monitor the order status.

Oracle Sales is an application for sales professionals that simplifies and optimizes
the task of planning and managing the sales process. Oracle Partner Management’s
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Opportunity Management pages are provided by the Oracle Sales application. You
might need to perform some implementation procedures to ensure that the opportunity
pages appear and function correctly. Refer to Setting up Opportunity Assignment

, page [10H1 for additional information.

Oracle Sales is used in the following Oracle Partner Management flows:

¢ Channel Manger Dashboard. The Channel Manager Dashboard displays
opportunity metrics in the Key Metrics areas. In addition, the Partner Details
page displays sales, deal, and opportunity information, all of which comes from
the Oracle Sales application.

¢ Deal Registration. When a partner’s deal registration request is approved, a new
opportunity is created for the deal. Opportunities are stored in Oracle Sales tables. If
an organization is using both Oracle Sales and Oracle Partner Management, the
opportunity will be visible from both applications.

e Opportunity Management. The pages that appear in the Opportunity
Management portions of Oracle Partner Management are Oracle Sales opportunity
pages. However, opportunities that are assigned to partners contain information
about the Channel Team; this information does not appear on opportunities handled
through an organization’s direct sales channel.

* Referrals. When a partner’s referral is approved, either a new opportunity or lead is
created, or the referral is linked to an existing opportunity or lead. Opportunities
and leads are stored in Oracle Sales tables. If an organization is using both Oracle
Sales and Oracle Partner Management, the opportunity or lead will be visible
from both applications.

Oracle Trade Management

Oracle Trade Management provides the consumer goods industry tools to aid in

trade planning and offer management, budget management, claim and deduction
management, and indirect sales management. Oracle Trade Management is used in the
following Oracle Partner Management flows:

¢ Channel Manager Dashboard. From the Channel Manager Dashboard, a vendor
user can see the amount of money that is owed to a partner to settle its open
claims, and the amount of partner funds a partner has requested year-to-date. Claims
and funding requests are managed through Oracle Trade Management, which
provides Oracle Partner Management with this partner data.

* Referrals. Oracle Trade Management is used to compensate partners for referring
winning leads and opportunities to the vendor. Oracle Trade Management is used
to create and manage one or more budgets that are used to track compensation to
partners who refer opportunities. When a partner’s referral compensation request
is approved, an offer corresponding to the request is also created in Oracle Trade
Management. Finally, Oracle Trade Management generates a claim against a
partner’s offer when the order generated by the referred opportunity is shipped.

e Partner Funds. Oracle Trade Management is used to reimburse partners that have
participated in successful marketing campaigns for the vendor. Oracle Trade
Management is used to create and manage one or more budgets that are used to
fund partner marketing activities. In addition, Oracle Trade Management provides a
seeded offer type that is used to generate claims for partners who are requesting
reimbursement for their activities.
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* Special Pricing. Oracle Trade Management is used to reimburse partners for special
pricing situations. Oracle Trade Management is used to set up one or more budgets
to track special pricing funds. In addition, Oracle Trade Management seeds three
offer types that are used to create and manage different types of special pricing
requests. Depending on the type of special pricing request submitted, a partner
may need to submit a claim for reimbursement, which is handled through Oracle
Trade Management as well.

Oracle Workflow Builder

Notification messages for numerous Oracle Partner Management flows are created and
managed using the Oracle Workflow Builder 2.6 application. The notifications are
associated with an object (such as a fund request or special pricing request) and are sent
out as the result of an event, such as the change of an object’s status.

Seeded notifications and messages for Oracle Partner Management are provided in
Oracle Workflow Builder; in this guide, lists of notifications and messages are provided
in the chapter devoted to each flow that integrates with the application. You might be
able to implement the seeded notifications without modification. However, if you need
to make changes to the seeded notifications or create new notifications, you will need
access to Oracle Workflow Builder version 2.6.2 and the Oracle 9i database.

Oracle Workflow Builder is used in the following Oracle Partner Management flows:

¢ Deal Registration. Notifications are sent to recipients at various times in the deal
registration process.

¢ Opportunity Management. Notifications are sent to various recipients when an
opportunity’s status changes.

e Partner Funds. Notifications are sent to recipients at various times in the fund
process.

e Partner Programs. Notifications are sent to partners based upon partner program
enrollment request status. Notifications are also sent to a partner when its
membership in a program is nearing expiration. Notifications are sent to the partner
user with the Partner Primary User role.

e Referrals. Notifications are sent to recipients at various times in the referral process.

* Special Pricing. Notifications are sent to recipients at various times in the special
pricing request process.
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3

Common Implementation and Administration

Overview

Tasks

This chapter covers the following topics:

e Overview |

e [Creating Approval Rules in Oracle Approvals Manager

e [Setting up Territories in Oracle Territory Manager

Setting up Notifications in Oracle Workflow Builder

Setting up Matching Rules with Oracle Data Quality Management

Setting up Noteb

This chapter provides information about implementation or administration tasks that
you might need to perform for multiple Oracle Partner Management business flows

or features. To avoid redundancy, information about these tasks and procedures for
completing them are presented in this chapter. Additional information that is needed to
complete the task for a specific flow or feature is presented in the appropriate chapter.

To complete the tasks in this chapter, you will need access to other applications, or have
access to a user who is responsible for administering those applications. The information
and procedures provided in this chapter are fairly high-level; to gain a more thorough
understanding of the procedures and their associated applications, you will want to refer
to the documentation for the application.

The following table lists the implementation and administration tasks contained in this
chapter, the business flows or features that require the tasks, and the applications in
which you will complete the tasks.
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Common Implementation and Administration Task Overview

Task

Business Flow or Feature

Application

Creating Approval Rules

Setting up Territories

Setting up Notifications

Setting up Matching Rules

Setting up Notes

Deal registration requests

Lead or opportunity referral
requests

Partner funds requests

Partner program enrollment
requests

Special pricing requests

Channel team creation
Deal registration requests

Lead or opportunity referral
requests

Deal registration requests

Lead or opportunity referral
requests

Partner funds requests

Partner program enrollment
requests

Special pricing requests

Special pricing requests
Deal registration requests

Lead or opportunity referral
requests

Deal registration requests

Lead or opportunity referral
requests

Partner fund requests

Special pricing requests

Oracle Approvals
Management

Oracle Territory Manager

Oracle Workflow Builder
version 2.6.2

Oracle Data Quality
Management

Oracle Common Application
Components

Creating Approval Rules in Oracle Approvals Manager

Approval rules and approvers for partner program enrollment requests, special pricing
requests, partner fund requests, deal registration and referral requests, and Data Quality
Management (DQM) approvals are defined in the Oracle Approval Management
application.

An approval rule associates one or more conditions with an approval in an if-then
statement, and each condition tests the value of an attribute (you can think of an
attribute as a variable). The approval rule also defines the list of approvers to which the
transaction is routed if the conditions are met. For example:
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If

condition C1 is true and
condition C2 is true
then

do approval Al

For example, to create the approval process “For a referral request from a partner in
the United States, require approval from a user with the Channel Manager role,” the
rule might be:

If

CUSTOMER_COUNTRY = US

then

require user with role Channel Manager to approve

You associate a rule with a transaction type, and a transaction type is associated with
an application. You can associate the same rule with several transaction types, and
therefore several applications.

Setting up approval rules and approvers involves specifying a condition for one or more
attributes, setting up approval groups, and defining rules. This section provides some
basic procedures for creating an approval rule. For more thorough information about
rule creation, refer to the Implementing Oracle Approval Management guide.

Creating an approval rule involves a number of steps, which are described in the
following sections:

* Setting up a Condition

¢ Setting up an Approval Group
* Setting up a Rule

¢ Testing the Rule

When creating an approval rule, a user might need to complete only some of the steps
listed in this section. For example, if an approval group already exists, the user would
need to create a condition and a rule only.

Oracle Partner Management integrates with AME version 11.5.9, and fully supports
features included in that release. Currently, features introduced in AME 11.5.10, such as
the ability to set up parallel approvals processes, are not supported.

To set up an approval rule, log in to the self-service application as an Approvals
Management Application Administrator and navigate to Approvals Management
Application Administrator > Approvals.

Setting up a Condition

Transaction Types are seeded. For Oracle Partner Management, the following transaction
types are available:
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Transaction Types for Oracle Partner Management

Transaction Type Used For

PV: Deal Registration Management Deal registration

PV: DQM approvals Data quality management
OZF: Special Pricing Request Special pricing

OZF: Soft Fund Request Partner fund request

PV: Referral Management Approvals Partner referral

PV: Partner Program Enrollment Requests Partner program registration

Use this procedure to create a condition for the approval rule.

1.

Click the Set Transaction Type link at the top of the Approvals page and select the
appropriate Transaction Type from the drop-down list. Refer to the table above to
select the correct transaction type for your condition.

Click Continue.

Click the Conditions tab, and then click Add a Condition.

Select Ordinary as the condition type, and click Continue.

The Choose a Condition page appears.

Select an attribute from the drop-down list and click Continue.

The Create a Condition on a String Attribute page appears.

Provide a value for the attribute and click Continue.

The Text Values page appears.

Click Add a Text Value to define additional values for the attribute, if appropriate.

Click Quit to save the condition.

Setting up an Approval Group

Use this procedure to set up an approval group.

1.

Click the Groups tab.

A page appears that lists existing groups for the transaction type.

Click Add Group.

The Create an Approval Group page appears.

Provide information, as required, for the group, and click Create Group.

The Members section appears at the bottom of the Create an Approval Group page.

Note: Use the Active List region to specify whether the list of
approvers will be a static or a dynamic list. Static indicates that you
will set up a list of approvers for the rule. Dynamic indicates that
the application will execute a query to determine the approval
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Setting up a Rule

group’s membership. Enter the query statement in the Query
region below the Active List.

Click Add Approver.
The Search for Approver page appears.
Select either FND User or HR People from the drop-down list.

Note: Select FND User to search for approvers that are set up as
Users. Select HR People to search for approvers who are entered as
employees. For Oracle Partner Management, it is recommended that
you select HR People.

Click Search to return a list of potential approvers.

Select an approver from the list and click Continue.

The Select Order Number page appears.

Specify the approvers order in the approval process, and click Create Member.

The Edit an Approval Group page appears, displaying the new approver in the
Members region.

When you have finished adding members to the approval group, click Submit
Changes.

Use this procedure to set up an approval rule.

1.

Click the Rules tab.

The Add a Rule - Step 1 page appears.

Provide information for the rule and click Continue.
The Add a Rule - Step 2 page appears.

Note: There are six rule types available. Different rule types use
different conditions and approval types, and have different effects
on a transaction’s approver list. For Oracle Partner Management, it
is recommended that you select list-creation as the rule type.

Select "chain of authority includes an approval group" and click Continue.
The Add a Rule - Step 3 page appears.

From the "approval group chain of authority Actions" list, select the approval group
that you set up for this transaction type and rule and click Continue.

The Add a Rule - Step 4 page appears.
Select the condition from the Header Attributes region and click Continue.

Note: The Header Attributes region should contain all the conditions
that have been set up for the transaction type. It will also contain the
default condition TRANSACTION_SET OF BOOKS ID.
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The Add a Rule - Step 5 page appears.

6. Select the conditions to be included in the rule from the Header Conditions area and
click Continue.

The rule is created and the approval set up is complete. The Approvals Engine will
use this rule to assign the specified type of transaction to a user that matches the
conditions specified.

Testing the Rule

From the Test tab, you can test the rule to make sure that it will work properly. You can
choose to test the rule against an existing transaction, or have the system create a test
transaction.

Setting up Territories in Oracle Territory Manager

Oracle Partner Management uses territories created in Oracle Territory Manager to:

* Associate channel managers and channel representatives with partners (that is, to
set up a channel team)

¢ Identify the country of the customer for which a partner is registering a deal or
referring a lead or an opportunity.

A Partner Management territory must be set up before a channel team can be assigned
to a partner and opportunities can be matched with partners. In addition, an
organization must have a Trade Management territory set up if it is going to implement
lead and opportunity referral as a partner program benefit. Optionally, a Trade
Management territory can be used for deal registration, although it is not required

for implementation. The same Trade Management territory is used for both referrals
and deal registrations.

Note: If you are implementing deal registration or referrals, you will
need to set up two separate territories. Set up a territory with the usage
Partner Management to create a populate channel teams. Set up a
territory with the usage Trade Management for use with referrals

and deal registrations.

There are three main steps involved in creating a territory: enabling transaction
qualifiers, setting up the territory, and running concurrent programs to populate the
territory. In this manual, we provide some basic procedures for creating territories using
Oracle Territory Manager. For more thorough information about the application and
territory creation and management, refer to the Oracle Territory Manager Implementation
Guide.

Enabling Transaction Qualifiers

Transaction qualifiers are the criteria used by various assignment engines to determine
winning territories. The applications that use Territory Manager use different sets of
seeded transaction qualifiers. You must enable transaction qualifiers before they can
be used in a territory.

Navigation
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Log in to Oracle Forms with the CRM Administrator responsibility, and navigate to
Territory Manager > Territory Administration. Then, choose Setup Qualifiers from the
Administration menu.

Notes

e Usage: Select the type of territory you are setting up. The type of territory you select
determines the transaction qualifiers that will be available. Click Find to display the
qualifiers associated with the territory.

¢ Enabled: Click the Enabled check box for each transaction qualifier you want to
use, and then click Update Qualifiers. When you enable a qualifier, you make it
available for use when setting up a territory.

Setting up the Territory

A territory is a hierarchal organization of resources. For Oracle Partner Management, you
will need to set up a territory with the Oracle Partner Management usage that allows
you to assign vendor employees to partners so that you can create channel teams and
match opportunities to partners. If you are implementing referral management or

deal registration, you set up a territory with the Oracle Trade Management usage that
associates partners with countries or regions. The territories you create model a physical
organization of business entities.

Navigation

Log in to Oracle Forms with the CRM Administrator responsibility, and navigate to
Territory Manager > Territory Administration. Then, choose Define Territory from the
Administration menu.

Prerequisites

The transaction qualifiers have been enabled.

Steps

1. Click the Overview tab, and provide values in the following fields as appropriate:

* Usage: Select the type of territory you are setting up. Select Oracle Partner
Management when creating a territory for the channel team. Select Oracle
Trade Management when creating a territory for deal registration or referral
management.

¢ Parent: Enter Catch All if you are creating the top-level
territory. Otherwise, select the appropriate parent territory from the LOV.

* Number of Winners: Number of winners refers to the number of territories
below the top-level territory that can be identified as matching (that
is, “winning”) territories for a partner or a claim (number of winners does not
apply to offers). There are two possible outcomes based on values entered in the
Number of Winners field:

* One Winner: If you enter 1 in the Number of Winners field, Oracle Territory
Manager assigns the business object to a single territory in the hierarchy. If more
than one territory could be considered a winner, use the territory ranking
mechanism for tie-breaking.

*  Multiple Winners: If you enter a number greater than one in the Number of
Winners field, Oracle Territory Manager can assign a business object to multiple
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territories. Again, if there are more winning territories than the number you
have specified, territory ranking is used for tie-breaking.

¢ Rank: Used to specify the priority of a territory among multiple winners. If no
rank is defined, the choice will be decided randomly. If more than one territory
level is identified as a possible match for a business entity, the lowest-ranked
territory wins at the same level in the hierarchy. For example, from rank 1 to 10
for the same hierarchy level, rank 1 has the highest priority.

* Transaction Types: Use the LOV to select one or more types of transactions
based on the territory usage. Note that some application types allow you only
one transaction type.

e Freeze: Leave unchecked

2. Click the Transaction Qualifiers tab, and select one or more transaction qualifiers
for the territory.

The list of available qualifiers is populated with the qualifiers that you enabled for
the transaction type.

3. In the Qualifier Values area, define operators and values for the transaction qualifier
selected. The operators and values available are determined by the transaction
qualifier selected.

4. Click the Resources tab to select resources for the territory.

A resource can be an individual, a resource group, or a resource team. Each resource
must have the access type Partner.

Running Concurrent Programs

Once the territory is set up, the following concurrent programs must be run to properly
populate the territories with partners and channel teams:

* OZF-TM: Generate Party List for Market Qualifier
e OZF-TM: Generate Party List for Market Qualifier
e PV:Channel Team Assignment for Partners in TOTAL/INCREMENTAL Mode

e PV: Define Channel team for specific territories

Refer to Appendix C, “Summary of Concurrent Programs"”, page (11 for additional |
information on the purpose of these programs.

Setting up Notifications in Oracle Workflow Builder

Notification messages for deal registration requests, partner fund requests, special
pricing requests, and lead or opportunity referral requests are created using the Oracle
Workflow Builder 2.6 application. The notifications are associated with an object

(such as a fund request or special pricing request) and are sent out as the result of an
event, such as the change of an object’s status. The notifications for a specific module are
identified by a unique Item Type; the following table lists the notification item types

for Oracle Partner Management flows.
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Notification Item Types for Business Flows

Business Flow Notification Item Type
Deal registration request PVDEALRN

Partner fund request OZFSFBEN

Special pricing request OZFSPBEN

Lead or opportunity referral request PVREFFRL

Opportunity routing and assignment POL Assignment Routing

Seeded notifications and messages for Oracle Partner Management are provided in
Oracle Workflow Builder. You might be able to implement the seeded notifications
without modification. However, if you need to make changes to the seeded notifications
or create new notifications, you will need access to Oracle Workflow Builder version 2.6.2
and the Oracle 9i database. Note that you can not create new notifications for opportunity
routing or assignment, but you can modify the text of the seeded notifications.

In this guide, we provide instructions for changing a message’s text and adding a

URL to a message. The messages are written in HTML, and can be modified without
programming. For each message, tokens have been created that are associated with
message attributes. Examples of message attributes include objects such as a partner
name, approver name, program name, etc. Tokens make it easy to personalize messages
for recipients.

If necessary, you can also create additional processes, create notifications for the
processes, and associate new or existing messages with the notifications. Creating new
processes, notifications, and messages requires programming skills.

For additional information on using Oracle Workflow Builder, refer to the Oracle
Workflow Builder Implementation Guide.

Changing Message Text

Use this procedure to change the text contained in a notification message.
Navigation

Launch the Workflow Builder 2.6 client application and make sure that the application’s
access level is set to 100 by navigating to Help > About Oracle Workflow Builder

2.6. Then, navigate to File > Open, select the Database radio button, and provide the
values needed to connect to the database.

Prerequisites

You must have installed the Oracle 9i database and Oracle Workflow Builder version
2.6.2.

Steps
1. Locate the notification’s Item Type and expand it.

2. Locate the Messages node to see a list of messages that have been seeded for the Item
Type. You can see the tokens created for a message by expanding the Message node.
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3. To edit a message double click its icon to display the Navigator Control Property
window, and then click Body tab, and then the HTML Body tab.

4. Make changes to the text as required.
5. Click OK and save your changes.

Adding a URL to a Message

Use this procedure to add a URL to an existing notification message.

NavigationLlaunch the Workflow Builder 2.6 client application and make sure that the
application’s access level is set to 100 by navigating to Help > About Oracle Workflow
Builder 2.6. Then, navigate to File > Open, select the Database radio button, and provide
the values needed to connect to the database.

Prerequisites

You must have installed the Oracle 9i database and Oracle Workflow Builder version
2.6.2.

Steps

1. Add a new attribute by right clicking with the mouse placed on the Attributes Node
and then providing the following information:

¢ Internal Name = <internal name> (for example: TEST)
e Type = URL
e Value = <URL address>

2. Drag the newly created attribute into the message in which you want the URL to
appear.

3. Double-click the message to display the Navigator Control Properties window.
4. Click the Body tab.

5. Add the URL attribute created previously by preceding the internal name with an
“&"” (for example: &TEST).

Setting up Matching Rules with Oracle Data Quality Management

Data Quality Management (DQM) is a tool from the Oracle Trading

Community Architecture (TC) group that is used to check for duplicate
information. Oracle Partner Management uses DQM to check for potential duplicate
customers, contacts, leads, opportunities, referrals, deal registrations, and special
pricing requests.

When a referral, deal, or special pricing request is submitted by a partner, a DQM
approver in the vendor organization compares the new information against existing
records. If there are no matches for the customer or contact associated with the
referral, deal, or special pricing request, the new customer and contact are created in
the system. If there are matches for the object, the DQM approver reviews the existing
records decides to do one of the following:

* Associate the new customer and/or contact with an existing customer record.
¢ Create a new organization and contact.

* Associate the special pricing request with an existing request.
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The following information is intended to get you started with DQM. For more
information setting up DQM rules, refer to Oracle® Trading Community Architecture Data
Quality Management User Guide.

The TCA Registry

You use DQM to manage duplicate parties in the TCA registry. The TCA registry is the
central repository of party information for all Oracle applications. The party information
includes details about organizations and people, the relationships among the parties, and
the places where the parties do business.

Attributes and Transformation Functions

Match Rules

DQM has defined four types of attributes that represent logical entities that are stored in
the TCA registry: party, address, contact, and contact point. Each attribute corresponds
to a table column in the TCA registry. Attributes are used to search for possible matches
between an input record and the TCA registry data. Numerous seeded attributes are
provided; you can also create custom attributes.

New records can include typographical errors, spelling errors, inconsistent formats, and
abbreviations due to input errors. For this reason, searches performed on raw values
often are inconclusive or miss potential matches. Transformation functions transform
attribute values in the staged schema so that the values are more similar and useful

for the purpose of matching records. Transformation functions neutralize the effects

of data errors on your searches. For example, a transformation function that removes
all of the double letters in a party name transforms a name such as Allied Freight into
Alied Freight. This transformation makes it easier to match to a party if a typographical
error, such as a missing double letter, exists.

After your raw data has been transformed and populated into the staged schema, match
rules can use the transformed data to score each record to determine if the record is
considered alike enough to be a match to an input value.

DQM includes several seeded transformation functions. You can also create custom
functions.

Match rules determine whether two parties should be identified as a match or potential
duplicate. When you define match rules, you specify which attributes will be used in
the matching, and configure how the attributes should be evaluated. For each attribute
that you use in a match rule, you also assign one or more transformation functions. You
can also set up scoring rules, which allow you to calculate a match score for each
record. Scoring provides more flexible and granular matching.

Creating a Match Rule

Use this procedure to create a match rule.
Navigation

Log in to Oracle Forms as a Trading Community Manager and navigate to Data Quality
Management > Setup > Match Rules.

Steps

1. Provide a rule name and a description.
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2. In the Purpose area, select Expanded Duplicate Identification.

3. Click the Acquisitions tab, and provide values in the following fields as appropriate:

Attribute Name: Select one or more attributes from the LOV. To identify
duplicate customer, select an attribute with an entity type of Party. To identify
duplicate contacts, select an attribute with an entity type of Contacts. When you
select an attribute, the Entity and Type fields are populated automatically.

Filter: You can use an attribute as a filter so that the attribute always appears

as a match in the returned records. The search engine groups attributes of a
logical entity, under a match-all condition, when the attributes are used as
filters. This grouping overrides the match requirement selected in the Attributes
Match region.

Attributes used as filters should not be used for the Scoring component of the
match rule because all records contain them.

Attribute Match: If you specify more than one attribute in the match
rule, specify whether all attributes must match or any attributes can match fields
on the record to identify a record as a potential match.

Transformation Name: You must select at least one transformation function
for each attribute. The functions contained in the LOV are determined by
the attribute type selected. When you select a function, the Description field
is populated automatically.

Use the fewest transformation functions as possible for a match rule, as using
many functions could negatively impact system performance.

4. Click the Scoring tab and provide values in the following fields as appropriate
(setting up Scoring is optional):

Attribute Name: Select one or more attributes from the LOV. When you select
an attribute, the Entity and Type fields are populated automatically. The
attributes for which you set up scoring do not need to be the same attributes that
you selected for matching.

Score: Assign a numerical score to the attribute. Assign the highest score to the
attribute that you consider the most important for a match. The score is awarded
to a record if the attribute is evaluated as a match. If the attribute does not
match, a score of zero is assigned.

Transformation Name (Scoring tab): You must select at least one transformation
function for each attribute for which you’ve set up scoring. When you select a
function, the Description field is populated automatically.

Weight (%): Enter the percentage of the attribute score that is factored into the
weighted total score in the event of a match.

Exact or Similarity: Indicates if a transformation function requires an exact
match or applies the similarity algorithm. If you select the similarity option, you
must enter a percentage in the Similarity (%) field.

Match Threshold: Enter the minimum match score. The minimum match
indicates the minimum set of attributes that are required for a match.

Automatic Merge Threshold: Enter the minimum set of attributes that are
required for considering two parties for merge. The total of the attribute scores
of this minimum set is the maximum value for the automatic merge threshold.
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The automatic merge threshold must be greater or equal to the match threshold.

5. Click Compile to compile, lock, and save the match rule.

Setting up Notes

Oracle Common Application Components (CRM) provides Notes functionality that
allows users to associate free-form comments with a business object. In Oracle Partner
Management, CRM Notes are available for deal registration, referrals, partner funds, and
special pricing.

Oracle Partner Management is seeded with numerous note types; you can create
additional note types to meet your organization’s needs. To reduce the number of note
types that your users see when selecting a note type when creating a new note, you
can map note types to a source.

This section provides some basic procedures for creating note types and mapping
note types to a source. For more thorough information about notes, refer to the Oracle
Common Application Components Implementation Guide.

Creating a Customized Note Type

Use this procedure to create a customized note type.
Navigation

Log in to CRM with the CRM Administrator responsibility, and navigate to Notes
Setup > Note Type Setup.

Prerequisites
None.

Notes

* Code: Enter a code for the new note type. The code should comprise the code name
of your application and a note type name. The code for Oracle Partner Management
is PV. For example, the code for a note type for Referrals could be PV_REFERRALS.

* Meaning: This field contains the name of the note type as you want it to appear in
the application.

e Enabled: Check to make the note type available for use.

e End Date: Enter an date after which the note type will be unavailable for use in
the application.

Mapping Note Types to a Source

After creating a note type, you can map it to a source object. Mapping note types to a
source object limits the number of note types that are available for users.

Navigation

Log on to the CRM application with the CRM Administrator responsibility, and navigate
to Notes Setup > Source and Note Type Mapping.

Prerequisites

The note type must exist.
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Notes

* Source Object: A source object is a business object that initiates the creation of a
note. A note must have a source object. For example, to associate the Referrals note
type with partner lead and opportunity referrals, select Lead Referral.

* Note Type: Select a note type that you would like to map to the source. You can map
multiple note types to a single source.

* Application: Optionally, you can select the application that this mapping is
for. Select Oracle Partner Management.

Note: If a note type is not associated with a specific marketing
object, it becomes available to all marketing objects.
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Overview

Setting Up Vendor Users

This chapter covers the following topics:

e  Overview |

* [Understanding Vendor Users

¢ [Understanding Responsibilities] Roles|] and [Permissions

Creating a Vendor User

Creating a Channel Administrator

Setting up Resource Groups and a Resource Group Hierarchy

Setting up a [Partner Hierarchy

Vendor users are members of the vendor organization who are responsible for working
with partner organizations to manage the organization’s indirect sales channel.

Vendor users are set up initially during implementation. The channel administrator will
also need to create new vendor users periodically. Creating a vendor user involves the
following steps:

¢ Entering a person as an employee in the HRMS application
* Setting up the employee as a user and assigning responsibilities to the user

e Importing the user as a resource in the CRM Resource Application, assigning
resource roles to the user, and adding the user to a resource group

* Assigning permissions to the user
In addition to vendor users, two hierarchical structures must be set up:

* The resource group hierarchy: Used to determine vendor users’ visibility into
partner information

* The partner territory hierarchy: Used to group partners hierarchically and to
associate vendor users with partners

Partner users are set up differently from vendor users. Partner users are created as a
result of self-registration, and then subsequently are assigned additional responsibilities
through partner program membership. For a complete discussion of partner users, refer
to Setting up the Partner Dashboard, page [6H1. []
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Understanding Vendor Users

Oracle Partner Management provides you with seeded responsibilities and roles that
you use to create vendor users. In this guide, we provide information on setting up
three basic types of vendor users:

Channel representative. A channel representative can be assigned to a partner’s
channel team. A channel representative can access all information about a partner
is he is a member of its channel team.

Channel manager. The channel manager can also be assigned to a partner’s channel
team. Channel representatives “report” to channel managers, and a channel manager
has visibility into her channel representatives’ partner data even if she is not a member
of the partners’ channel teams.

Channel administrator. The channel administrator has access to Oracle Partner
Management’s administration pages and flows.

Creation of each type of vendor user is accomplished by assigning specific responsibilities
and roles, which are described in the next section. While reading this chapter, please
keep in mind that our intention is to provide you with enough understanding of Oracle
Partner Management users to allow you to create users that meet your organization’s
business requirements. If you are using additional Oracle applications, your
organization’s users might require additional responsibilities, roles, and permissions.

Understanding Responsibilities, Roles, and Permissions

Setting up vendor users in Oracle Partner Management involves assigning
responsibilities, resource roles, and permissions-based roles.

Responsibilities
Responsibilities are used across the Oracle E-Business Suite to give access to
applications. When a responsibility is assigned to a user, it gives the user access to
specific business flows, functions, and database tables. Responsibilities provide a way to
implement security, as they control the information a user can see. Responsibilities are
seeded for specific applications, and within an application, different responsibilities can
provide a basis for creating different types of application users.

To assign a responsibility to a vendor user, first set up the user as an employee in the
HRMS application, and then create a user name and password for the employee. The
responsibility is then assigned to the user.

Oracle Partner Management seeds the Channel Manager and Channel Administrator
responsibilities:
¢ The Channel Manager responsibility is assigned to both channel managers and

channel representatives.

e The Channel Administrator responsibility is assigned to channel
administrators. Note that, in addition to the Oracle Partner Management
responsibility, a channel administrator needs to be able to access numerous other

Oracle applications. Refer to Creating a Channel Administrator, page 448 for a list of []

the responsibilities that you might need to assign to a channel administrator.
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Resource Roles

Oracle’s CRM resource applications use resource roles to assign privileges to users
and to control security.

In the CRM architecture, resources are people who are identified by the business
function they perform. CRM resources include employees, parties, partners, and
supplier contacts. In Oracle Partner Management, a vendor user is considered an
employee resource.

A resource is assigned one or more roles. A resource role is a descriptive category

that can encompass one or more job descriptions and job titles (for example, Channel
Manager or Vendor Administrator). A resource role is associated with a role type, which
is a collection of roles associated with a particular CRM application. Partner
Management is a role type, as are Marketing and Sales Compensation. Both roles and
role types are seeded per application.

Each role is associated with one or more attributes. A role’s attributes are defined when
the role is created. The attributes assigned to a role help to further define the role. There
are four attributes: Member, Lead, Administrator, and Manager.

Relationship Between Resources, Roles, and Attributes

Partner
Resource Mgmt. Roles Attribute

Manager

Linda |e__| Channel PEE g
Manager|,

Lead

o — Member
ar Channel
John [ Rep. [
Administrator

A resource role is associated with a resource group, and resource groups are used to
build a resource group hierarchy. In Oracle Partner Management, the resource group
hierarchy is used to associate channel representatives with channel managers, who are
subsequently able to view information about their channel representatives’ partners. A
resource group hierarchy can include parent-child relationships, as illustrated in the
following figure. Thus, you can extend a channel manager’s visibility by adding child
groups to her group.
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Resource Groups with Parent/Child Relationships
Linda - Channel Manager

Partners West Group
{Parent Group)
F

Mark - Channel Rep John - Channel Rep.

Jim - Channel Manager
California Group
{Child Group)

T
| |

Mary - Channel Rep Tony - Channel Rep

When you assign a user to a resource group, you give the user a role within the

group. The group roles available for a particular user within a resource group are
determined by the resource roles you have granted her. For example, to add resource
Linda Jones to a resource group with a Channel Manager group role, you first must give
her the Channel Manager resource role.

Oracle Partner Management uses three resource roles: Channel Manager, Channel
Representative, and Vendor Administrator:

¢ The Channel Manager and Channel Representative roles are used to assign vendor
users to channel teams and to control visibility into partner information.

* The Vendor Administrator role is used to designate a user as an enrollment request
superuser, as it allows the user to see all Oracle Partner Management-related
enrollment requests without being designated as a request approver.

Permissions-Based Roles

CRM applications also use permissions-based roles. In Oracle Partner

Management, permissions-based roles allow you to control a user’s security at a
granular level, because a permission generally gives a user access to a specific bit of
functionality. For example, you give a user the ability to invite an organization to become
a partner by granting him the PV_INVITE_NEW_PARTNERS permission.

Permissions-based roles can be thought of as containers for permissions. Although you
can not create a permission, you can create a permission-based role, and associate
one or more permissions with the role.

Oracle Partner Management provides you with three seeded permissions-based roles:
e CHANNEL_MANAGER - contains the PV_INVITE_NEW_PARTNERS permission.

¢ CHANNEL_ADMIN_UPDATE - contains the PV_UPDATE_ALL_PARTNERS
permission
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e CHANNEL_ADMIN_VIEW - contains the PV_VIEW_ALL_PARTNERS permission

The following table lists all the permissions that are used by the Oracle Partner
Management application. You can assign the permissions to one of the seeded Oracle
Partner Management roles, or create a new role.

Permissions Used by Oracle Partner Management

Permission Description

PV_INVITE_NEW_PARTNERS Allows a user to invite a partner to join a
partner program. A user with this permission
sees the Invite New Partner button on his
Partners page.

PV_UPDATE_ALL_PARTNERS Allows a user to view and update all partners
in the system and to create a partner list. A
user with this permission sees the Create as
List button on his Partners page.

PV_VIEW_ALL_PARTNERS Provides a user with a read-only view of all the
partners in the system.

OZF_SPECIAL_PRICING_SUPERUSER Allows a user to view, update, and approve
special pricing requests.

OZF_SPECIAL_PRICE_DQM Identifies a user as the Data Quality
Management (DQM) approver for special
pricing. The DQM approver can search for
similar special pricing requests and link them.

OZF_FUND_REQUEST_SUPERUSER Allows a user to view, update, and approve
partner fund requests.

Creating a Vendor User

This section provides basic procedures for setting up a vendor user. As they are
written, the procedures describe how to create a user who is a channel manager. By
assigning the appropriate responsibilities and roles, you can also use these procedures to
create a channel representative and a channel administrator.

Creating a vendor user involves the following steps, which are described in this section:
1. Creating an employee

2. Creating a user and assigning responsibilities

3. Importing the employee as a resource into CRM

4. Assigning resource roles and a resource group

5. Assigning permissions-based roles

The following table lists other Oracle application guides that you can refer to for
additional information about the vendor creation tasks in this section.
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Additional Documentation

Procedure Guide

Creating an Employee Using Oracle HRMS - The Fundamentals
Creating a User and Assigning Responsibilities

Importing the Employee into CRM Oracle Common Application Components

Assigning Resource Roles and Resource Implementation Guide

Groups

Assigning Permissions-Based Roles

Creating an Employee
Employees are added to the Oracle Human Resources Management System (HRMS).

Navigation

Log on to Oracle Forms with the HRMS Manager responsibility and navigate to People >
Enter and Maintain. When the Find window appears, click New.

Prerequisites
None.

Notes
* Action: Select Create Employment.

Creating a User and Assigning Responsibilities

An employee must be assigned a user name, because responsibilities are assigned to
the employee’s user name. The employee will use the user name when she logs in
to Oracle applications.

Navigation

Log on to Oracle Forms with the System Administrator responsibility, and navigate to
Security > User > Define.

Prerequisites
The employee has been created.

Notes
e Person: Use the LOV to find the employee created previously.

* User Name: Create a user name for the employe.

e Password: Enter an initial password for the user, and press Enter. Re-enter the
password, and press Enter again.

The user will be prompted to enter a different password the first time she logs on.

* Responsibility: Use the LOV to select Channel Manager as the responsibility. The
Application, Security Group, and From fields are populated automatically.
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Importing the Employee as a Resource into CRM

Before you can assign resource or permissions-based roles to an employee, she must
be imported into the CRM applications. In this procedure, you search for an employee
and then import her into CRM.

Navigation

Log on to Oracle Forms with the CRM Administrator responsibility, and navigate
to Resource Manager > Maintain Resources > Import Resources to access the Select
Resources to Import window.

Prerequisites
The employee must have been created and assigned a user name and responsibilities.

Steps:
1. Select Employee from the Resource Category list.

2. In the Name field, use the search to find the employee’s name.
3. Click Search. Employee information appears in the Search Results table.
4. Select the correct employee from the table, and click Start Import.
The Set Resource Attributes window appears.
5. Click OK.
The Review and Import Selected Resources window appears.
6. Select the employee and click Save Resource.

7. Click Details to view the resource information for the employee.

Assigning Resource Roles and a Resource Group

In this procedure, you assign an Oracle Partner Management role to the newly created
resource, and then assign the resource to a user group and give the resource a role
in the group.

Navigation

Log on to Oracle Forms with the CRM Administrator responsibility, and navigate to
Resource Manager > Maintain Resources > Resources to access the Find Resources
window, and search for the resource you added in the previous procedure. When
you have located the resource, the Resource window appears, displaying the resource
information.

Prerequisites
The employee must have been imported as a resource into CRM

Steps:
1. In the Resources table, use the LOV to select Partners Relationship Management
as the Role Type.

Use the Role LOV to select Channel Manager as the role.
Click the Groups tab.

In the Groups region, select a resource group name from the LOV.

gk » DN

In the Group Member Roles region, enter the resource’s role in the group.
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The roles available for the resource are determined by the roles you granted the resource
in step 2. In this example, since you assigned the Channel Manager role only, Channel
Manager appears in the Name field automatically.

Note that there are four checkboxes beside the resource name field: Manager, Admin,
Member, and Lead. These boxes provide you with information about the role in the
group; you can not modify the boxes.

Assigning Permissions-Based Roles

In this procedure, you assign an Oracle Partner Management permissions-based role to
a user.

Navigation

Log in to the self-service application with the CRM HTML Administration responsibility
and navigate to Setup > Users > Registration. At the search page, enter the user
name, the employee’s first name, or the employee’s last name to search for the employee.

Prerequisites
The employee has created in the system.

Steps:
1. Click the name of the user to display the User Details page.

2. Click Roles to display the User-Role Mapping page.
3. Add PV_CHANNEL_MANAGER to the user’s Assigned Roles list.

Creating a Channel Administrator

To properly set up and administer Oracle Partner Management, the channel
administrator needs access to other Oracle applications and functions. This section
lists all the responsibilities a channel administrator might need, depending on
implementation requirements. If a channel administrator will also be a channel
manager or channel representative, Oracle Partner Management resource roles and
permissions-based roles need to be assigned as well.

Channel Administrator Responsibilities

Responsibility Description

Application Developer Allows a user to create and modify lookups.
Approvals Management Application Allows a user to create and modify approval
Administration rules and approval groups in Oracle Approvals

Management. Oracle Approvals Management
is used to control the approvals processes for
partner program enrollment requests, special
pricing requests, partner funds requests, deal
registration requests, and lead referral requests.

Channel Administrator Gives user access to the Oracle Partner
Management administration pages and flows.

Channel Manager Gives user access to Oracle Partner
Management.
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Responsibility

Description

Content Super User

Contract Manager

CRM Administrator

CRM HTML Administration

CRM Resource Manager

HRMS Manager

iStore Administrator

Order Management Super User

Oracle Sales Administrator

Oracle Trade Management User

Allows a user to access Oracle Content
Manager. Oracle Content Manager is used to
store content that is used in partner programs
and the Partner Dashboard.

Allows a user to access the Oracle Contract
Manager application, which is used to create
and store contracts associated with partner
programs.

Allows a user to access Oracle Forms

with Customer Relationship Management
Administrator privileges and allows a user
to create resources, resource groups, and the
resource hierarchy. Also give a user access to
the Oracle Territory Manager application.

Allows a user to access the HTML CRM
administration pages, which are used to enable
user types and create and manage permissions-
based roles and assign permissions to roles.

Gives a user access to the CRM Resource
Manager application, which is used to
define, access, and maintain different
categories of resources, and to create and
manage resource roles and resource groups.

Gives a user access to the Human Resources
Management application, which is used

to create and manage employees in Oracle
applications.

Gives a user access to iStore administration.
The Partner Dashboard is set up and
maintained through iStore.

Allows a user to access Oracle Order
Management and to view and update orders.

Allows a user to access Oracle Sales, from
which he can set up the report currency lookup
and run the AS_PERIOD_DAYS table and

the Refresh Multi-Currency Conversion Rate
(AS_PERIOD_RATES) concurrent program to
update currency exchange rates.

Gives a user access to the Oracle Trade
Management application. The channel
administrator uses Oracle Trade Management
to set up budgets, claims, offers, and approvers
used in special pricing, partner funds, and lead
referral registration.
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Responsibility Description

System Administrator Gives a user access to various Oracle
application system administration functions,
including creating users and assigning
responsibilities and administering profile
options and concurrent programs.

Trading Community Manager Allows a user to access the Oracle Data Quality
Management (DQM) application. DQM is
used by special pricing, lead referral, and deal
registration to identify potential duplicate
customers and customer contacts. In
addition, special pricing uses DQM to identify
potential matches for special pricing requests.

Workflow Administrator Web Applications Allows a user to access to Oracle Workflow
Builder. Oracle Workflow Builder is used to
send notifications for deal registration, partner
fund, special pricing, and lead referral
requests. Oracle Workflow Builder requires the
Oracle 9i database.

Workflow User Web Applications Allows a user to access Oracle Workflow, where
the user can view approval requests for which
she is an approver, and approve or deny
requests.

Setting up Resource Groups and a Resource Group Hierarchy

As part of Oracle Partner Management implementation, you may need to set up resource
groups and a resource group hierarchy. The resource group hierarchy allows you to
create a virtual model of your indirect channel management organization and to control
vendor users’ visibility into partner information.

The following figure illustrates how the resource group hierarchy is used to control
vendor users’ visibility into partner information. The example contains two resource
groups: Partners West and California. The California group is a child of the Partners
West group. Each group has a Channel Manager and a Channel Representative. In both
groups, the Channel Reps have access to information about their partners only. In the
California group, Jim can see information about both Tony and Mary’s partners, because
he has the Channel Manager role. In the Partners West group, Linda can see John's
partners because she has the Channel Manager role. In addition, Linda can see
information about all the partners that members of the California group are assigned

to, because the Partners West group is the California group’s parent.
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Resource Hierarchy and Visibility into Partner Information

Linda's partner Linda - Channel Manager
Visibility Partners West Group
(Parent Group)

I
| |
iprnt Jim - Channel Manager
Jim's partner California Group John - Channel Rep.

visibility (Child Group)

Mary - Channel Rep Tony - Channel Rep

Mary's partner

wigibility

Creating a Resource Group and the Resource Group Hierarchy

When you create a resource group, you specify members and roles that can be assigned
to the group. You also define parent and child relationships for the group, which are the
mechanisms by which the resource group hierarchy is developed.

Navigation

Log in to Oracle Forms with the CRM Administrator responsibility, and navigate to
Resource Manager > Maintain Resources > Groups.

Steps:

1. Click the Roles tab to define role types and roles to the group.

* Role Type: Select Partners Management.

* Roles: Add one or more of the roles available for the Partners Management
role type.

2. Click the Parent Group tab to define one or more parent groups for the new group.
3. Click the child Group tab to define one or more child groups for the group.

4. Click the Used In tab to define the Oracle applications that will make use of the
resource group.

5. Click the Members tab to add members to the group. Adding a member to a group
is the equivalent of assigning a resource to a resource group (refer to Assigning
Resource Roles and a Resource Group for more information).

Setting up a Partner Hierarchy

Oracle Partner Management uses a partner hierarchy to assign vendor users to partner
channel teams. A partner hierarchy is created using the Oracle Territory Management
application. When you create a partner territory hierarchy, you specify the qualifiers that
you will use to define the territories, and then create each territory and assign resources
(partners and vendor users) to it. For example, you could create a California territory that
contains partners whose identifying address is in California. Then, you could associate
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the California resource group with the California territory, thus adding the resources in
the California group to the channel team of each partner located in the territory.

Example of a Partner Territory Hierarchy

United States
' |
Western Region Eastern Region
| |
ST California
and Oregon

F 3

Note that the example in the preceding figure is simplistic. In reality, an organization’s
territory hierarchy could contain numerous levels and include more than one
country. Likewise, a territory hierarchy can be built around non-geographic

information. For example, a territory could be built around partner information such
as partner level or type.

Creating a Partner Territory Hierarchy

For instructions on creating a territory, refer to Setting up Territories in Oracle Territory
Management, page 3H6. 1]

Notes

e Usage: Select Oracle Partner Management as the territory usage for the hierarchy to

indicate that the territory will be used to associate partners and channel teams.
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5

Overview

Setting Up Partner Profile Attributes

This chapter covers the following topics:

e Overview |
Partner [Profile Aftributes
Working with Alttributes

Viewing Profile [Attribute Historical [nformation [

Setting Up Custom Attributes

Partner profile attributes provide important characteristic information on Oracle Partner
Management business entities such as partners, partner contacts, leads, opportunities
and so on. Attributes help companies increase knowledge of their partners’
demographics, contacts, and capabilities. They provide information such as who the
partners are, what they sell, where they sell, what industries they focus on, and what
certifications they have. Thus, attributes are set up to capture additional specific business
information for a given business entity within Oracle Partner Management.

Oracle Partner Management provides an extensible framework to manually or
automatically capture any kind of information about your partners, including
performance measures and data derived from external sources. After you have defined
attributes, the channel manager or the partner can enter profile information while
enrolling into programs. The framework supports fixed attributes, information entered
by the partner or channel manager, and derived attributes, information calculated
based on partner data and transactions. Channel managers can use this information to
differentiate partners and provide better services, such as fund requests, incentives, and
opportunities.

Partner Profile Attributes

An attribute is a specific piece of information about an individual partner. Examples of
partner attributes include a partner’s geographic coverage, the number of opportunities
a partner currently has open, and the number of referrals a partner has submitted

year to date (YID).

Attribute information can be collected from a partner program enrollment
request, entered by a vendor or partner user, or calculated based on partner data and
transactions.
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Attribute information is used to create a profile for a partner, and is available from
tabs on a partner’s Partner Details page and View Trends page. Collectively, partner
profile information is used to track key performance indicators that appear on the
channel manager dashboard.

Oracle Partner Management provides you with a thorough set of seeded partner

attributes, which are described in detail in the section, Seeded Attributes, page B2. In

the application, a channel manager can view all the attributes from the Attributes
Overview page. For a description of the information available on this page, refer to
The Attributes Overview Page, page BH11. A channel ddministrator can also create
customized attributes, if needed, to meet her organization’s needs. Refer to Setting up
Custom Attributes, page 520 for additional information.

Seeded Attributes

Oracle Partner Management provides numerous seeded partner attributes. The seeded
attributes track a variety of facts about a partner. For an individual partner, the attributes
provide a thorough, up-to-date partner profile. Collectively, partner attributes are used
to build a 360-degree view of a channel’s performance.

Seeded attributes can be informational or performance based. Informational attributes
provide information about a partner that is unlikely to change frequently, such as

a partner’s industry. Performance attributes provide current information about a
partner’s activities, and are updated by concurrent programs. Most seeded attributes are
performance attributes.

Performance attributes can be cumulative or noncumulative. Cumulative attributes
track information for a specific attribute over a period of time and help the vendor to
track a partner’s performance trends. For example, the attribute Opportunities Won
YTD tracks the total number of indirect opportunities a partner has won during the
current fiscal year. Noncumulative attributes provide information about a partner’s
current status. For example, the attribute Open Opportunities Count lists the number of
opportunities that are open currently for a partner or partners. Currently, you can not
create customized performance attributes.

There are three types of performance attributes:

e Partner Performance Attributes: Partner performance information appears in the
Performance tab of the Partner Detail page. The Performance tab contains tables that
provide information for specific partner attributes. For cumulative attributes, the
year to date (YTD) totals are displayed. Taken in total, the attribute information
provided on the tab provides a profile of a partner’s current performance. Both
cumulative and noncumulative performance attributes are used to track partner
performance.

Partner performance information is calculated by the concurrent program PV
- Refresh attribute text table, which populates the pv_search_attr_trends table.

e Partner Trend Attributes: Partner trend information appears in the View Trends
page, which is accessed by clicking the View Trends button on the Performance tab
on the Partner Details page. A partner trend attribute tracks a partner’s performance
for a particular attribute over a specific period of time. Cumulative performance
attributes are used to track partner trends.

Partner trend information is calculated by the concurrent program PV: Refresh
Partner Trend Values, which populates the pv_entity_attr_trends table.
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e Partner Group Performance Attributes: Partner group performance information
is used to populate the Key Metrics bin on a channel manager’s dashboard. The
Key Metrics bin contains aggregated performance attribute information for all
partners whose data the vendor employee can access (either through channel team
membership or the employee’s role in a resource group). Both cumulative and
noncumulative performance attributes are used to track partner group performance.

The data contained in the Key Metrics bin is populated by a query, which draws data
from the pv_search_attr_trends table and other partner tables. The following table
provides information about Oracle Partner Management seeded partner attributes.

Seeded Attributes

Attribute

Description

Category

Display Style

Enabled For

Additional
Channel Offering

Capacity Rating

Claims Paid

Claims Paid YTD

Country

Customer
Annual Revenue

Deals Accepted

Additional
services
provided by
the partner (
Implementation
specific)

Partner’s
capacity rating
(Implementation
specific)

Total claim
settlement
amount paid for
soft funds and
special pricing
request based on
settlement date

Total claim
amount paid for
soft funds and
special pricing
request based
on settlement
date during the
current fiscal
year

Countries that
the partner has a
presence in

Annual revenue
of the partner as
stored in TCA
table

Total deal

amount accepted

based on deal
creation date

General

General

Marketing

Marketing

General

General

Sales

Multi-Select

Drop-down

Currency

Currency

Multi-Select

Currency

Currency

Performance Tab

Performance Tab

Trends Page

Performance Tab

Performance Tab

Performance Tab

Trends Page
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Attribute

Description

Category Display Style

Enabled For

Deals Accepted
Count

Deals Accepted
YTD

Deals Close Rate

Deal Closed

Deals Closed
Count

Deals Closed
YTD

Deals Submitted
Count

Total number of
deals accepted
based on deal
creation date

Total deal
amount accepted
based on deal
creation date
during the
current fiscal
year

Deals Closed
Count/Deals
Accepted Count

Amount of total
number of closed
opportunities,
based on the
date the deal
status changes
to "Closed.
Opportunity
Won’

Total number
of closed
opportunities
based on the
date the deal
status changes
to 'Closed.
Opportunity
Won’

Amount of total
number of closed
opportunities,
where the deal
status changes
to 'Closed.
Opportunity
Won’ during the
current fiscal
year

Total number of
deals that are not
in draft status
based on deal
creation date
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Sales Numeric

Sales Currency

Sales Percentage

Sales Currency

Count

Sales

Sales Currency

Sales Count

Trends Page

Performance Tab,
Key Metrics Bin

Performance Tab

Trends Page

Trends Page

Performance Tab

Trends Page



Attribute

Description

Category

Display Style

Enabled For

Deals Submitted
YTD Count

Deals accepted
YTD count

Functional

Expertise

Funds Paid

Funds Paid YTD

Funds Requested

Funds Requested
YTD

Geographic
Coverage

Total number of
deals that are not
in draft status
based on deal
created during
the current fiscal
year

Total number of
deals accepted
based on deal
created during
the current fiscal
year

Partner expertise
with regards to
vendor product
or service
offering

Total settlement
amount paid for
fund requests
based on the
settlement date

Total settlement
amount paid for
fund requests
based on
settlement date
during the
current fiscal
year

Total amount
requested for
fund requests
based on the
submitted date

Total amount
requested for
fund requests
based on the
submitted date
during the
current fiscal
year

Partner’s
Geographic
Coverage (
Implementation
specific)

Sales

Sales

General

Marketing

Marketing

Marketing

Marketing

General

Count

Count

Multi-Select

Currency

Currency

Currency

Currency

Multi-Select

Performance Tab

Performance Tab,
Key Metrics Bin

Multi-Select

Trends Page

Performance Tab,
Key Metrics Bin

Trends Page

Performance Tab,
Key Metrics Bin

Performance Tab
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Attribute

Description

Category

Display Style

Enabled For

Inactive Partners

Indirect Sales

Indirect Sales
Prior year

Indirect Sales
YTD

Industry

Last Order Date

Total number of
active partners
that have not
placed an order
(where partner
is the “sold-to")
in the time span
specified by the
profile ” PV:
Inactive Partners
Time Window’

Total amount
based on the
transaction date.
This information
is captured by
Oracle Trade
Management
from the Point-
of-Sale system

Total amount
based on
transaction
date during last
fiscal year. This
information is
captured by
Oracle Trade
Management
from the Point-
of-Sale system

Total amount
based on
transaction
date during the
current fiscal
year. This
information is
captured by
Oracle Trade
Management
from the Point-
of-Sale System

Partner’s
Industry (
Implementation
specific)

Date of the last
order where
partner is the
‘Sold to” party
base on last
ordered date
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General

Sales

Sales

Sales

General

Sales

Count

Currency

Currency

Currency

Multi-Select

Date

Key Metrics Bin

Trends Page

Performance Tab

Performance Tab,
Key Metrics Bin

Performance Tab

Performance Tab



Attribute

Description

Category

Display Style

Enabled For

New Partners

Open Claims

Open
Opportunities

Open
Opportunities
Count

Opportunities
Won

Opportunities
Won Prior year

Opportunities
Won YTD

Total number of
partners created
in the time span
specified by the
profile * PV: New
Partners Time
Window’

Total amount
remaining for

all open claims
generated from
referral, soft
funds and special
pricing

Total amount
of open indirect
opportunities
that a partner is
working on

Total number
of open indirect
opportunities
that a partner is
working on

Total amount

of indirect
opportunities
that a partner has
won based on
decision date

Total amount
of indirect
opportunities
that a partner
has won based
on decision date
during the last
fiscal year

Total amount
of indirect
opportunities
that a partner
has won based
on decision
date during the
current fiscal
year

General

Marketing

Sales

Sales

Sales

Sales

Sales

Count

Currency

Currency

Count

Currency

Currency

Currency

Key Metrics Bin

Performance Tab,
Trends Page, Key
Metrics Bin

Performance Tab,
Trends Page, Key
Metrics Bin

Performance Tab,
Trends Page, Key
Metrics Bin

Trends Page

Performance Tab

Performance Tab
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Attribute

Description Category Display Style

Enabled For

Opportunity
Acceptance Rate

Opportunity
Close Rate

Partner
Enrollment Date

Partner Level

Partner Member
Type

Partner Name

Partner Type

Partnership
Activity

Product
Categories for
Special Pricing

Number of Sales
opportunities

accepted by

partner or the

number of
opportunities

offered to partner

Percentage

Number of Sales
opportunities

won by the

partner or the

number of
opportunities

accepted by the

partner

Percentage

Partner General Date

enrollment date

Partner level ( General
Implementation

specific)

Drop-Down

Partner member  General Radio Button
type (Standard,
Global,

Subsidiary)

Partner Name General Text

Partner type General Check Box
(End user,

Original

Equipment

Manufacturer,

Prospect,

Distributor,

Reseller). Users

can define

additional types

Partnership General Multi-Select
Activity (
Implementation
specific)
Product General Multi-Select
categories that

a partner is

authorized

to submit

special pricing

requests for (

Implementation

specific)
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Performance Tab,
Key Metrics Bin

Performance Tab,
Key Metrics Bin

Performance Tab

Performance Tab

Performance Tab

Performance Tab

Performance Tab

Performance Tab

Performance Tab



Attribute

Description Category

Display Style

Enabled For

Products Bought
Last Year

Products Sold
Last Year

Referral
Commission
Paid

Referral
Commissions
Paid YTD

Referrals
Accepted

Referrals
Submitted Count

List of products ~ Sales
bought by the
partner in the last
twelve months.
(from the current
date) This is
captured by
taking union of
products on all
orders shipped
last year where
Partner is the “Bill
to” party

List of all Sales
products sold
by the partner in
the last twelve
months. (from
the current date)
This metric is
calculated by
taking union

on products on
all line items
maintained in
the POS table
against the given
partner

Total commission Marketing
amount paid

based on the

date the referral

status changes

to 'Closed. Fee

Paid’

Total commission Marketing
amount paid

based on the

date the referral

status changes

to 'Closed. Fee

Paid” during the

current fiscal

year

Total referral
amount accepted
based on referral
creation date

Marketing

Total number of  Marketing
referrals that are

not in draft status

based on referral

creation date

List

List

Currency

Currency

Currency

Count

Performance Tab

Performance Tab

Trends Page

Performance Tab,
Key Metrics Bin

Trends Page

Trends Page
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Attribute

Description

Category

Display Style

Enabled For

Referrals
accepted YTD

Referrals
accepted YTD
count

Referrals
submitted YTD
count

Sales

Sales Prior Year

Sales YTD

Total referral
amount accepted
based on referral
creation date
during the
current fiscal
year

Total number
of referrals
accepted based
on referral
creation date
during the
current fiscal
year

Total number
of referrals that
are not in draft
status based on
referral creation
date during the
current fiscal
year

Total amount
of all orders
shipped where
a partner is the
‘sold-to” party,
based on the
order date

Total amount
of all orders
shipped where
a partner is the
’sold-to” party,
based on order
date during the
prior fiscal year

Total amount
of all orders
shipped where
a partner is the
‘sold-to” party
based on order
date during the
current fiscal
year
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Marketing

Marketing

Marketing

Sales

Sales

Sales

Currency

Count

Count

Currency

Currency

Currency

Performance Tab,
Key Metrics Bin

Performance Tab,

Key Metrics Bin

Performance Tab

Trends Page

Performance Tab

Performance Tab,
Key Metrics Bin



Attribute

Description Category Display Style

Enabled For

State

Total Partners

States that the General Multi-Select
partner has a

presence

Total number General Count
of partners

managed

Performance Tab

Key Metrics Bin

The Attributes Overview Page

A vendor user with the Channel Administrator responsibility can access the Attributes
Overview page. The Attributes Overview page displays all the attributes that can
be associated with a partner. On the page, seeded attributes are indicated with an

asterisk (*).

The following table describes the information that appears on the Attributes - Overview

page.
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Attribute Information

Column

Description

Profile Attribute Name

Attribute Type

Display Style

Category

Attribute Values

Refresh Frequency

Remove

Inactivate

The name of the attribute. Seeded attribute
names can not be modified.

Indicates how the attribute’s data is populated.
Three attribute types are available: list of
values, text box, and derived.

e List of values. A value is selected from
a range of values that the vendor sets
up. Refer to Setting up an Internal List of
Values, page 5416 for more information on
lists of values and attributes.

e  Text box. Data is entered a user.

® Derived. Data is populated by an SQL
query or database function.

For attributes with a type of text box, derived,
or list of values, the display status indicates the
information type of the attribute.

For attributes with a type of list of values, the
display style is flexible, and can be set

up according to a vendor’s business
requirements. Refer to Setting up Attribute
Display Styles, page 516 for additional |
information.

The functional category of the attribute. Refer

to Setting up Attribute Categories, page b{l6for

additional information.

The View Values link appears in this column
if the attribute has an internal List of Values
associated with it. Click View Values to access
the Attribute Details page, from which you can
set up or modify an attribute’s list of values.

The frequency with which the attribute
is updated by the appropriate concurrent
program. Refer to Setting up Refresh
Frequency for additional information.

Select to remove an attribute. You can remove
attributes for which no data has been collected.

Select to disable the attribute in the
application. When you attempt to make an
attribute inactive, the application performs

a check to determine if the attribute is used

in partner program eligibility or opportunity
rules; if the attribute is being used, you can not
inactivate it until you first remove it from the
rule or eligibility requirements.
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Lists of Values for Seeded Attributes

Many attributes are associated with a list of values. For many of the seeded

attributes, and for some derived custom attributes, the list of values is populated from

a Lookup or an external table. The list of values for other attributes can be set up by

a channel administrator. If a list of values can be set up internally, a View Values link
appears in the attribute’s Attribute Values column. Refer to Setting up an Internal List of
Values, page 5116 for more information.

The following table lists the seeded attributes that are associated with a list of values, and
indicates the list of values source and additional information. The source can be the
name of a Lookup, a SQL statement, or Internal if the list of values is created from within

Oracle Partner Management.

Sources for Lists of Values for Seeded Attributes

Attribute

Display Style

List of Values Source

Enabled For

Functional Expertise

Product Categories
for Special Pricing

Partner Type

Country

Industry

Partner Member Type
Geographic Coverage

Additional Channel
Offering

Partnership Activity

Multi-Select

Multi-Select

Check Box

Multi-Select

Multi-Select

Radio Button

Multi-Select

Multi-Select

Multi-Select

ENI_PROD_
DEN_HRCHY_
PARENTS_V WHERE
PURCHASE_
INTEREST ="Y" AND
(DISABLE_DATE IS
NULL OR DISABLE_
DATE > SYSDATE)

ENI_PROD_
DEN_HRCHY_
PARENTS_V WHERE
PURCHASE_
INTEREST ="Y" AND
(DISABLE_DATE IS
NULL OR DISABLE_
DATE > SYSDATE)

INTERNAL

FND_TERRITORIES_
VL

LOOKUP (PRM_
IND_CLASSIFICAT
ION_TYPE)

INTERNAL
INTERNAL

INTERNAL

INTERNAL

Partner

Partner

Partner

Partner, Opportunity

Partner, Opportunity

Partner

Partner, Opportunity

Partner, Opportunity

Partner, Opportunity
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Attribute

Display Style

List of Values Source Enabled For

Campaign

Capacity Rating
Partner Level

State

Customer

Opportunity Status

Product Category

Sales Channel

Sales Stage

Offer

External List of Values

Drop Down
Drop Down

Multi-Select

External List of Values

Drop Down

Multi-Select

Drop Down

Drop Down

External List of Values
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AMS_P_SOURCE_
CODES_V WHERE
SC.STATUS IN ("ACT
IVE’, 'ONHOLD’,
'"COMPLETED’) AND
SC.SOURCE_TYPE
IN (EVEH',/EVECO’,
"CAMP”’,/CSCH’)

INTERNAL
INTERNAL

AR_LOCATION_
VALUES WHERE
LOCATION_
SEGMENT_QUAL
IFIER = 'STATE’

ASF_CUSTOMER_
LOV_V WHERE
PARTY_TYPE IN
('ORGANIZATION’, ’
PERSON’)

AS_STATUSES_VL
WHERE ENABLED _
FLAG ="Y" AND
OPP_FLAG ="Y

ENI_PROD_
DEN_HRCHY_
PARENTS_V WHERE
PURCHASE_
INTEREST ="Y" AND
(DISABLE_DATE IS
NULL OR DISABLE_
DATE > SYSDATE)

ASO_I_SALES_
CHANNELS_V
WHERE ENABLED _
FLAG ="Y’

AS_SALES_STAGES_
ALL_VL WHERE
ENABLED_FLAG
="Y" AND SYSDATE
BETWEEN START_
DATE_ACTIVE AND
NVL(END_DATE_
ACTIVE, SYSDATE)

AMS_P_SOURCE_
CODES_V

Opportunity

Partner, Opportunity
Partner, Opportunity

Partner, Opportunity

Opportunity

Opportunity

Opportunity

Opportunity

Opportunity

Opportunity



Attribute

Display Style

List of Values Source Enabled For

Win Probability

Sales Methodology

Customer/Account
Type

Routing Status

Customer Category

Products Bought Last
Year

Products Sold Last

Drop Down

Drop Down

Drop Down

Drop Down

Drop Down

Multi-Select

Multi-Select

AS_FORECAST_
PROB_ALL_

VL WHERE
ENABLED_FLAG
="Y’AND ((SYSDATE
BETWEEN START_
DATE_ACTIVE AND
END_DATE_ACT
IVE) OR(SYSDATE

> START_DATE_
ACTIVE AND END_
DATE_ACTIVE IS
NULL))

Opportunity

AS_SALES_
METHODOLOGY_
VL WHERE SYSDATE
BETWEEN START_
DATE_ACTIVE AND
NVL(END_DATE_
ACTIVE, SYSDATE)

Opportunity

LOOKUPS
(CUSTOMER_
ACCOUNT_TYPE)

Opportunity

LOOKUPS (PV_
ROUTING_STAGE)

Opportunity

AR_LOOKUPS
WHERE LOOKUP_
TYPE ="CUSTOMER_
CATEGORY” AND
ENABLED_FLAG

= IYI

Opportunity

MTL_SYSTEM_ Partner
ITEMS_B WHERE
ORGANIZATION_ID

= FND_PROFILE.

VALUE('ORG_ID)

MTL_SYSTEM_ Partner

Year ITEMS_B WHERE
ORGANIZATION_ID
= FND_PROFILE.
VALUE('ORG_ID’)

Working with Attributes

A channel administrator may need to perform the following tasks, either during
implementation or as on-going administrative tasks:

e Setting up Attribute Categories

e Setting up Attribute Display Styles

e Setting up an Internal List of Values

Setting Up Partner Profile Attributes
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e Setting up Refresh Frequency

* Refreshing Attribute Values with Concurrent Programs

Setting up Attribute Categories

Attributes can be organized into different functional categories: General,
Marketing, PRM, Resource, or Sales. The categories are used to group attributes on
Profile, Performance, and Opportunity tabs on the Partner Details page.

A vendor user can set up additional categories either during or after
implementation. Additional attribute categories are added through Oracle
Forms, by adding new lookup values to the lookup type Attribute Categories
(PV_ATTRIBUTE_CATEGORY_TYPE).

Setting up Attribute Display Styles

An attribute’s Display Style indicates the type of control that will be used to provide
information about the attribute. An attribute’s Display Style is determined by its
Attribute Type. Most of the seeded attributes with an Attribute Type of List of Values
have flexible Display Styles, which can be set up by the channel administrator according
to business requirements.

Depending on the drop-down list associated with the attribute, the channel manager can
select one of two Display Style controls:

*  Multiselect or check box
¢ Radio button or drop-down list

When a channel administrator creates a custom attribute, she indicates both the attribute
type and display style. For more information, see Setting up Custom Attributes, page

5-20. 1]

Setting up an Internal List of Values

When the View Values link is available for an attribute, a channel administrator can set
up an internal list of values for the attribute. Click the View Values link to access the
Attributes - Overview page and set up populate an attribute’s internal list of values.
Notes

e Description: How the attribute appears in the list.

e Inactive: Select to prevent the attribute from appearing in the list.

Setting Up Refresh Frequency

Attributes that track partner performance and trends need to be refreshed
periodically. You set up an attribute’s refresh frequency from the Attribute Details

- Properties page, which is accessed by clicking the Refresh Frequency link for an
attribute. The refresh frequency is subsequently used by concurrent programs to update
an attribute’s information.

How frequently a specific attribute should be refreshed depends on business
requirements. You can specify that an attribute be refreshed hourly, daily, weekly, or
monthly:

e Hour - Refresh if the last refresh exceeds the specified number of hours.
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* Day - Refresh if the last refresh exceeds the specified number of days.

*  Week - Refresh if the last refresh occurred before the specified number of weeks. It is
important to note that one week does not always equal seven days. For example, if
the refresh frequency was set to one week, and the last refresh occurred on Friday, if
the concurrent program runs on Monday the attribute will be refreshed again
because the week has changed.

* Month - Refresh if the last refresh occurred before the specified number of months.

When setting up a refresh frequency, you should also take into consideration whether or
not an attribute’s value is derived from, and thus dependent upon, another attribute. For
information on attribute refresh dependencies, refer to Understanding Performance
Attribute Refresh Dependencies.

Attributes for which you have not assigned a refresh frequency are refreshed whenever
the concurrent programs run.

Understanding Performance Attribute Refresh Dependencies

Many of the partner performance and partner group performance attributes derive their
values from other attributes. Specifically, many of the partner performance attribute
values are derived from partner trend measures, while many of the partner group
performance attribute values are derived from partner performance attributes.

When an attribute is dependent upon another attribute for its value, the other attribute
must be refreshed before the dependent attribute can be updated successfully. You must
understand attribute dependencies to properly set up refresh values. The following table
maps the dependencies between the three types of performance attributes.

Performance Attribute Refresh Dependencies

Partner Group Measure Depends on Partner Depends on Partner Trend
Measure Measure

Open Opportunities Count Open Opportunities Count Open Opportunities Count

Open Opportunities Open Opportunities Open Opportunities
Sales YTD Sales YITD Sales

Indirect Sales YTD Indirect Sales YTD Indirect Sales
Opportunity Close Rate Opportunity Close Rate -

Opportunity Acceptance Rate  Opportunity Acceptance Rate -~

Referral Commissions Paid Referral Commissions Paid Referral Commission Paid
YTD YTD
Referrals Accepted YTD Referrals Accepted YTD Referrals Accepted

Referrals Accepted YTD Count Referrals Accepted YTD Count -~
Deals Accepted YTD Count Deals Accepted YTD Count Deals Accepted Count

Deals Accepted YTD Deals Accepted YTD Deals Accepted
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Partner Group Measure

Depends on Partner

Depends on Partner Trend

Measure Measure
Funds Requested YTD Funds Requested YTD Funds Requested
Funds Paid YTD Funds Paid YTD Funds Paid
Open Claims Open Claims Open Claims
- Sales Prior Year Sales

Total Partners

New Partners

Inactive Partners

Indirect Sales Prior Year
Opportunities Won YTD
Opportunities Won Prior Year

Referrals Submitted YTD
Count

Deals Close Rate

Deals Closed YTD
Deals Submitted YTD Count

Claims Paid YTD

Indirect Sales
Opportunities Won
Opportunities Won

Referrals Submitted Count

Deals Closed Count divided
by Deals Accepted Count

Deals Closed
Deals Submitted Count

Claims Paid

Refreshing Attribute Values with Concurrent Programs

The refresh frequency value is used by one of two concurrent programs to determine
whether or not an attribute needs to be updated.

* PV: Refresh Partner Trend Values - This program calculates the partner trend

performance measures summarized at a monthly level.

® PV: Refresh Attribute Text Table - This program calculates the performance and
derived attributes for each partner and allows the attribute details for a particular

partner to be used in the matching process.

There are two options for running this program - Full Refresh or New Partners Only. The
Full Refresh option is the default option. The New Partners Only option picks up all the

newly created partners since the last refresh of this type. The last refresh date is stored in
the profile PV: Refresh Search Attributes Last Update Date.

The following table provides the parameters of the PV: Refresh Partner Trend Values
concurrent program.
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PV: Refresh Partner Trend Values Parameters

Parameter Description

Start from Beginning of Month Identifies the starting month to refresh (only
applies to measures that are cumulative). Non-
cumulative measures are always calculated for
the current month only.

To Ending of Month Identifies the ending month to refresh (only
applies to measures that are cumulative). Non-
cumulative measures are always calculated for
the current month only.

New Partners Only If Yes, then only process for new partners. New
partners are defined as partners created after
the last refresh run of this concurrent program
(stored in the profile 'PV: Partner Trend Last
Refresh’).

Ignore Refresh Interval If Yes, process all attributes even though the
time interval from the last refresh have not
exceeded the refresh interval set for some
attributes.

For currency measures, the PV: Refresh Partner Trend Values concurrent program
converts all currency to the currency stored in the profile PV: Common Currency for
Rules Engines. If this profile is not set, it defaults to USD.

The following table provides the parameters of the PV: Refresh Attribute Text Table
concurrent program.

PV: Refresh Attribute Text Table Parameters

Parameter Description

New Partners Only Only process for new partners. New partners
are defined as partners created after the last
refresh run of this concurrent program (stored
in the profile PV: Refresh Search Attributes
Last Update Date).

For currency measures, this concurrent program converts all currency to the currency
stored in the profile PV: Common Currency for Rules Engines. The default value is USD.

Viewing Profile Attribute Historical Information

A vendor user can view historical information about an attribute. The historical
information includes a record of the changes made to an attribute and a snapshot of
a partner’s profile for a specified date.

Setting Up Partner Profile Attributes 5-19



Viewing Attribute Change History

Partner profile attributes are frequently updated by users or concurrent programs. You
can view an attribute’s change history to determine what changes have been made to the
attribute, who made the changes, and when they were made.

To view an attribute’s change history, navigate to a partner’s Partner Details page, and
click the Profile tab. Navigate to a the attribute’s category, click the View History
button, and then select the attribute from the drop-down list that appears.

Viewing a Partner Profile Snapshot

The partner profile snapshot provides you with a partner’s profile values for a specific
historical date. A profile snapshot allows a user to compare a partner’s current profile
with a past profile.

To view partner profile snapshot, navigate to a partner’s Partner Details page, and click
the Profile tab. In the Values as Of field, enter a date. The profile values will be updated
to reflect the partner’s profile as of the date entered.

Setting Up Custom Attributes

A channel administrator can create custom attributes to track additional information
about partners. Customized attributes can be used to gather information about a partner
or to derive information from other sources through SQL statements and database
functions.

Navigation

Log on with the channel administrator responsibility, navigate to the Attributes
Overview page, and click the Create button that appears on the Attributes - Overview
page to access the Create Attribute page.

Notes

* Attribute Type: Select Text Box, List of Values, or Derived. The attribute type
determines the options that will be available in the Display Style drop-down
list. Subsequently, the Display Style further determines what additional information
must be provided for an attribute.

* Status: Selecting Active makes the attribute visible in the application.

* Expose to Partner: Makes the attribute visible to partners from their profiles. Not
selecting this option for an attribute makes it visible to vendor users only.

* Requires Data Validation: Selecting this attribute indicates that updates made to the
attribute must be approved. When an update is made to the attribute for a specific
partner, an email notification is sent to the channel manager(s) for the partner
informing him of the change. In addition, the validation history for the attribute is
tracked for the attribute for each partner.

Two icons appear beside an attribute that requires validation. One icon takes a user
to the Validation Information page, which allows the user to provide notes or
documentation to support the change. The other icon takes a user to a page that
displays the attribute’s validation history.

¢ Related To: Enables the attribute for use in specific areas of the application. All the
following options are available for Text Box and List of Values attributes; for a
Derived attribute, only the Partner and Opportunity options are available.
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e Partner: Makes the attribute visible on Partner Details pages. The section or tab
that the attribute appears in is determined by the Category selection.

e Lead Referral: Select to enable the attribute for use when creating questions
associated with a Referral benefit. When a partner user submits a referral, the
answers she provides are used to update the partner’s profile.

e Partner Contact: Select this option to display the attribute on partner contact
pages.
¢ Deal Registration: Select to enable the attribute for use when creating questions

associated with a Deal Registration benefit. When a partner user submits a deal
registration, the answers she provides are used to update the partner’s profile.

e Opportunity: Select this options to associate the attribute with
opportunities. The attribute will appear on opportunity pages.

* Countries: Associates an attribute with one or more countries. When a country is
selected for an attribute, the attribute is available for partners whose identifying
address matches the country. More than one country can be selected for an
attribute. The default is All

e Partner Types: Select one or more partner types to limit the attribute to specific types
of partners, or select All to use the attribute for all partners.

e Enabled for Locator: Select to include an attribute in the Partner Locator. Enabling
an attribute for the Partner Locator allows a potential customer to use the attribute to
search for a partner.

¢ Enabled for Matching Services: Select to enable an attribute to be used in the
following areas:

e Opportunity Matching: Enabling an attribute for matching services enables
it to be used for automatic and manual opportunity matching. Note that you
also need to select Related To: Opportunity for the attribute to be available
for opportunity matching.

¢ Partner Program Requirements: Enabling an attribute for matching also makes
it available for use as a requirement for a partner program.

The following table lists all the attribute types and display styles available for custom
attributes. The table also provides additional information for those attributes and
display styles that require additional information during set up.
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Attribute Types and Display Styles

Attribute Type Display Style Additional Information for
Attribute
List of Values Check Box No
Multi Select Enter the number of lines to be
included in the list.
Percentage By default, the percentage

Radio Button
Drop Down

Text Box Currency

Date

Numeric

Text
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values must add up to 100%.
To change the percentage
total, modify the profile value
PV: Attribute Percentage Total.

No
No

Decimal points: Number
of decimal points used for
rounding.

Character Width: number of
characters allowed in the text
box.

Value Type: Used to evaluate
attribute during opportunity
matching. Specify Minimum
or Maximum.

Value Type: Used to evaluate
attribute during opportunity
matching. Specify Minimum
or Maximum.

Decimal points: Number of
decimal points used to round
amounts.

Value Type: Used to evaluate
attribute during opportunity
matching. Specify Minimum
or Maximum.

Number of lines: The number
of lines to be allowed in the
text box.

Character Width: The number
of characters allowed in the
text box.



Attribute Type Display Style Additional Information for

Attribute
Derived Currency No
Date No
Numeric Value Type: Used to evaluate

attribute during opportunity
matching. Specify Minimum
or Maximum.

Text No
List of Values No
Percentage Value Type: Used to evaluate

attribute during opportunity
matching. Specify Minimum
or Maximum.

Creating a Derived Attribute

Creating a derived attribute involves providing “code” that is used to populated
attribute values. A derived partner profile attribute can be populated by a PL/SQL
stored procedure or package, or by a SQL statement. A user-defined SQL statement
is used to populate the list of values that is associated with an attribute with List Of
Values value type.

Coding for derived attributes is done in the Derived Attribute Properties section of the
Attribute Detail page. This section appears when you click Create after providing the
attribute’s initial details.

Notes

LOV Lookup SQL: If List Of Values was selected as the attribute’s value type, this
field appears, and contains a sample SQL statement. The user changes the SQL
statement to generate the desired list of values.

Value Type: If numeric or percentage was selected as the attribute’s value type, this
field appears. Value type is used to evaluate the attribute during opportunity
matching. Select Minimum to indicate that the attribute with the lowest value wins;
select Maximum to indicate that the attribute with the highest value wins.

Enabled For: Indicates the areas of the application to which the attribute will
apply. If multiple areas are selected, a different function can be created for each.

Function Name: The function name and code. A function is actually

a PL/SQL package. The package and procedure must exist in the
database. The function name for the attribute must follow the following
format: <procedure-name>(;party_id,:output)

Validate: Click to check a SQL statement’s syntax or to check a function’s syntax and
to validate that the function appears in the database.
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Example: Populating a Derived Attribute with a Stored Procedure

Derived attributes support all the return types that are currently supported by Oracle
Applications: currency, date, null_check, number, and string.

Currently, the following procedure template is supported. The procedure expects an IN
parameter of NUMBER type and an OUT parameter of JTF_VARCHAR2_TABLE_4000
type:
PROCEDURE <procedure-name>
(

p_partner_id NUMBER,

x_output OUT JTF_VARCHAR2_TABLE_4000

)
IS

<declarations>
BEGIN

x_output := JTF_VARCHAR2_TABLE_4000();

<logic to derive the output values and store them in x_output tab
le>
END;
The following is an example of a procedure that would be used to create an attribute
that calculates a partner’s actual revenue:

PROCEDURE Partner_Revenue
( p_partner_id NUMBER,
x_assigned_count OUT JTF_VARCHAR2_TABLE_4000 )

IS
CURSOR Ic_count IS
SELECT orgp.curr_fy_potential_revenue annual_revenue
FROM apps.pv_partner_profiles PV, apps.hz_organization _profil
es orgp

WHERE orgp.curr_fy_potential_revenue 1S NOT NULL
AND orgp.party_id = pv.partner_party_id
AND pv.partner_id = p_partner_id ;
indx NUMBER := 1;
BEGIN
x_assigned_count := JTF_VARCHAR2_TABLE_4000();
FOR Ic_cursor IN Ic_count LOOP
x_assigned_count.EXTEND;

x_assigned_count(indx) := lc_cursor.annual_revenue;
indx = indx + 1;
END LOOP;

End;

Example: Populating a Derived Attribute with a SQL Statement

The application provides a the following sample SQL statement that can be modified to
create a custom SQL statement for a list of values:

select pac.attr_code code,
pac.description meaning,
pac.description description from
pv_attribute_codes_v1 pac where
pac.attribute_id = ? and
pac.enabled_flag = 'Y’

In the SQL statement, attribute_id can refer to a table column or an actual attribute id.
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For a derived attribute with a List Of Values value type, a list of values is provided
through a user-defined SQL statement. The following example provides a SQL statement
for a derived list of values attribute where:

e The attribute id = xxxx
e The list of values is derived from an external lookup FND_EXAMPLE_LOOKUP

select Ikp.lookup_code code,

Ikp.meaning meaning,

Ikp.description description

from fnd_lookups Ikp

where Ikp.lookup_type = 'FND_EXAMPLE_LOOKUP'.
and xxxx= ?

Setting Up Partner Profile Attributes  5-25






6

Overview

Setting Up the Partner Dashboard

This chapter covers the following topics:

e  Overview |

Setting Up the Hartner Dashboard
Creating the Partner Dashboard Web [Pages
Creating the Partner Dashboard Site

Creating [Partners and [Partner Users

Creating [Partner Program Enrollment [Pages

Giving [Partners[Access to the Library
Profile Options | |

The partner dashboard provides partner users with a single point of entry for working
with the vendor. From the dashboard, partners can:

* Register as a partner, and then enroll in programs for which they are eligible.
* Manage their memberships including upgrades and renewals.

e Manage transactions such as viewing the catalog, placing orders, managing sales
opportunities, and accepting opportunities.

® Submit referrals, register deals, request marketing funds, request special pricing, and
create quotes.

* Maintain the partner contact and company profile.
* View notifications.
e Access content published by the vendor.

The Partner Dashboard is the mechanism by which partner organizations are entered into
Oracle Partner Management and partner users are added to the system. Thus, partner
organizations and users are not set up directly by a vendor user, but instead are created
automatically as a result of self-registration. This chapter describes how partner users
are set up and the roles and permissions that they are assigned.

The Partner Dashboard is configured and managed through the Oracle iStore
application. This chapter provides basic information to help you get started setting up a
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Partner Dashboard. For more thorough information, refer to the iStore Implementation
Guide.

Setting Up the Partner Dashboard

Oracle Partner Management integrates with Oracle iStore to provide the Partner
Dashboard. The Partner Dashboard is an iStore web site, and is set up through the
iStore application.

A site is any site that the site administrator (manager) creates using the Oracle iStore
Site Administration user interface. From this interface, the site administrator creates
the Partner Dashboard site by selecting a template to use to format the site, selecting
appropriate text, images, and hyperlinks to populate the site, and setting up the
Dashboard as a live, specialty site that is linked to a partner responsibility.

Multiple specialty sites can exist within one site, as each site-responsibility combination is
considered a specialty site. Speciality sites can be assigned to groups. The Partner group
is shipped out of the box to facilitate customers to group partner sites into a single group.

The iStore user interface allows a vendor organization to implement the Partner
Dashboard so the it meets the organization’s business needs. To help you get
started, Oracle Partner Management provides some seeded bins that can be used in
the dashboard. In addition, iStore profiles the Configurable Layout Template, which
provides a simple yet highly usable page format.

Using the Configurable Layout, you can create an effective partner dashboard for your
partners. You can easily modify the seeded template by changing the style sheet and
mapping your branding. The seeded dashboard allows you to deliver content to your
partner using the central section and provide access to the transactional system by
mapping the seeded bins (my opportunity, quick links and manage my partner bins) to
the left and right locations. You can also use the locations on the left and right to map the
Available programs, upgrade, renewal bins. You can also support registration through
the registration global icon to support self service registration.

For example,
®  One location delivers the links for navigation to the transactional system.

* Another location delivers messages for partners via integration with Oracle
E-merchandising.

* Another location enables vendors to deliver content by leveraging Oracle Content
Management (OCM) and Oracle iStore (Section Hierarchy functionality).

e The dashboard displays a summary of transactions and partners can click a link to
navigate to the functional system. The list of transactions available depends on the
partner enrollments and the role. For example, if a partner is authorized to resell a
vendor’s products, the partner is assigned sales opportunities for fulfillment.

Using the Partner Dashboard Template Layout

The following figure displays the seeded partner dashboard template layout with top
header, menu and bottom header locations.
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Partner Dashboard Template Layout

Menu
Top Header
LEFT 1 RIGHT 1
MIDOLE 4
LEFT 2 RIGHT 2
MIDDLE 2
LEFT 3 RIGHT 3
LEFT 4 CEMTRE RIGHT 4
LEFT 5 RIGHT &
MIDDLE 3
LEFTE RIGHT &
MIDDLE 4
LEFT ¥ RIGHT 7
Bottom Header

¢ The top header layout component renders <html>, <head> tags. Customers can add
any thing that they would like to see before rendering the menu. It provides an area
for global icons, sections, and company logo located at the top of the page.

* The menu layout component renders logos, global icons, and the menu.
* The bottom header layout component renders </html> tags.

* The Top, Left 1-7, Middle 1-4, Right 1-7, Bottom and Center layout components do
not have templates mapped for the Configurable Layout.
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¢ To map a template for Top, Left 1-7, Middle 1-4, Right 1-7, and Bottom layout
components, navigate to Catalog > Section > Section Details > Templates >
Layout > Configurable Layout.

¢ To map a template for the Center layout component, see Steps 6, 7 and 8 of the
procedure, Creating the Partner Dashboard Pages.

Setting Up Partner Dashboard Bins

When a partner user first logs into the dashboard, he sees bins such as Quick Links

bin, Renewals bin, Upgrade bin, Available Programs bin, and My Opportunities bin (if
the vendor has set them up). For partners to be able to view the bins, you must map the
seeded templates. Each bin is defined as a template. Some bins are provided to customers
so that they can map the bins to any template-site combination, during implementation.

The following bin templates are shipped out of the box. The vendor organization needs
to map these bin templates to appropriate locations for the Configurable Layout:

Quick Links Bin

Quick Links bin

Renew Programs bin
Upgrade Programs bin
Available Programs bin
My Opportunities bin
Manage My Partners bin
Welcome bin

Marketing Posting bin
Partner Group bin

Store Group bin

This bin provides links to referrals, deal registrations, opportunities, special
pricing, claims, fund requests, and messages. The list is based on vendor implementation
and the partner responsibility.

The transaction records within each area, depend on the following:

Partner benefits. Partners have to be entitled to use each type of benefit. The
benefits displayed to the partner users in the Quick Links bin are controlled using
responsibilities. The list of links available in the bin depends on the current
responsibility assigned to the user and the functions and menus attached to that
responsibility. For the links to appear in the Quick Links bin the following setup
needs to be done:

1. Define a menu that contains all functions, exposed to the partner user.

2. Specify this menu name as the value for the responsibility level profile option
"IBE: Quick Links Menu’ that is assigned to the user. This menu specified in the
profile should be one of the sub menus under the root menu.

User role within the partner organization. Partners can access transactions that
they created or are assigned to them. For example, if an opportunity is assigned to a
partner, the partner can see that opportunity. If a partner created a referral, he/she
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can view the referral. Partner administrators can access all transactions created by
any user or, transactions assigned to any user, within their organization.

Renew Programs Bin

This bin displays programs that are up for renewal. The bin is available only to partner
administrators to assist them manage their memberships. The partner administrator
can review programs and start the enrollment process by clicking the Program Name
link. The renew option appears to the user when the program is up for renewal. The
default value is set to 60 days before membership expires.

Upgrade Programs Bin

This bin displays programs that partners can upgrade to. The bin is available only
to partner administrators to assist them manage their memberships. The partner
administrator can review programs and start the enrollment process by clicking the
Program Name link.

Available Programs Bin

This bin provides the ability to view program details and start the enrollment

process. The bin is displayed only to the partner administrator. The link on the program
name navigates to the program details page. If the user clicks on the Enroll button, they
can navigate to the questionnaire page for enrolling in that program.

My Opportunities Bin
This bin is displayed to partners who have offered opportunities in the queue to accept
and where the routing status is Offered. Partners can navigate to the opportunity link

to go to the Opportunity Detail page and view details of the opportunity. They must
have the permission OPPTY_CONTACT to view this bin.

Manage My Partners Bin

This bin displays the Invite New Partner and View Partner links for

distributors. Distributors must have the Channel Manager role or Channel
Representative role to see this bin. Distributors should also have the
PV_INVITE_NEW_PARTNER permission to see the Invite New Partner link in this bin.

Welcome Bin

This bin displays a welcome message with the user name and allows users to switch
accounts if they have multiple accounts. User can switch between accounts before
enrolling into a program or before submitting a referral to use a particular account.

For more information, see Oracle iStore Implementation Guide.

Marketing Posting Bin

This bin displays marketing postings. E-Merchandising banners are used to deliver
marketing messages to partners who can click on the bin to see more details about the
marketing campaign.

For information on the implementation steps necessary for this bin, see Oracle iStore
Implementation Guide.
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Partner Group Bin

Oracle iStore seeds a bin template which displays sites associated to the group, Partners.
To display this group, map the logical template, PARTNER_GROUP_BIN_IBEWC, to
the bin layout component of your choice.

For more information about the bin template, see Seeded Bins in the Oracle iStore
Implementation Guide.

Store Group Bin

For information on this bin, see the Oracle iStore Implementation Guide.

Bin JSPs -Template Mapping

The following table lists the templates and corresponding bin JSPs that can be
customized as per guidelines in the Oracle iStore Implementation Guide.

Bin JSPs

Template Bin JSP Name

Available Programs Bin pvxCPvdPrgmNewBin.jsp
Renew Programs Bin pvxCPvdPrgmRenewBin.jsp
Upgrade Programs Bin pvxCPvdPrgmUpgradeBin.jsp
My Opportunities Bin pvxCPvdMyOffrdOppBin.jsp
Manage My Partner Bin pvxCPvdMngPrinrBin.jsp
Accessible Stores Bin ibeCAcdGroupSiteBin.jsp
Emerchandising Postings Bin amsWebPlacement.jsp
Welcome Bin ibeCAcdWelcome.jsp

The Quick Links and Marketing Postings bin are part of Oracle iStore. The

Renewals, Upgrades, Available Programs and My Opportunities bins are included in
Oracle Partner Management. These bins display content only to authenticated partner
users. These bins do not display content for guest users even when the bins are mapped
to sites that can be browsed by guest users.

The following APIs can be used to get data for the respective bins. Java Class is
oracle.apps.pv.enrollment.bin.BinContent.

* public Vector newPrograms(...)

* public Vector renewable_programs(...)
* public Vector upgradable_programs(...)
¢ public Vector incomplete_programs(...)

For the Opportunity bin, the api is in: oracle.apps.pv.bin.MyOfferedOpptyBinDataSource
and the method is public Vector getBinData(...)
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Understanding iStore Partner Templates

The following templates are used in partner specific profiles pages in the partner
dashboard:

* Sales Preferences: Template to view the sales preferences page. Navigate via the
Profile icon > My Profile > Preferences.

e Update Partner Profile: Template to view the partner organization’s profile
page. Navigate via the Profile icon > Company Profile > Company Information >
Profile tab.

e Update User Profile Page: Template to view the contact’s Update Profile
page. Navigate via the Profile icon > My Profile > Personal Information > Profile tab.

e View Channel Team for Partner: Template to view the channel team page. Navigate
via the Profile icon > Company Profile > Channel Team.

e View Current Partner Memberships: Template to view the memberships
page. Navigate via the Profile icon > Company Profile > Memberships.

* View Partner Profile: Template to view the partner organization’s profile
page. Navigate via the Profile icon > Company Profile > Company Information >
Profile tab.

e View User Profile Page: Template to view the contact’s profile. Navigate via the
Profile icon > My Profile > Contact Information > Profile tab.

e Update User Profile: Template for the contact update profile. Navigate via the
Profile icon > Administration > Contact Management > Details > View Profile.

e View User Profile: Template to view the contact’s profile. Navigate via the Profile
icon > Administration > Contact Management > Details > View Profile.

Creating the Partner Dashboard Web Pages

After you had determined that the Partner Dashboard pages are complete, complete this
procedure to set up the pages as an actual web site accessible by partner users. Partner
Dashboard sites are created in iStore by a user with the iStore Administrator
responsibility.

Navigation

Log on with the iStore Administrator responsibility, and navigate to the Catalog tab >
Catalog Hierarchy page.

Prerequisites
None.

Steps:

1. Select the Root section for Oracle Partner Management and click the Create Section
icon in the sections column.

The Root section is seeded. The Create Section page appears.
2. Enter the necessary details and click Apply.

Make sure that the status is Published and the dates are active. The Update Section
Details page appears.

3. To associate a template with the section, select the Templates side navigation link.
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The Update Section: Layout page appears.

4. In the Layout region, from the Select Layout LOV, select a layout that you want to
apply to the above create section and click Go. The layout determines the bins
that are to be displayed on the left and right sides of the dashboard. The values
are: Configurable and Fixed Layout.

5. If you select the Configurable layout, perform the following steps to map the bins to
templates. The templates are seeded in Oracle iStore.

1. In the Mapping region, select a template from the Layout Component Templates
LOV and map it to a layout component.

2. Click Apply.

6. If you selected the Fixed Layout, you must map the bin JSPs to templates. You
cannot see the Mapping region because the templates are already positioned and the
layout cannot be configured.

1. Navigate to Advanced tab > Template Manager > Templates page.

2. Select Programmatic Access Name from the Search field and enter
STORE_CTLG% and click Go. All seeded locations are displayed.

3. Click Update for the Bin Left 1 record.
4. In the Update Template page, click Add Source File.

5. In the Add Source File page, in the Source File Name field, enter the JSP for
Quick Links. For example, vin-ibeCAcdQuickLinkBin. jsp.

6. Select the above created site from the Site drop-down list and click Apply. The
Update Template page appears with the JSP mapped to the bin.

7. Select the Display Layout side navigation link.

The Update Section: Display Template page appears. This page displays the format
of the center bin.

8. From the Select a Display Template drop-down list, select Component for Section
Contains Navigational Subsections only and click Go.

A section called Section Contains Navigational Subsections Only appears in the
bottom with different display templates.

Some templates are shipped to customers. The templates enable customers to
select how they would like to view content in the center. Customers can use the
following templates to display content:

e Multilevel Subsection list with Content under Component for section contain
navigation subsections only: This template is specifically designed to show
subsections within a section, along with content mapped to content components
at the section level.

® Section detail under section containing products only: This template is only
available for configurable layout. This template is specifically designed to
show section details, along with content mapped to content components
at the section level.

9. Select the Multilevel Subsection List template to be used in subsections and click
Apply.
The Display Template for the section is selected.
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For information on the center template, refer to the Oracle iStore Implementation Guide.

Creating the Partner Dashboard Site

After you had determined that the Partner Dashboard pages are complete, complete this
procedure to set up the pages as an actual web site accessible by partner users. Partner
Dashboard sites are created in iStore by a user with the iStore Administrator
responsibility.

Navigation

Navigate to the Catalog tab > Catalog Hierarchy page.

Prerequisites

The Partner Dashboard web site pages have been created.

Steps:
1. pNavigate to the Sites tab and click Create a Site and enter necessary details.
2. In the Catalog Root Section field, select the section created above.
Select the Restrict customer access by responsibility check box.
Do not select the Allow un-registered users to browse the site check box.
3. Click Apply.
A site is created and the Update Site: Details page appears.
4. Click the Responsibility side navigation link.
The Site ABC: Supported Responsibilities page appears. Customers can access
the site through these responsibilities.
5. Click Add Responsibility.
6. In the Search and Select Responsibility page, select any responsibility and click
Select.
The responsibility is added to the site and only users with this responsibility can
access the site.
7. In the Site Display Name field, enter a unique name.
The name should help to identify the site as a partner site.
8. In the Site ABC: Supported Responsibilities page, click the Assign Groups icon.
9. In the Update Site: Assign Groups page, select a group from the Unassigned Groups
section and click Move to move it to the Assigned Groups section.
10. Click Apply.

The Responsibility and site are assigned to the selected groups and partners can
view sites that they have access to, through the responsibilities that they have
received by enrolling into programs.

Creating Partners and Partner Users

Partners and partner users are created in Oracle Partner Management through the
self-registration process. A partner employee can register his organization as a partner
and register himself as a partner user. Subsequently, additional employees in the partner
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organization can register as partner users, or the organization’s partner administrator
can sign up other employees as partner users. An organization and its employees
register using a link provided during implementation.

Once a partner employee starts the registration process, he is guided through a

series of steps to submit company and user information. Once this information is
submitted, Oracle Partner Management generates a company and user account for the
organization. The partner user is given a user name and password, which, he selects
during registration and then receives a notification about. The partner employee
registered during the partner organization registration process is always registered as
a primary user. Default roles and responsibilities are granted to a partner user upon
the completion of the registration flow.

When a partner registers:

® A party record is created for the organization
e A party record is created for the contact

® A partner of relationship is created

* A contact of relationship is created

¢ Based on the Partner Management territory hierarchy, the channel manager is
identified and assigned to the partner. A channel team is assigned to the partner
based on the territory setup. The channel team is a set of channel manager(s), who
manage and work with the partner.

e For directly managed partners, channel managers are vendor employees.

e For indirectly managed partners, channel managers are employees or vendor
employees or both.

Each partner organization and partner user that registers is subject to the enrollment
approvals process. For additional information about approvals and enrollment, refer to
Setting up Partner Program Enrollments, page 91. 1]

Enabling User Types

The following user types must be enabled using the CRM HTML administrator
responsibility for registering partner organizations and partner users through user
registration.

e IBE_PARTNER_BUSINESS to register partner users of an existing partner
organization.

e IBE_PARTNER_PRIMARY to register a new partner and primary user of partner
organization.

Use this procedure to enable the user types.
Prerequisites
None.

Steps:

1. Login as the system administrator into the CRM Admin Console and navigate to
Users tab > Setup > User Types.

2. Enable the following user types, only if you have Oracle Partner Management
11.5.10 or a higher version is installed.
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e IBE _PARTNER_BUSINESS
e IBE _PARTNER_PRIMARY

For more information, see theOracle iStore Implementation Guide.

Partner User Responsibilities, Roles, and Permissions

Like employees of the vendor organization, partner employees are assigned
responsibilities, resource roles, and permissions-based roles.

Responsibilities

Resource Roles

There are two partner user responsibilities:

Default Partner User: This responsibility is used to display the Partner Dashboard
to the partner user after the partner organization has registered but before the
partner has enrolled in a program. Partners users with the Default Partner User
responsibility have a limited view of information on the Partner Dashboard. They
can see the Available Programs bin, but cannot see the Quick Links bin because

no menu is attached to the Default responsibility. The users cannot see the
Upgrade and Renewal bins, since the partner is not yet registered in a partner
program. Finally, since the partner does not yet have offered opportunities, the users
do not see the Offered Opportunities bin.

After a partner enrolls in a program, Oracle Partner Management removes the
Default Partner User responsibility and assigns partner users the responsibilities
that are associated with the partner program. Depending on the program and

the associated responsibilities, the partner’s users will be able to see additional
information on the Partner Dashboard. For more information on partner programs
and responsibilities, refer to Mapping Partner Responsibilities to Programs, page 89.

Partner Super User: This responsibility includes the superset of all

functionality offered to partners. Partners can either be regular partners or
distributors. Distributors are different from regular partners as they manage

some partners on behalf of the vendor. Menus tied with the Partner Super User
responsibility can be used as a reference to create menus for custom responsibilities.

For defining menus that can be used with the Quick Links bin, see Oracle iStore
Implementation Guide.

Oracle Partner Management provides two resource roles for partner users. A role is
assigned to a user during the self registration process or when the partner administrator
sets up a partner employee as a user:

Primary Business User: By default, this resource role is assigned to the partner
employee who first registers his organization. A user with this role has
administrative capabilities.

Default Business User: This role is assigned to partner users who are created
through self-registration or by a user with the Primary Business role. This role
should be assigned to all partner users who will do not need administrative
functionality, including users in distributor organizations who will be responsible
for managing their organizations’ partners.
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Permissions-Based Roles

Oracle Partner Management provides two permissions-based roles that are used for
partner users and are assigned to a user during the self registration process or when the
partner administrator sets up a partner employee as a user:

e PV_PARTNER_PRIMARY_USER: By default, this role is assigned to the partner
employee who first registers his organization as a partner. A user with this
role is referred to as the Primary User. The Primary User has administrative
capabilities, such as the ability to set up other employees as users and the ability
accept compensation for deal referrals.

e PV_PARTNER_BUSINESS_USER: This role is assigned to all users that are created
through self-service registration. A user with this role is referred to as a Business
User. A Primary User can give Business Users the Primary User role from the Profile
> Administration > Contact Management > Roles Ul page.

The following table lists permissions that are seeded with the Primary User
(PV_PARTNER_PRIMARY_USER) role:

Permissions of the PV_PARTNER_PRIMARY_USER Role

Permission Name Description
PV_PARTNER_USER Indicates that the user is a partner user.
PV_MY_CONTACT_PROFILE Provides access to the partner’s profile.

Navigate via the Profile icon > My Profile >
Personal Information > Profile tab.

PV_SALES Provides access to view sales preferences.
Navigate via the Profile icon > My Profile >
Preferences.

PV_PARTNER_UPDATE_PROFILE Provides access to update a partner’s

organization information. Navigate via the
Profile icon > Company Profile > Company
Information > Profile tab.

PV_PARTNER_VIEW_PROFILE Provides access to view a partner’s
organization information. Navigate via the
Profile icon > Company Profile > Company
Information > Profile tab.

PV_VIEW_MEMEBERSHIPS Provides access to view partner memberships.
Navigate via the Profile icon > Company
Profile > Memberships.

PV_CHANNEL_TEAM Provides access to view a partner’s channel
team. Navigate via the Profile icon > Company
Profile > Channel Team.

PV_CONTACT_PROFILE Provides access to view a contact’s profile
information. Navigate via Profile icon >
Administration > Contact Management >
Detail > View More Details button.

PV_OPPTY_CONTACT This is used to identify the partner contacts
during opportunity routing.
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Permission Name Description

PV_REF_COMP_APPROVER This is defined for partners who can accept
compensation. This permission enables
partners to view and accept compensation for
referrals.

PV_REFERRAL_SUPERUSER This a Super User permission defined for
referral management. It can be assigned
to vendors and partners. Vendors with
this permission can view and update all
referrals. Partners with this permission can
view, update, and accept compensation for
referrals for their organization.

PV_DEAL_SUPERUSER This is a Super User permission defined for
deal registration. It can be assigned to vendors
and partners. Vendors with this permission
can view and update all deals. Partners with
this permission can view and update all deals
for their organization.

The following table lists permissions that are seeded with the Business User
(PV_PARTNERBUSINESS_USER) role:

Permissions of the PV_PARTNER_BUSINESS_USER Role

Permission Description
PV_PARTNER_USER Indicates that the user is a partner user.
PV_MY_CONTACT_PROFILE Provides access to the partner’s profile.

Navigate via the Profile icon > My Profile >
Personal Information > Profile tab.

PV_VIEW_MEMEBERSHIPS Provides access to view partner memberships.
Navigate via the Profile icon > Company
Profile > Company Information > Profile tab.

PV_SALES Provides access to view sales preferences.
Navigate via the Profile icon > My Profile >
Preferences.

PV_PARTNER_VIEW_PROFILE Provides access to view a partner’s

organization information. Navigate via the
Profile icon > Company Profile > Company
Information > Profile tab.

PV_CHANNEL_TEAM Provides access to view a partner’s channel
team. Navigate via the Profile icon > Company
Profile > Channel Team.

Oracle iStore Permissions

In addition to Oracle Partner Management permissions, numerous iStore permissions are
included with partner user roles. The following table lists the Oracle iStore permissions
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for the for the PV_PARTNER_PRIMARY_USER and PV_PARTNER_BUSINESS_USER

roles.

Oracle iStore Permissions

Permission

Role

Description

IBE_INT_ASSIGN_ROLES

IBE_INT_PRIMARY_USER

IBE_INT_ORG_DETAILS

IBE_INT_USER_
MANAGEMENT

IBE_VIEW_NET_PRICE

IBE_INT_ORG_EMAIL _
ADDRESSES

IBE_INT_UPDATE_ORG_
DETAILS

IBE_INT_CONTACT_DETA
ILS

PV_PARTNER_PRIMARY _
USER

PV_PARTNER_PRIMARY _
USER

PV_PARTNER_PRIMARY _
USER

PV_PARTNER_PRIMARY_
USER

PV_PARTNER_PRIMARY_
USER

PV_PARTNER_BUSINESS _
USER

PV_PARTNER_PRIMARY_
USER

PV_PARTNER_BUSINESS_
USER

PV_PARTNER_PRIMARY_
USER

PV_PARTNER_PRIMARY_
USER

PV_PARTNER_BUSINESS_
USER
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Assigns roles in the User
Management screens.

Identifies a user as primary
user in the Administration
screens.

Provides permissions to view
organization details in the
Company Profile screens.

Provides access to User
Management screens.

Allows a user to see all prices
(that is, list prices, discount
prices and net prices), instead
of just Retail Price/Your Price
in the shopping cart and
Order Tracker pages. This
permission does not affect
the user’s ability to view
prices in the catalog.This
permission also controls the
pricing agreement, promotion
code, and commitment
functionalities in Oracle iStore.

For users without this
permission, it is recommended
that they also not have the
following permissions IBE_
CHECKOUT, IBE_CREATE_
ORDER, IBE_CREATE_
RETURN, or IBE_VIEW_
ORDER.

Allows to view company
contact information.

Permission to update
organization details in the
Company Profile screens.

This permission is currently
not supported. Although
they may appear in some
seeded user roles, they are
non-functional.



Permission

Role

Description

IBE_INT_ORG_ADDRESS_
BOOK

IBE_INT_ORG_TELEX_
NUMBERS

IBE_CHECKOUT

IBE_ASK_SALES_ASS
ISTANCE

IBE_INT_ADMINISTRATORS

IBE_INT_ROLE_
MANAGEMENT

IBE_INT_MANAGE_
CONTACT_INFO

IBE_INT_MANAGE_
CONTACT

IBE_INT_ASSIGN_
ACCOUNTS

PV_PARTNER_PRIMARY _
USER

PV_PARTNER_BUSINESS_
USER

PV_PARTNER_PRIMARY _
USER

PV_PARTNER_BUSINESS_
USER

PV_PARTNER_PRIMARY_
USER

PV_PARTNER_BUSINESS_
USER

PV_PARTNER_PRIMARY _
USER

PV_PARTNER_BUSINESS_
USER

PV_PARTNER_PRIMARY_
USER

PV_PARTNER_BUSINESS_
USER

PV_PARTNER_PRIMARY_
USER

PV_PARTNER_PRIMARY_
USER

PV_PARTNER_PRIMARY _
USER

PV_PARTNER_PRIMARY _
USER

Setting Up the Partner Dashboard

Permission to view company
address book in the Company
Profile screens.

Permission to view telex
numbers of the company in
the Company Profile screens.

Allows a user to see and
use the Checkout button in
shopping cart.

Allows a user to request sales
assistance in the checkout
phase, and to disagree with
terms and conditions. If a user
does not have this permission,
the "Need Salesrep Assistance’
button in the Order Review
page, and the ‘I disagree

- Need Assistance’ button is
not displayed.

Gives users permission to
view primary users of the
organization in the Company
Profile screens.

Gives users permission to
create and update roles in the
Role Management screens.

Gives users permission to
update, create, and delete
corporate addresses, e-mail
addresses, phone numbers,
and telex numbers in the
Company Profile screens.

Gives users permission to
update, create, and delete
corporate addresses, e-mail
addresses, phone numbers,
and telex numbers in the
Company Profile screens.

Gives users permission to
assign accounts in the User
Management screens.
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VAD Users

Permission Role Description

IBE_INT_PENDING_AP PV_PARTNER_PRIMARY_ Gives users permission

PROVAL USER to approve users of the
organization in the Pending
Approval screens.

IBE_CREATE_BILLTO_ PV_PARTNER_PRIMARY_ Allows the user to create a
CONTACT_ADDRESS USER new address associated with
the bill-to contact which will
g\éEI;{ARTNER—BUSINESS— have a bill-to relationship with
the bill-to contact.
IBE_CREATE_SHIPTO_ PV_PARTNER_PRIMARY_ Allows the user to create a
CONTACT_ADDRESS USER new address associated with
PV_PARTNER_BUSINESS_ the shlp—tg contact Whlch will
USER have a ship-to relationship

with the ship-to contact.

Value-added distributors might work with their own partner organizations. Partner
users that are members of a VAD have additional abilities. VAD users who manage their
organization’s partners can be assigned the Channel Manager role, which provides them
with visibility into partner information. In addition, the following permissions can be
assigned to VAD users to give them additional partner management capabilities:

e PV: View All Partners permission: Allows a user to view information about all
partners in his organization.

e PV: Update All Partners permission: Allows a user to view and update information
about all partners in his organization.

e PV:Invite New Partners permission: A user with this permission can invite an
organization to become a partner. The user sees the Invite New Partner button
on his Partners page.

Creating Partner Program Enrollment Pages

In the previous release, the enrollment flow provided a set of screens that could be
configured to allow the partner to enroll in a program.

¢ Customers could not easily format enrollment pages or brand enrollment pages
based on partner classifications.

¢ Customers could not easily add additional content to enrollment pages.

Oracle Partner Management leverages the template management framework to address
these usability concerns. The registration framework supports enrollments. The
enrollment pages are embedded in the registration flows. Users can now enroll into a
program from the partner dashboard provided by a common foundation component
called Template Management Framework.

* The top header renders <html>, <head> tags. Customers can add any thing that they
would like to see prior to menu rendering in this page.

e The Left 1, Left 2, Left 3, Left 4, Right 1, Right 2, Right 3, Right 4, Center 1, Center
2, Center 3 and Center 4 templates are part of the Layout template.
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e The layout template includes the content rendering part of the enrollment flow.
e The bottom header renders </html> tags.

Enrollment pages do not have the menu section hierarchy. So, the menu template
renders logo, global icons and a thin menu bar without any section hierarchy.

The following figure displays the enrollment flow template with top header, menu, and
bottom header locations.

Enrollment Flow Template

Enrcliment Flow Container Template

henu

Top Header

Layout Template

Left 1 Center 1 Right1
TLETEr 2 aF ]

Left 2 Program Detail Rigght 2

Template

TErter 3 or _

Left 3 Enrollmert Flow Rigiht 3

Page Template
Left 4 Center 4 Right 4

Bottom Header

Each page in the enrollment flow has different data that needs to be processed when
user clicks the Next button. Hence, each page in the enrollment flow has separate
container pages. To minimize the amount of work when a customer wants to customize
the layout, the same layout template is present across all the pages in the enrollment
flow. Any change in the layout template is reflected immediately in all the pages of the
enrollment flow.

The Enroll Now, Questionnaire, Questionnaire Summary, Contract, Payment
Address, Payment Information, Payment Confirmation and Thank you pages are
container templates.

The following figure illustrates the container templates mentioned above.
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Container Templates
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The following templates are used in partner registration flow. For information on how
these templates are used, see Oracle iStore Implementation Guide.

* Processing page for partner types during registration: Processing page template
to process user selected partner type and member type during self registration of
partner primary user.

¢ Displays partner types during registration: Template for displaying partner type and
member type during self registration of partner primary.

* Displays user preferences during registration: Template for displaying user
currency during self registration of partner primary user, business user, user
management, user creation and user update page in the partner dashboard profile.

Giving Partners Access to the Library

A vendor organization can give partner users access to the organization’s library from
the Partner Dashboard. To provide partners with access to the vendor organization’s
Library, a Library link must be added to the Quick Links bin on the Partner
Dashboard. Through personalization, a vendor can hide some of the sections of the
library that are inappropriate for vendors.

After you have added the Library link to the Partner Dashboard, log in as a partner user
and look at all the sections in the content details page. Depending on your organization’s
business requirements, you might determine that some sections should not be available
for partners.

These sections provide high-level information on using personalization. For additional
information, refer to the Oracle Application Personalization Framework guide.

Adding a Library Link to the Partner Dashboard Quick Links Bin

All menus that are available for partner users must be modified to enable Library
access. You must identify all the partner responsibilities for which you want to provide a
Library link, and then identify the Quick Links menu used by each responsibility. The
Quick Links menu should be the menu identified by the IBE: Quick Links Menu

profile option. For example, for the Partner Super User responsibility, this menu is
PV_PARTNER_SUPER_USR_MAIN_MENU.
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Prerequisites

The vendor organization must have set up sites for all partner responsibilities that
need access to the Library link.

Navigation
Log in to Oracle with the System Administrator responsibility.

Steps:

1. Navigate to Application > Function and create a new function called
PV_LAUNCH_LIBRARY.

2. Provide the following values for the new function.
¢ Type: JSP Interop

e HTML Call: pvxLaunch.jsp?OAFunc=IBC_LIBRARY_PG&OAHP=PV_
PARTNER_USR_HOME&OAPB=PV_PARTNER_USER_BRANDING

3. Navigate to Application > Menu.

4. Add the PV_LAUNCH_LIBRARY function to PV_PARTNER_SUPER_USR_MA
IN_MENU.

Make sure that you select the PV_PARTNER_SUPER_USR_MAIN_MENU. A menu
titled PV_PARTNER_SUPER_USER_MAIN_MENU might be available; this is a
different menu.

5. Add IBC_LIBRARYTAB_MENU submenu under PV_PARTNER_SUPER_USR_
ROOT_MENU.

6. Add the IBC_PRVEVIEW_PG function to PV_PARTNER_SUPER_USR_ROOT_
MENU.

Enabling Personalization for Partner Responsibilities

Use this procedure to enable personalization for partner responsibilities.
Prerequisites

None

Navigation

Log on to Oracle Forms with the System Administrator responsibility and navigate to
Profile > System.

Notes:

* Set the following profile options to Yes at the user level for each partner user
that has access to each of these partner sites that are associated with partner
responsibilities, which need to provide access to the library link:

e Personalize Self-Service Defn

¢ END: Personalization Region Link Enabled

Personalizing Library Information for Partner Responsibilities

Personalization is used to hide some of the information that appears in the Library. This
procedure provides instructions for hiding categories from partner users. Depending on
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business requirements, a vendor organization might have numerous Library categories
to hide or only a few.

The personalizations documented in this procedure must be performed for each partner
responsibility that is used in your implementation.

Prerequisites
None
Navigation

Log in to the Oracle HTML application as a partner user, and navigate to the

user’s Partner Dashboard. Then, navigate to Library > Content Library > Browse
categories, and select the any category that has some content items defined. Drill down
in any content name to look at content item details.

Steps:
1. Click the global Personalization link or icon that appears at the top of the page.

The Choose Personalization Context page appears.
2. Uncheck the Site Included check box.
3. Remove the organization name.

4. Make sure that the appropriate partner responsibility is selected in the responsibility
field.

5. Click Apply.

6. Locate the Header: <name of category> line, click the Update icon, and change the
Rendered value to False. Then click Apply to apply the changes.

Repeat this procedure to hide all the categories that should be unavailable to partner
users.

Disabling the Personalization Global Icon

It is not recommended that partner users have access to Personalization. In Enabling
Personalization for Partner Responsibilities you turned on personalization for each
partner responsibility so that selected categories could be disabled in the partner’s
version of the library. In this procedure, you turn off personalization for the same user.

Prerequisites
None
Navigation

Log on to Oracle Forms with the System Administrator responsibility and navigate to
Profile > System.

Notes

* Set the following profile options to No or Null at the user level for each partner
responsibility:

e Personalize Self-Service Defn

¢ FEND: Personalization Region Link Enabled
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Profile Options

There are certain system profile options that must be set for the Partner Dashboard to

function properly. Refer to Appendix A, “System Profile Options”, page [AH1 for a

complete list of profile options for the Partner Dashboard.

Setting Up the Partner Dashboard  6-21






v

Setting Up the Channel Manager Dashboard

This chapter covers the following topics:

e Overview |
e [Vendor User Dalta Visibility
Setting Up Graphs in the Channel Manager Dashboard

Workflow Business Events

Profile Options | |

Concurrent [Programs |

Overview

The Channel Manager Dashboard provides vendor users with an easy to

use, configurable user interface to help them with day to day responsibilities. It provides
them with a 360 degree view of their partners and activities, thereby enabling them to
make informed decisions.

The Channel Manager Dashboard provides vendor employees with a Key Metrics
bin, charts and graphs that display the sales performance of partners, a Quick Links
bin, and a partner search. Vendor employees can perform advanced partner searches
for partners based on profile attributes.

A vendor employee can access the dashboard if he has been assigned the Channel
Manager responsibility. The information available on a user’s dashboard is further
determined by channel team membership, resource role, and permissions. In this
chapter, we describe how a user’s roles and permissions affect what he sees on a
dashboard, and how the Sales Performance Graph is set up and populated. For
information on creating vendor users and assigning roles and permissions to them, refer
to Setting up Vendor Users, page 4Hl1. |

Vendor User Data Visibility

A vendor user’s resource role and permissions determine the partner data he sees
in three areas on the Channel Manager Dashboard: the Key Metrics bin, the Sales
Performance graphs, and the My Partners list.
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Key Metrics Bin and Sales Performance Graphs

The Key Metrics bin and the Sales Performance graphs provide statistical information
about the performance of partners whose data the user can view and update. A vendor
user gains access to partner data in two ways:

¢ Channel team membership: A vendor user who is a member of a partner’s
channel team can access information about a partner, and is said to “manage” the
partner. The Key Metrics bin and the Sales Performance graphs display statistics for
all the partners for which the user is a channel team member.

A vendor user is assigned to a channel team automatically according to the
organization’s Partner Management territory hierarchy. Refer to Setting up
Territories in Oracle Territory Manager, page 346 for informatioh on setting up the
Partner Management territory and using it to create channel teams. In addition, a
user can be added to a partner’s channel team manually by a user with the
appropriate permission. When a user is added to a partner team manually, an
option can be set that insures that the user will remain on the channel team even
if there is a territory reorganization.

* Resource group role: The role assigned to a user within a resource group can also
affect the information that appears in his Key Metrics bin and Sales Performance
graph:

* A user with the channel representative role sees information about partners for
which he is a member of the sales team.

* A user with the channel manager role sees information about a partner if he is a
member of the partner’s sales team. In addition, the channel manager also sees
information about all partners that the group’s channel representatives manage.

e If a group is a parent group, the channel manager can also see information
about partners managed by channel managers and channel representatives in
all the child groups as well.

Partner Search Results

The My Partners area of the Channel Manager Dashboard lists the results of a
partner search. A user’s resource role and permissions determine the partners that
are returned by a search and what actions a user can take upon those partners (for
example, view, update, invite).

¢ Channel Representative Role: A user with the Channel Representative role’s
partner search will return partners that he manages. The channel representative can
view and update information about these partners.

¢ Channel Manager Role: A user with the Channel Manager role’s search will
return both partners that he manages and partners that are managed by channel
representatives in his group. In addition, if the channel manager’s group is a parent
group, his search results will include partners managed by channel managers
and channel representatives in child groups. The channel manager can view and
update information about these partners.

e PV: View All Partners permission: If a user has this permission, his search results
can contain partners owned by any other channel manager or channel representative
in the organization, as well as his own partners. A user with this permission can
view and update information about partners that he manages directly; he can
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only view information about partners managed by other users. This permission
can be assigned to users with any role.

e PV: Update All Partners permission: If a user has this permission, his search results
can contain partners owned by any other channel manager or channel representative
in the organization, as well as his own partners. A user with this permission can
view and update information about all partners in the system. The user also sees
the Create as List button on his Partners page, which allows him to create a partner
list. This permission can be assigned to users with any role.

e PV:Invite New Partners permission: If a user has this permission, he is able to
invite an organization to become a partner. The user sees the Invite New Partner
button on his Partners page. This permission can be assigned to users with any role.

Statistical information about the partners that a user manages, either directly as a
channel team member or indirectly as a channel manager, appears in the user’s Key
Metrics bin and Sales Performance graph. Information about partners that the user does
not manage, but can access because of the PV: View All Partners or PV: Update All
Partners permissions, is not included in his statistical overview information.

The following table provides details about what information users with specific role and
permission assignments can see. Note that the table also provides information about
what Distributors can see. A Distributor is a partner user who also has functionality
similar to that of vendor users.

Roles and Permissions

User Type Manager in PV: Update PV: View All  PV: Invite Description

- Resource Resource All Partners Partners New
Role Group Partners
Hierarchy

Vendor Y N N N Can view and

Employee update all

- Channel partners that

Manager are managed
by the logged
in user and
as well as

partners that
are managed
by channel
managers

or channel
representatives
reporting to
the logged in
user.

Cannot invite
new partners
to join a
program.
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User Type Manager in PV: Update PV: View All  PV: Invite Description
- Resource Resource All Partners Partners New
Role Group Partners

Hierarchy

Vendor Y Y N/A N Can view and
Employee update any
- Channel partners in
Manager the system.

Cannot invite
new partners
to join a
program.

Vendor Y N Y N Can view any
Employee partners in
- Channel the system.

Manager Can update

only those
partners that
are managed
by the logged
in user and
partners that
are managed
by channel
managers

or channel
representatives
reporting to
the logged in
user.

Cannot invite
new partners
to join a
program.

Vendor Y N Y Y Can view and
Employee update all the
- Channel partners that
Manager are managed
by the logged
in user and
partners that
are managed
by channel
managers
or channel
representatives
reporting to
the logged in

user.

Can invite
new partners
to join to

a partner
program
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User Type
- Resource
Role

Manager in
Resource
Group
Hierarchy

PV: Update
All Partners

PV: View All
Partners

PV: Invite
New
Partners

Description

Vendor
Employee
- Channel
Manager

Vendor
Employee
- Channel
Manager

Vendor
Employee -
Channel Rep

Y

N/A

Can view and
update any
partners in
the system.

Can invite
new partners
to join a
program.

Can view any
partners in
the system.

Can update
only those
partners that
are managed
by the logged
in user and
as well as
the partners
that are
managed by
the channel
managers

or channel
representatives
reporting to
the logged in

user.

Can invite
new partners
to join to

a partner
program.

Can view
and update
only the
partners that
are managed
by the logged
in user.

Cannot invite
new partners
to join to
a partner
program.
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User Type
- Resource
Role

Manager in
Resource
Group
Hierarchy

All Partners

PV: View All
Partners

PV: Invite
New
Partners

Description

Vendor
Employee -
Channel Rep

Vendor
Employee -
Channel Rep

Vendor
Employee -
Channel Rep

Vendor
Employee -
Channel Rep

N
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N/A

N/A

Can view and
update any
partners in
the system.

Cannot invite
new partners
to join to
a partner
program.

Can view any
partners in
the system.

Can update
only those
partners that
are managed
by the logged

in user.

Cannot invite
new partners
to join a
program.

Can view and
update all the
partners that
are managed
by the logged

in user.

Can invite
new partners
to join to

a partner
program.

Can view and
update any
partners in
the system.
Can invite
new partners
to join to

a partner
program.



User Type
- Resource
Role

Manager in
Resource
Group
Hierarchy

PV: Update
All Partners

PV: View All
Partners

PV: Invite
New
Partners

Description

Vendor
Employee -
Channel Rep

Vendor
Employee

- Any other
role

N

N/A

Can view any
partners in
the system.

Can update
only those
partners that
are managed
by the logged
in user.

Can invite
new partners
to join a
program.

Can view
partners

that are
managed by
the channel
managers

or channel
representatives
that report to
the logged in
user.

The logged in
user cannot
update
partner
details.

The logged in
user cannot
invite new
partners

to join A
program.
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User Type
- Resource
Role

Manager in
Resource
Group
Hierarchy

PV: Update
All Partners

PV: View All
Partners

PV: Invite
New
Partners

Description

Distributor
- Channel
Manager

Distributor
- Channel
Manager

Distributor
- Channel Rep

Y N/A

Y N/A

N N/A
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N/A

N/A

N/A

Can view
only the
partners that
are managed
by the logged
in user and
as well as
the partners
that are
managed by
the channel
managers

or channel
representatives
reporting to
the logged in
user.

Cannot invite
new partners
to join a
program.

Can view
only the
partners that
are managed
by the logged
in user and
as well as
the partners
that are
managed by
the channel
managers

or channel
representatives
reporting to
the logged in
user.

Can invite
new partners
to join a
program.

Can view
only the
partners that
are managed
by the logged

in user.

Cannot invite
new partners
to join to
a partner
program



User Type Manager in PV: Update PV: View All  PV: Invite Description

- Resource Resource All Partners Partners New
Role Group Partners
Hierarchy

Distributor N N/A N/A Y Can view

- Channel Rep only the
partners that
are managed
by the logged
in user.
Can invite
new partners
to join a
program.

Distributor N/A N/A N/A N/A No access

- Any Other to partner

Role details.

Distributor N/A N/A N/A N/A No access

- Any Role to partner
details.

Setting Up Graphs in the Channel Manager Dashboard

For the graphs in the channel manager dashboard to be displayed correctly, the
Accounting Calendar must be set up and then the Refresh AS period days concurrent
program must be run.

Setting up the Accounting Calendar

The Accounting Calendar is set up from the Oracle General Ledger application. Unless
you are implementing Oracle Partner Management as a stand-alone application, the
Accounting Calendar has most likely been set up already.

The Accounting Calendar is set up in Oracle Forms by a user with the General Ledger
Super User responsibility.

Populating the Graph

The x-axis of the Sales Information graph is populated with data stored in the
as_period_days table. Running the Refresh AS period days concurrent program
populates this table with data form the General Ledger Accounting Calendar.

The graph’s y-axis is populated with Sales data.

Workflow Business Events

A business event is any event that might be of interest to customers or development
teams. For example, the creation of a partner might be a business event. The assignment
of opportunity to a partner might be another example of a business event.
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Workflow Event Subscriptions

Event Subscriptions to a business event typically perform any or all of the following
actions:

e Execution of custom pl/sql code
¢ Sending the business event to a predefined workflow process
* Asynchronous messaging using Oracle Advanced Queuing

Event subscriptions can be enabled or disabled using a user interface. You do not
have to change the code.

Oracle Partner Management provides features to assign indirect opportunities to
partners, invite partners to enroll into a program and tools to determine performance
of partners. Partner transactions like opportunity assignment, program enrollment
etc. requires the partner status to be active. To determine if a partner is active, the
following conditions need to be true:

* Relationship between partner and vendor status is active and relationship is not
end dated.

* Partner Organization status is active
e Vendor Organization status is active
* Resource record tied to the partner is active in CRM resource manager

Whenever the partner status changes (from active to inactive or vice-versa), an

Oracle Workflow business event is raised to indicate a change in the status of the
partner. Customers can subscribe to the partner status business event to take appropriate
action using the Define Business Event Subscriptions Ul available under the Workflow
Administrator Event Manager responsibility. The Workflow Business Event is seeded

in the Add Business Event/Event Group Ul available under Workflow Administrator
Event Manager responsibility as follows:

Column Name Value

Internal Name oracle.apps.pv.partner.Profile.updateStatus
Display Name oracle.apps.pv.partner.Profile.updateStatus
Description This event is raised every time the partner

status changes.

Status Enabled

Owner Name Oracle Partner Relationship Manager
Owner Tag PV

Customization Level Limit

Event Organization Update
Each time an organization-related partner qualifier (for example, Partner name, Annual
revenue, Number of employee, Customer category and so on) values change, a workflow
business event oracle.apps.ar.hz.Organization.update is raised to indicate that the
organization information is updated.
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The following table lists the subscription setup details for an organization.

Subscription Setup Details

Column Name Value
System SEED11.WORLD
Source Type Local

Event Filter
Source Agent
Phase

Status

Rule Data
Customization Level
Rule Function
Workflow Type
Workflow Process
Out Agent

To Agent

Priority
Parameters
Owner Name
Owner Tag

Description

oracle.apps.ar.hz.Organization.update

50

Enabled

Key

Limit
pv_tap_bes_pkg.organization_update_post

Normal

Partner Relationship Manager
PV

Create a changed partner record in PV_TAP_
BATCH_CHG_PARTNERS table, whenever
there is an updation in organization related
partner qualifiers, resulting in re-definition of
Channel team for that Partner Organization.

Event Partysite Update

Each time a party site related partner qualifier (for example, Identifying
address_flag, status and so on) value changes, a workflow business event
oracle.apps.ar.hz.PartySite.update is raised to indicate that the party site information

is updated.

The following table lists the subscription setup details for a party site.
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Subscription Setup Details

Column Name Value

System SEED11.WORLD

Source Type Local

Event Filter oracle.apps.ar.hz.PartySite.update

Source Agent -

Phase 50

Status Enabled

Rule Data Key

Customization Level Limit

Rule Function pv_tap_bes_pkg.partysite_update_post
Workflow Type -

Workflow Process -

Out Agent -

To Agent -

Priority Normal

Parameters -

Owner Name Partner Relationship Manager

Owner Tag PV

Description Create a changed partner record in the PV_TA

P_BATCH_CHG_PARTNERS table, whenever
there is a change in the organization party
site related partner qualifiers, resulting in
re-definition of Channel team for that Partner
Organization.

Event Location Update

Each time a location-related partner qualifier (e.g. City, County, Country, Postal
code, Province, State etc.) value changed, a workflow business event
oracle.apps.ar.hz.Location.update is raised to indicate that location information got
updated. A code attached to the Rule function of the subscription executes.

The following table lists the subscription setup details for a location.
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Event Contact

Subscription Setup Details

Column Name Value
System SEED11.WORLD
Source Type Local

Event Filter
Source Agent
Phase

Status

Rule Data
Customization Level
Rule Function
Workflow Type
Workflow Process
Out Agent

To Agent

Priority
Parameters
Owner Name
Owner Tag

Description

oracle.apps.ar.hz.Location.update

50

Enabled

Key

Limit
pv_tap_bes_pkg.location_update_post

Normal

Partner Relationship Manager
PV

Create a changed partner record in PV_TAP_
BATCH_CHG_PARTNERS table, whenever
there is an updation in organization location
related partner qualifiers, resulting in
re-definition of Channel team for that Partner
Organization.

Point Update

Each time a contact point related partner qualifier (for example, Area Code) change, a
workflow business event oracle.apps.ar.hz. ContactPoint.update is raised to indicate

that contact point information is updated.

The following table lists the subscription setup details for a contact point.
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Subscription Setup Details

Column Name Value

System SEED11.WORLD

Source Type Local

Event Filter oracle.apps.ar.hz.ContactPoint.update

Source Agent -

Phase 50

Status Enabled

Rule Data Key

Customization Level Limit

Rule Function pv_tap_bes_pkg. contactpoint update_post
Workflow Type -

Workflow Process -

Out Agent -

To Agent -

Priority Normal

Parameters -

Owner Name Partner Relationship Manager

Profile Options

There are certain system profile options that must be set for the Channel Manager
Dashboard to function properly. Refer to Appendix A,” System Profile Options”, page
IAHI for a complete list of profile options for the Channel Manager Dashboard.

Concurrent Programs

There are several concurrent programs that need to be run periodically for the Channel
Manager Dashboard. Refer to Appendix C, “Summary of Concurrent Programs”, page
1 for information about setting up and running the programs.
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8

Overview

Setting Up Partner Programs

This chapter covers the following topics:

e  Overview |

Setting Up Program Types |

Setting Up [Programs in Oradle [nventory [

Specifying the Liocation of Price Lists \

Setting Up Payment Options

Setting up Program Benefits

Setting Up Locking Rules

Setting Up Man{atory Rules

Setting up Program Contracts

Setting Up Partner Program Overviews

Mapping [Partner Respongibilities to Programs

TCA Events and Subscriptions
Profile Options | |

Lookups |

Concurrent [Programs \

Programs are used to segment partners and provide them with benefits. Vendors

can create programs for existing partners as well as new partners. Vendors can also
recruit and maintain partners with specific incentive packages. This helps increase and
maintain a strong partner community that further helps to increase overall market
share and revenues.

Vendors can also customize programs to recruit new partners and motivate existing
partners. Programs can be created for groups of partner types, for example, Value Added
Resellers (VARs), Original Equipment Manufacturers, and Prospects.

Vendors can organize and offer specific benefits to partners. Benefits such as sales
opportunities, product information, marketing collateral, services, and training can be
grouped within a program. Partners can gain access to the benefits by enrolling into
a program that provides these benefits.
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Examples of benefits that can be associated with a partner program include the following;:

® Referrals - A partner refers business to the vendor and receives compensation when
the referral is converted to an order.

* Deal Registrations - A partner registers a deal with the vendor for non-competition
purposes.

* Special Pricing Requests - A partner requests for discounts for newly purchased
inventory or to move existing inventory.

¢ Fund Requests - A partner can request for funds to carry out certain marketing
activities.

* Opportunity Management - A partner is eligible to receive opportunities from
the vendor.

Partner programs consist of numerous features, many of which are available through
integrations with other Oracle applications. During implementation, and as part of
on-going administration, a channel administrator is responsible for the following tasks:

* Setting up program types and specifying program approvers
¢ Adding programs to Oracle Inventory

* Specifying price lists to be used for programs

e Setting up payment methods

e Setting up program benefits, such as opportunity management, special pricing, or
deal referral and registration

* Making sure that program contracts have been set up in Oracle Contract
Management

e Setting up mandatory and locking rules

* Adjusting channel managers’ permissions in Oracle Content Management, which is
used to store partner program overview information

* Specifying the type of text editor to be used to create partner program overviews
* Mapping partner responsibilities to programs

Once the channel administrator’s partner program set up tasks are completed, channel
managers have all the tools they need to create and manage actual partner programs. For
information on creating and managing partner programs, refer to the Oracle Partner
Management Vendor Users Guide.

Setting Up Program Types

The channel administrator is responsible for specifying the program types that will be
available for program creation. A program type defines the type of partners that can
enroll in the program (for example, distributors, VADs, or resellers) and identifies
certain users as program approvers. The approvers will be responsible for approving
new programs created by channel managers. A program must be approved before
partners can enroll in it.

The Oracle Marketing Framework (AMS: Generic Approval Framework) is used to route
approval requests and notifications, and get approvals. For a user to be available as a
partner program approver, he must be set up as an approver in the Oracle Marketing
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approvals framework. For more information on the framework, see Oracle Marketing
Implementation Guide.

Use this procedure to set up a program type.
Navigation

Log on with the channel administrator responsibility and navigate to Programs >
Program Type, then click Create Type to access the Create Partner Program Type page.

Prerequisites
None.

Notes

* Partner Types: The partners available in this list are determined by the types of
partners specified in the Partner Type partner profile attribute. You can select
multiple partner types.

* Approvers: Specify one or more users who will be responsible for approving
programs. Note that the approvers specified here are responsible for approving
programs set up by channel managers. A different approval system is used to
approver partner program enrollment requests.

®  Order: If multiple approvers are required, set up an approval order.
e Type: Select User from the list, and then search for the user in the User Role field.

If the program creator and the approver are the same person, the program
is approved automatically.

Setting Up Programs in Oracle Inventory

Frequently, partners must pay a fee before they can join a partner program. If a fee is
associated with program enrollment, an order must be created for the program in
Oracle Marketing; for an order to be created, the partner program must be set up as
an inventory item in Oracle Inventory.

To set up partner programs in Oracle Inventory, the channel administrator must
complete the following:

* Specify the inventory organization in which programs will be stored.

e Set the PV: Concatenated Inventory Flex Segments for Program profile option to add
partner programs to Oracle Inventory.

e If the vendor organization is implementing Oracle Partner Management as a
standalone application, inventory categories and items might need to be set up as
well. Refer to the Oracle Inventory Users Guide for more information.

Setting the AMS ltem Validation Master Organization Profile Option

The AMS Item Validation Master Organization profile option is used to determine the
inventory organization in which partner programs will be stored as items. The profile
setting should be the name of the organization.

Setting the PV: Concatenated Inventory Flex Segment for Program Profile Option

Inventory items are added using a key flex field. Partner Management uses the
PV: Concatenated Inventory Flex Segments for Program profile option to populate
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the flexfield with information that creates a partner program inventory item. Oracle
Inventory uses one of the segments in the flexfield to uniquely identify each inventory
item; each Oracle application that sets up inventory items must populate this segment
with information that uniquely identifies its items. Other segments in the flexfield
are used to provide additional information about the item (such as company name

or business unit).

To set this profile option properly, you need to determine the following:

e What values must be specified in the segments that precede the segment that
uniquely identifies the inventory item.

e The style of segment delimiter.

When you set the profile option, you specify appropriate values for the preceding
segments and enter the code for the program. Then, you enter the value
PV_PRGRM_FLEX_CODE for the segment that will provide the information required to
set up the partner program as an Inventory item.

For example, suppose that the vendor organization’s Inventory key flexfield uses four

"o

segments to specify an inventory item, and uses "." as the delimiter:
¢ Segment 1: Company name = VENDOR

* Segment 2: Business unit = SOFTWARE

* Segment 3: Business subunit = EBUS

e Segment 4: Inventory item identifier

For this organization, the PV: Concatenated Inventory Flex Segment for Program profile
option would be populated as follows VENDOR.SOFTWARE.EBUS.PV_PRGRM_
FLEX_CODE, where the PR_PRGRM_FLEX_CODE concatenates the first five letters

of the partner program’s name with the program_id value, which is populated by the
database when the partner program is created.

For a program called Distributors Gold Program, the inventory flexfield would be
populated as follows:

VENDOR.SOFTWARE.EBUS.DISTRPV123, where “PV123” is the program_id assigned
by the database.

Specifying the Location of Price Lists

Partners might be charged to enroll into a partner program. Thus, partner programs
must be associated with price lists, which can be used to determine the appropriate
program price for each partner. When the channel manager creates a partner program, he
selected which price list or price lists will be used for the program. If multiple price
lists are used, the channel manager must define precedence so that the appropriate
price is selected.

Partner Programs can be priced using either the Oracle Advanced Pricing or the Oracle
Order Management application. The channel administrator specifies which application
is used by setting the profile option QP: Source System Code. This profile is set at the
Application level; when the profile is set, the value provided is the name of the pricing
application to be used.

For more information on setting up pricing, refer to Oracle Advanced Pricing User’s Guide
or the Oracle Marketing Implementation Guide.
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Setting Up Payment Options

A variety of payment methods can be set up to help partners pay program enrollment
fees conveniently. Payment methods can include cash, credit, check, or purchase order.

Payment methods are set up based on geographical regions, which allows the vendor
to set up different payment options for partners located in different countries or
regions, if necessary. The geographic regions used to specify payment options are

set up in Oracle Marketing. Geographic information may already be set up for your
implementation. However, if it is not, it can be set up by a user with Oracle Marketing
administration access. Refer to the Oracle Marketing Implementation and Administration
Guide for additional information.

Use this procedure to add a payment rule to specify available payment methods by
geographic regions from the Payment Option Details page.

Navigation

Log on as the channel administrator and navigate to Programs > Payment Methods, and
then click Add Payment Rule to access the Payment Option Details page

Prerequisites
None.

Notes

* Geography Level: Indicates the level at which the payment option applies, for
example, country or state.

* Geographic Region: Further defines the geographic information. The regions
options are determined by the Geography Level selected previously. For example, if
you select Country as the Geography Level, the Lookup for Geographic Region lists
all countries stored in the Oracle Marketing application.

e Select Payment Method: Payment method choices available are determined by the
union of two Lookups:

e PAYMENT TYPE: This is an Oracle Order Management Lookup, and provides
the methods Cash, Check, and Credit Card.

e PV_PAYMENT_TYPE: This is an Oracle Partner Management Lookup, and
provides the method Purchase Order.

Setting up Program Benefits

A benefit is a feature of a program that provides value to a partner, for example:
*  Access to funds for marketing or other promotional activities

¢ Ability to request special pricing

* Incentives for referring business to the vendor

*  Access to mailing lists or iStore

A benefit can be associated with one or more partner programs. Benefits are associated
with partner programs, and are granted to a partner organization through partner
program enrollment.

The channel administrator sets up benefits from the Benefit Administration page. When
setting up a benefit, the administrator selects the type of benefit to be created from
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the list of available benefits, which include deal registration, soft fund, referral, and
other. Numerous benefits of the same type can be set up; for example, the vendor might
want to offer different soft fund benefits to different types of partners.

Setting up a soft fund (also referred to as a partner fund), deal registration, or referral
benefit involves specifying additional steps, such as assigning a budget to the benefit or
associating products with it. Additional information about creating a deal registration
benefit, partner fund benefit, and referral benefit is presented in each benefit’s specific
chapter.

Opportunity management and special pricing functionality are also made available to
partners through benefit creation. To set up these types of benefits (as well as benefits
such as access to mailing lists or iStores), the channel manager creates a benefit of
type Other. Refer to the chapters on Special Pricing and Opportunity Management
for more information.

A benefit’s status must be Active before it can be available for use in a partner program.

Setting Up Locking Rules

A locking rule locks a partner program field to further editing. More specifically a locking
rule specifies that a field can not be edited when the partner program is in a certain
status. For example, you might want to lock some fields once a program becomes Active.

Navigation

Log in as the channel administrator and navigate to Programs > Locking Rules.
Prerequisites

None.

Notes

*  Object Attribute: Select the flow for which you are creating the locking rule. The list
of available fields is updated to reflect the fields contained in the flow selected.

e System Status: Select the program status that will cause selected fields to become
locked.

Setting Up Mandatory Rules

Mandatory rules allow you to specify fields that are required for program creation. You
can create mandatory rules for each feature or flow that you set up for a partner program.

Navigation

Log in as the channel administrator and navigate to Programs > Locking Rules.
Prerequisites

None.

Notes

* Object Attribute: Select the feature or flow for which you are creating the
mandatory rule. The list of available fields is updated to reflect the fields contained
in the object attribute selected.
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Setting up Program Contracts

A vendor can associate legal terms and conditions with membership in a partner
program. Terms and conditions are listed in a contract, which is presented to a partner
user who the program enrollment process. If the partner agrees to the terms, the partner
user then submits the signed contract to the vendor via fax or regular mail.

Oracle Partner Management integrates with the Oracle Contract Management, which
allows the vendor to create and manage contracts. A contract template can be attached to
a program based on geography, program type, and member type. Member type can be
used to present global partners with contracts that differ from contracts presented to
standard or subsidiary partners.

In Oracle Partner Management, the contract template is displayed and not the actual
contract. The channel manager selects the type of contract or contracts that he wants to
associate with a program and attaches it to a partner program. Once the partner clicks on
Accept/Print and Fax/Reject during the enrollment, a new contract is created.

Setting up program contracts involves two tasks:
e Setting up contract templates

* Setting up contract approval options

Setting up Contract Templates

For a contract to be available in Oracle Partner Management, the channel administrator
or a user with access to Oracle Contract Management must create contract templates
under the Partner Contracts category. Contract templates are created and stored in the
Oracle Contract Management Core application.

The legal terms that a vendor organization wants partners to agree to might differ based
on a partner’s geographic location or partner member type. Thus, numerous partner
program contract templates may need to be set up in Oracle Contract Management. The
channel manager then selects the contracts that he wants to associate with a specific
partner program based on geographic and partner member type criteria.

For more information on working with contracts, refer to the Oracle Contract Management
Implementation Guide.

Setting up the Contract Approval Option

Some vendor organizations delay approving partner program enrollment requests until
a signed contract is received from the partner. However, other organizations allow
approvers to approve an enrollment request before the signed contract is received.

To specify whether or not an enrollment request can be approved without a signed
contract, the channel administrator sets the profile option PV: Allow Approval without
Contract:

* Yes: Approver can approve the enrollment request before the signed contract
is received.

¢ No: The signed contract must be received before the enrollment request can be
approved. If this value is selected, the approver must indicate that the contract has
been received by making the appropriate selection on the Approval Checklist for
the partner program The system will check for this selection before allowing the
enrollment’s status to change to Approved.
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Setting Up Partner Program Overviews

When a vendor user creates programs, he can create a program overview that provides
partners with a summary of the program. The program overview is HTML content that
is displayed to partners to help them understand program requirements, benefits, and
so on. Channel managers set up the program overview, which can include images as
well as text.

The content for the program overview is stored in the Oracle Content Manager
application, although the text and images are entered by channel managers though
Oracle Partner Management. During implementation, the channel administrator
needs to perform two tasks to make sure that program overviews can be created and
stored properly:

* Adjust permissions in Oracle Content Manager so that channel managers can access
and store program overview information.

* Enable or disable rich text formatting for the overview, depending on business
requirements.

Although the Oracle Content Manager application provides a content approval
process, we are not using it in Oracle Partner Management. No separate approval is
required for a program overview.

Granting Vendor Users Oracle Content Management Access

Use this procedure to grant access privileges to vendor users (to create a JTA resource
group and include vendors in the group) to create, update or approve program summary.

Navigation

Log in to Oracle Content Management with the Content Super User responsibility.
Prerequisites

None

Steps:

1. From the Root directory level, select the PR_PRGM directory from the list of
subdirectories.

2. Click Folder Properties. The Folder Properties page appears.

3. In the Permissions section, click Add Another Row;, if necessary, and add the user
(for example, the name of a channel manager), resource group, or responsibility for
which you want to set up permissions.

4. Select the permission level:
e To grant full access to the folder, select all the available permissions.
e To restrict permissions, select the applicable permissions only.

For more information, see the Oracle Content Manager Implementation Guide.

Setting up the Program Overview Text Editor

A rich text editor can be used to create a program overview. The editor offers the ability
to add images and formatting to a program overview, which can cause accessibility
challenges for some users. The channel administrator can change the text editor used
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for the overview, if required, by changing the setting of the Self Service Accessibility
Features profile option.

The following settings are available for the profile option:

e NONE: Enables the rich text editor, and makes the accessibility-specific features
unavailable.

® Screen Reader Optimized: Content is optimized for reading on a computer screen.

e Standard Accessibility: Accessibility compliant mode.

Mapping Partner Responsibilities to Programs

Partner user responsibilities can be associated with partner programs. When a partner
organization’s enrollment in a program is approved, the responsibilities associated
with it are granted to the partner users. The channel administrator is responsible for
mapping programs and responsibilities.

Mapping responsibilities to programs provides a way to make the information associated
with a partner program visible to partner users from the Partner Dashboard. For
example, when a partner organization becomes enrolled in a program that provides
opportunity management benefit, the Opportunities bin becomes visible for the partner
organization’s users.

Responsibility mapping associates a responsibility with one of the two partner resource
roles: Primary User or Business User. To help vendor organizations further control the
information available to partner users, geographic location can also be used to determine
the responsibility that a partner user will receive. The geographic information available
for responsibility mapping is set up in the Oracle Marketing application.

Creating a New Responsibility
By default, each new partner user is assigned one of the following resource role and
responsibility combinations:
e Primary User role and Partner Super User responsibility

* Business User role and Default Partner User responsibility

Some organizations choose to simply map the Partner Super User responsibility to all
partner programs. Other organizations opt to create new responsibilities that allow
them to limit what partner users can see.

To create a new partner responsibility, it is recommended that you start with the
Partner Super User responsibility and exclude functions, as appropriate, to limit what
the user can see.

The channel administrator must perform the following to make the responsibility
available from the list of values that appears on the Create Responsibility Mapping
Setup page:

e Make sure that the responsibility’s application is set to Oracle Partner Relationship
Management.

*  Set the responsibility’s profile option PV: Is External Responsibility to Yes at the
responsibility level.

When the channel administrator adds, changes, or deletes a responsibility, the concurrent
program PV - Assign/Revoke user responsibilities runs automatically. This program
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updates partner responsibilities, assigning or revoking responsibilities to partner users
as appropriate.

Mapping Responsibilities

When setting up role and responsibility mapping, an organization can use geographic
criteria to further control the information that a partner user can access. The
application matches the partner’s identifying address to the most-granular geographic
level. Thus, more than one responsibility and role combination can be mapped to

a partner program, and the different responsibilities can be assigned to partner users
based on the geographic location of the partner.

Use this procedure to map responsibilities to partner programs.
Prerequisites

The responsibility must be set up as a Oracle Partner Relationship Management
responsibility with the profile option PV: Is External Responsibility set to
Yes. Additionally, the partner program must be set up.

Navigation

Log in as the channel administrator and navigate to Programs > Responsibility Mappings
and then click Create Mapping to display the Create Responsibility Mapping Setup page.

Notes

* Geography: Select the geographic criteria that will be associated with the
responsibility. The application will use the partner’s geographic information
(usually the identifying address) when assigning responsibilities.

You should make sure to set up the two default role and responsibility combinations
at the highest level in the geographic hierarchy (for example, the World

level). This ensures that all partner users will automatically be assigned a role and
responsibility, even if their organizations are not yet enrolled in a partner program.

* Location: Select the location from the list. The location choices available in the list
are determined by the Geography criteria selected previously.

TCA Events and Subscriptions

Relationships

There are a number of TCA events and subscriptions associated with partner programs.

In TCA, for global and subsidiary relationships, the relationship name used is
PARTNER_HIERARCHY. To keep the member type up-to-date, the following TCA event
subscriptions are registered for CREATE /UPDATE of the relationship status.

e oracle.apps.ar.hz.relationship.update

e oracle.apps.ar.hz.relationship.create

Change in Partner Address

If the address of a partner changes, a TCA event subscription is registered to update
the partner user responsibilities.

e oracle.apps.arhz.location.update
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The above subscription is seeded out of the box.

To set up the update process, run the concurrent program Workflow Agent Listener with
the parameter WF_DEFERRED. Set this up to run every hour. This concurrent program
is seeded in the request group of the responsibility System administrator. When this
concurrent program is executed, every subscription from every instance of events

in the DEFERRED queue at that moment is executed. The Workflow Agent Listener
concurrent program is shipped as DISABLED.

Partner Invitations

Workflow sends out invitations to all the primary users of the partner organization. The
workflow item type for this is PV: Partner Program Notifications and the workflow
process used in the above item type is EVENT_NOTIF_PROCESS. This item type can be
customized as needed.

Profile Options

Lookups

There are certain system profile options that must be set for Partner Programs to function
properly. In addition to the profile options mentioned in this chapter, there are additional
profile options that may need to be set. Refer to Appendix A, “System Profile Option”,
page|AHL for a completé/list of profile options for Partner Programs.

There are several Lookups that need to be set up for Partner Programs. Refer to
Appendix B, “Lookups”, page Bl for additional information.

Concurrent Programs

There are several concurrent programs that need to be run periodically for Partner

Programs. Refer to Appendix C, “Summary of Concurrent Programs", page CH1 for

information about setting up and running the programs.
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Setting Up Partner Program Enrollments

Overview

This chapter covers the following topics:

e  Overview \
Creating a [Partrler [Program Enrollment Site
Setting Up Address Validation

Setting Up Oracle Order Management

Setting Up Oracle iPayment Server |

Setting Credit Card [Profile Options

Setting Up Runtime Variables

Setting Up Tax Rules

Setting Up Enrollment Request Approvers

Users and Security

Oracle Partner Management enables a partner to be part of a vendor’s indirect sales
force by enrolling into programs designed by the vendor. Programs provide a basis for
vendors to effectively segment and manage partner interactions. Vendors can group
programs to target certain partner segments.

After an organization has registered with the vendor as a partner, programs that the
partner is eligible for appear in the Available Programs bin on the Partner Dashboard. A
partner user can enroll her organization into a program listed in the bin. The enrollment
request is then routed to an approver, who is a vendor user. If the partner’s enrollment is
approved, the partner receives the benefits associated with program membership, for
example, the ability to submit special pricing requests or to request funding for
marketing activities. Partner who are distributors can in turn invite their partners to
join partner programs.

When a partner user initiates the program enrollment process, she is prompted through
a series of enrollment-related web pages. Depending on the partner program, the
enrollment process can involve some or all of the following:

* A program overview page, which describes the program benefits and requirements
and other information provided by the program creator.

* An enrollment questionnaire, which presents a series of questions that the partner
must answer.
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e A terms and conditions page, which the partner must agree to.

e If a fee is associated with program membership, the partner user will be asked to
submit billing and payment information.

All the program enrollment-related items listed above were set up by either the channel
administrator or channel manager as part of the partner program creation process. For
more information on creating partner programs, refer to Setting up Partner Programs,
page [841. There are additional set ups that the channel administrator or another vendor
employee must complete to enable program enrollment; these are presented in this
chapter.

Creating a Partner Program Enrollment Site

During enrollment, a partner user is prompted through the enrollment process on a
series of web pages that can be thought of as an enrollment site. The enrollment site
is set up from Oracle iStore; templates are provided that the vendor can use to create
a customized enrollment process. For more information on using the template and
creating the site, refer to Setting up the Partner Dashboard, page 61. 1]

Setting Up Address Validation

The receivables address validation system option needs to be set up, because address
validation is required for payment. A partner’s billing address is validated against tax
locations that are set up in Oracle Receivables.

For more information on how to set up the address validation system option, see the
Oracle Receivables User Guide.

Setting Up Oracle Order Management

Oracle Order Management is used to process sales orders when a partner submits an
enrollment request for a program that contains fees. It is used to process financial
liabilities. Oracle Order Management is also used to process orders for different payment
modes such as cash, check, credit card and purchase order.

For partner program enrollments, three profile options must be set up to integrate Oracle
Partner Management with Oracle Order Management:

e PV: Default Sales person used for Orders: Oracle Order Management requires that
a salesperson be identified for each order. Depending on business requirements, the
salesperson can receive a commission for partner program enrollments; however, if
the vendor chooses not to associate a salesperson with program enrollments, a
fictional name can be used instead.

The setting for this profile option must be a CRM resource (a fictional resource can
be created, if necessary). The profile should be set at the Site level.

e PV: Order Cancel Reason: Use this profile option to provide a reason for the
cancellation of an enrollment request. This reason will be used when an enrollment
request is cancelled because:

e The partner chose to cancel the enrollment request
¢ The maximum number of credit card authorization requests was exceeded

* An approver rejected the enrollment request
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The setting for this profile option is taken from the Order Management
CANCEL_CODE Lookup. The profile is set at the Site level.

e PV: Order Transaction Type: A partner program is not a shippable item, which must
be specified on the order form. Set this profile option to BILL ONLY to indicate that
the program is not shippable. The profile is set at the Site level.

For more information on these profile options and on setting up Oracle Order
Management, refer to the Oracle Order Management Suite Implementation Guide and Oracle
Order Management User Guide.

Setting Up Oracle iPayment Server

Credit card payments are handled by the Oracle iPayment application. An iPayment
user with the Payment Administrator responsibility sets up and maintains the iPayment
application and server. For information on setting up and maintaining the iPayment
Server, refer to the Oracle iPayment Implementation Guide.

Depending on business requirements, an organization might choose to use secure

http (https) for enrollment requests, especially for requests that are paid with a credit
card. However, https can have a performance impact on a site, so the organization might
want to limit https to the payment portion of the enrollment request. For Oracle Partner
Management, you can specify whether or not to user https through two profile options:

e PV:Secure URL: Use to specify a secure server and port for payment pages.
e PV: Non Secure URL: User to specify a nonsecure server and port for other pages.

These two profile options are optional, and are both set up at the Site level. For more
information providing settings for the options, refer to Appendix A, “System Profile
Options", page [AHL. []

Setting Credit Card Profile Options

The vendor can choose to limit the number of authorization attempts allows for a single
credit card transaction. If a limit is placed on authorization attempts, and the number of
allowable attempts has been exceeded, the enrollment request will be ended, and the
user will be returned to the Partner Dashboard. However, the enrollment registration
information is saved, including the contract information. In addition, Oracle Order
Management saves the billing information.

The number of allowed authorization attempts is specified using the profile option
PV: Max number of credit card authorization. This profile is set at the Site level, and
the setting is a numeric value.

Setting Up Runtime Variables

The jtt_cookie_path and jtt_cookie_domain java runtime variables need to be set up
properly for transferring user cookie from https server to http server and vice versa. This
is so that users need not explicitly enter user name and password again when switching
from https to http and vice versa. This setup is needed only if payment pages need to
be secure and rest of the pages need to be non secure.

For information on how to use the java run time variables, see JTT documentation.
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Setting Up Tax Rules

Tax rules need to be set up for calculating tax for membership fee.

For information on how rules should be set up, see the Oracle Receivables Tax Guide.

Setting Up Enroliment Request Approvers

Partner program enrollment requests are subject to an approval process. When a
partner user submits an enrollment request, it is routed to an approver, who is a vendor
user. The approver can approver, reassign, or reject the request. The partner program
enrollment approvals process is set up and managed through the Oracle Approvals
Management application.

The seeded transaction for enrollment requests is PV: Partner Program Enrollment
Requests. Numerous attributes have been defined for this transaction. A default
program enrollment request approver can be identified using the PV: Default Enrollment
Request Approver profile option. For more information on setting up approvals for
program enrollment requests, refer to Creating Approval Rules in Oracle Approvals
Manager, page 32 . [

Users and Security

The channel administrator can designate one or more vendor users as partner program
enrollment administrators. Administrators can see all enrollment requests in the
system, whereas other users can only see the enrollment requests for which they are
approvers, or the enrollment requests submitted by partners to which they have access.

A partner program enrollment request administrator is designated by giving a Oracle
Partner Management vendor user the resource role Vendor Administrator. The user can
have other Oracle Partner Management vendor user roles as well.
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Overview

Setting Up Opportunity Assignment

This chapter covers the following topics:

e  Overview |

e [Opportunity Matching and Routing
Setting Up [Partner Matching Rules
Setting Up Manjial Matching Options

Setting Up Timeouts
Setting Up Channel Types

Specifying Status Notification Recipients

Modifying Status Notifications

Opportunity Events

Users and Security
Profile Options | |

Concurrent [Programs \

A sales opportunity is a pending sale that can be forecasted. Oracle Partner Management
extends the Oracle Sales opportunity module to support the assignment of indirect
opportunities to partners. An opportunity can originate from a lead or a marketing
campaign, or it can be entered manually by a user.

Oracle Partner Management allows a vendor organization to set up rules that simplify
the process of identifying the best partner or partners for an opportunity and
subsequently routing the opportunity to the appropriate partner. Partner Management
Opportunity Management module provides a flexible mechanism to control the
distribution of notifications associated with opportunities.

Oracle Partner Management integrates with two Oracle sales applications: Oracle Sales
Online (which is also called Oracle Field Sales) and Oracle Sales. If your organization
is integrated with Oracle Sales, additional implementation steps may be required for

proper integration of the applications. Refer to Oracle Sales Integration, page [L6H1

for more information.
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Opportunity Matching and Routing

Opportunity matching refers to the process of identifying a partner to whom an
opportunity should be offered. Opportunity Management allows the vendor to
create rules that identify the best partner for an opportunity based on opportunity
criteria, partner criteria, and geographical criteria. An opportunity matching rule can
also specify tiebreak criteria.

Opportunity routing refers to the process of offering an opportunity to one or more
partners. Routing can be done manually by a vendor user, or automatically. Automatic
routing can be set up as part of a matching rule.

Refer to Setting up Partner Matching Rules, page 1044 for instructions on creating
matching rules.

Automated Matching and Routing Methods

Semi-automatic

Fully-automatic

Opportunity matching and routing can be partially or completely automated. There are
three levels of automated matching and routing:

e Semi-automatic
¢ Fully-automatic

e Automatic Background

With semi-automatic matching, a user selects which matching rule will be used to
generate a list of partners. The user is responsible for completing the routing manually.

Semi-automatic matching requires that the channel administrator set up at least one
matching rule. The profile option PV: Matching Rule Selected by Engine must be set
to No (No is the default value). In addition, the profile option PV: Rule for Automatic
Matching must be set to specify which rule will be used for matching.

With fully-automatic matching, a user initiates the matching process but the Rules Engine
selects the best matching rule based on the opportunity’s attributes, and then generates a
list of partners. The user is then responsible for completing the routing manually.

To implement fully-automatic matching, the channel manager creates matching rules
and sets the PV: Matching Rule Selected By Engine profile option to Yes.

Automatic background

With automatic background matching, no user intervention occurs. Automatic
background matching is used for opportunities that resulted from the lead to
opportunity conversion process.

In automatic background matching, a workflow background process, either initiated
by a user or scheduled to run at regular intervals, queries all opportunities in the
indirect channel, determines the best partner(s) for each opportunity, and routes the
opportunities based on the routing rules.

To implement automatic background matching, the channel manager creates matching
rules that contain partner routing criteria (routing criteria is optional for other types of
matching). Two profile options must be set up:
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e PV: Partner Matching Type. Determines how the matching engine will evaluate
opportunities against opportunity selection criteria. This optional profile has two
settings:

¢ Exhaust all rules. The matching engine evaluates each rule (that matches
the conditions specified in the Opportunity Selection criteria), by order of
precedence, until it finds a rule that identifies a partner.

If a preferred partner was specified by the rule, the evaluation stops at the first
rule even if it does not return a partner.

* Stop at first rule. The matching engine uses the first rule that it finds that
matches the opportunity based on the Opportunity Selection criteria. The engine
stops even if a partner is not identified.

e PV: Default Batch Assignment User. Identifies a user who has access to an
opportunity that failed to complete the lead to opportunity routing process. The user
becomes a member of the failed opportunity’s sales team.

Routing Types

Routing refers to the process of distributing an opportunity to one or more partners that
have been identified as appropriate matches. Oracle Partner Management supports
several routing types:

* Single: An opportunity is routed to one partner only. If multiple partners have been
identified as a potential matches, the “winner” is selected randomly.

e Serial or Single-Serial: When the matching rules identify more than one partner for
an opportunity, the opportunity is offered to one partner at a time from the list. If
the highest ranking partner declines it, the opportunity is offered to the second
ranking partner and so on until a partner accepts it. Once a partner accepts the
opportunity, partners further down in ranking do not see the opportunity.

e  Multiple-Parallel or First Come First Serve: You can also route the opportunity to
multiple partners simultaneously. The first partner to accept the opportunity wins
it, and the other partners are removed from the opportunity. If you want to do
multiple matching, you need to select at least two partners from the partner list.

e Multiple Joint or Joint: This option supports collaborative selling. The opportunity
is offered to multiple partners for fulfillment, and multiple partners can accept and
work jointly to win and fulfill the opportunity.

Manual Matching

Manual matching allows a vendor user to identify a partner match for an opportunity
independently of established matching rules. To perform a manual match, the

user selects criteria that will be used to search for potential partner matches for an
opportunity. The partner criteria available are partner profile attributes that have been
enabled for opportunities and matching services.

The criteria available for manual partner matching can be limited by responsibility. For
example, an organization might want channel managers to be able to identify partner
matches using all available partner criteria, but might want only a subset of the criteria
to be available to channel representatives for matching.

For information on setting up manual matching, refer to Setting up Manual Matching
Options, page [10-8. | ]
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Setting Up Partner Matching Rules

Matching rules make it easy for a vendor organization to offer opportunities to the most
appropriate partners. A matching rule evaluates specific opportunity criteria, evaluates
it against specific partner criteria, and then determines which partner or partners, out
of all available partners, is a best fit for the opportunity.

Channel administrators are responsible for creating matching rules. The rule
creation process involves specifying various criteria, and is spread across multiple
pages. Creating a matching rule involves the following procedures:

¢ Creating a new rule

¢ Adding opportunity selection criteria to the matching rule
* Adding partner selection criteria to the matching rule

* Adding partner matching criteria to the matching rule

e Adding geographic proximity to the matching rule

e Adding tiebreak criteria to the matching rule

¢ Adding routing information to the matching rule

Creating a New Rule
The first step in rule creation is naming the rule and providing basic information about it.

Navigation

Log on with the channel administrator responsibility, and navigate to Opportunity
Routing > Partner Matching Rules, and click Create

Prerequisites
None.

Notes
* Currency: Identifies the currency used for each currency condition that is added
to the rule.

e Precedence: A higher-numbered precedence rule is evaluated before
lower-numbered precedence rules when the partner matching engine is trying to
identify the most appropriate rule to apply for each opportunity.

e Owner: By default, the owner is the person creating the rule. A different owner
can be selected, if necessary.

* Create: Click to move to the next step.

Adding Opportunity Selection Criteria to the Partner Matching Rule

Opportunity selection criteria is used by the matching engine to determine if a rule
applies to an opportunity. Opportunity selection criteria are opportunity profile
attributes, such as Customer Country or Total Purchase Amount. You select one or
more attributes and then further define conditions for the attribute, such as “equal to,”
“between,” or “greater than.”

Prerequisites

Partner profile attributes must be set up and a partner matching rule must exist.
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Steps:

1.

At the Partner Matching Rules page, click the name of the rule you created in the
previous procedure.

The Edit Matching Rule page appears, displaying links for additional rule creation
steps at the top of the page.

Click Opportunity Selection.

In the Opportunity Selection page, click Add Attributes.
The Add Opportunity Selection Attributes page appears.
On the Attribute Page complete the following;:

1. Select the attribute category, if you know it, from the first drop-down list, or
select the blank option to display all attributes. Attributes that belong to the
selected category are displayed.

2. Select the attribute from the second drop-down list. Appropriate conditions and
values for the attribute are displayed. The conditions field displays different
values depending on the attribute selected.

3. Select conditions and values for the attribute.

4. Click Apply to add this attribute or click Apply and Add Another to add this
Attribute and display a new Attribute page.

Adding Partner Selection Criteria to the Partner Matching Rule

The conditions specified in the partner selection section defines a group of partners that
are eligible to receive the opportunity. Partners selection criteria are partner profile
attributes that have been selected for opportunities and enabled for Matching Services.

Use this procedure to add partner selection criteria to the rule. You can select attributes
and assign a condition and a value to the attribute.

Prerequisites

Partner profile attributes must be set up and a partner matching rule must exist.

Steps:
1. Click the Partner Selection link.
2. On the Partner Selection page, click Add Attribute.
The Add Partner Selection Attributes page appears.
3. On the Add Partner Selection Attributes page, complete the following:

1. The first drop-down lists the attribute categories. Select the category if you know
it or select the blank option to display all attributes. Attributes that belong to
the selected category are displayed.

2. Select the attribute from the second drop-down list. Appropriate conditions and
values for the attribute are displayed. The conditions field displays different
values depending on the attribute selected.

3. Select conditions and values for the attribute.

4. Click Apply to add this attribute or click Apply and Add Another to add this
Attribute and display a new Attribute page.
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Adding Partner Matching Criteria to the Partner Matching Rule

Partner matching criteria helps vendors refine the partner search. In this step, attributes
selected for the opportunity are compared to attributes selected for the partner to
determine a best partner match for the opportunity. For example, the vendor can decide
that the customer address must be in the same state as the partner address, or the
customer industry needs to match the partner’s target industry.

Use this procedure to add matching criteria to the rule. In this step, you relate attributes
selected for the opportunity to attributes selected for the partner.

Prerequisites

Attributes for both the opportunity and the partner must be defined and a partner
matching rule must exist.

Steps:
1. Click Matching Criteria.

The Matching Criteria page appears.

2. Select an attribute from the drop-down list in the Opportunity Attribute column. The
window refreshes as the Matching drop-down list is populated.

3. Select an operator from the Matching Condition drop-down list. The values in
the Matching Conditions drop-down list are determined by the attribute selected
in the Opportunity Attribute.

4. Select a related attribute from the Partner Attribute column. Attributes displayed in
the drop-down list of Partner Attributes are attributes that have the same return type
as the attribute selected in the Opportunity Attribute column.

Adding Geographic Proximity to the Partner Matching Rule

Geo-proximity criteria can be specified in a rule to match an opportunity to the partner
who is closest to the customer, or to limit the pool of potential partner recipients to
those that are within a specified distance.

Use this procedure to assign a geographical region to the rule.
Prerequisites
Attributes must be set up and a partner matching rule must exist.

Steps:
1. Click Geo-Proximity.

The Geographic Proximity page appears.
2. Enter a distance value in the Select Partner Within field.
3. Select a distance denomination of either miles or kilometers.

4. In the Select Nearest field, enter the maximum number of partners that should be
returned. For example, enter 10 to indicate that you want to limit the matches to
the closest 10 partners.

Adding Tiebreak Criteria to the Partner Matching Rule

Tiebreak criteria must be added to a rule if you want the rule to identify a single winner
or to produce an ordered list of winners. Tie break criteria uses partner attributes to
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determine the best partner when more than one partner is equally qualified according
to the other matching criteria.

Because the attributes used for tie breaking must provide a way to measure a partner’s
performance, the attributes that can be used are limited to those with a numeric or date
display style. When an attribute with a numeric display style is set up, a value type of
minimum or maximum can be specified. A value type of maximum indicates that, when
the attribute is used in tie breaking, the partner with the maximum value will win. A
value type of minimum indicates the opposite.

When setting up tie break criteria, the channel administrator assigns a rank to each
attribute. The rank indicates the importance of the attribute in the tie breaking
process. The matching engine evaluates the attribute with the lowest rank first; if a
winner can be determined using this attribute, the matching is complete. If no winner
emerges using the first attribute, the next-lowest ranked attribute is used to identify

a winner, and so on, until a winner emerges. If no winner emerges, the engine selects
a partner by random.

Use this procedure to assign tiebreak criteria to the rule.
Prerequisites
Attributes must be set up and a partner matching rule must exist.

Steps:
1. Click Tiebreak.

The Tiebreaker page appears.

2. Select an Attribute from the drop-down list and enter a rank for the attribute.

Adding Routing Information to the Partner Matching Rule

Routing rules are used if matching and routing of opportunities to partners will be
performed in the automatic background mode, with no user intervention.

Use this procedure to assign routing information to the rule.
Prerequisites
Attributes must be set up and a partner matching rule must exist.

Steps:
1. Click Routing.

The Matching Routing page appears.
2. Select the Routing Type from the drop-down list.

3. Select the Bypass Channel Manager Approval check box to skip channel manager
approval for this rule.

4. Enter the Channel Manager Time-Out in days or hours.

Channel Manager Time-Out specifies the number of days or hours that the channel
manager has to review and approve or deny the routing (if channel manager
approval is not disabled). If the channel manager does not respond in the specified
time, the opportunity is routed automatically.

5. Enter the Partner Time-Out in days or hours.
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Partner Time-Out specifies the number of days or hours that the partner has to
accept or reject the opportunity. If the partner fails to respond in the specified time
period, the opportunity is withdrawn automatically.

Note: The time-out periods specified for a matching rule are
independent of the other timeout periods that can be specified for
opportunities. When routing occurs automatically as a result of
automatic background matching, the timeout periods specified by the
rules are used; other timeout periods are ignored. Refer to Setting up
Timeouts, page 108 for additional information.

Setting Up Manual Matching Options

For manual matching of partners, all active partner attributes that are enabled for
matching are exposed by default on the manual search screen. The channel administrator
can restrict this list by identifying partner attributes to be exposed at a responsibility
level.

Use this procedure to set up manual matching options at the responsibility level.

Navigation

Navigate to Opportunity Routing > Manual Matching Setup.

Prerequisites

None.

Notes

Responsibility: Select the responsibility from the drop-down list. Separate manual
matching rules can be set up for each responsibility that appears in the list.

Rank: The rank determines the order in which the partner attributes are displayed
on the manual search screen that the user sees. If the profile PV: Enable Partial
Matching of Attributes is Yes, and partners are not found for the current search
conditions, the lowest ranked condition is dropped and the search is performed
again. This process continues until at least one partner is found or all the search
conditions are exhausted.

Setting Up Timeouts

Timeouts are time periods during which an action is expected to take place. There
are two timeout types:

Channel Manager Timeout: Limits the time period a channel manager can hold a
matched opportunity before it is forwarded to the assigned partner. If the channel
manager does not process the opportunity, the routing status is automatically
changed to Offered and the opportunity is routed to the partner.

Partner Timeout: Limits the time period during which a partner can respond to an
offered opportunity before it is recycled and offered to another partner.

There are three ways that timeout periods can be specified:

By a routing rule. Timeout periods specified as part of a routing rule apply to
opportunities that are routed by automatic background matching only.

For individual countries. From the Timeout Setup page, the channel administrator
can assign timeout periods for individual countries. For Channel Manager
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Timouts, the country corresponds with the country of the customer associated with
the opportunity. For Partner timeouts, the country corresponds to the partner’s
country. In situations where multiple partners in different countries are offered the
same opportunity, the longest timeout period is assigned to all partners, regardless
of their country. These timeout periods apply to opportunities offered through
semi-automatic and fully-automatic matching and manual matching. Specifying
country-specific timeout periods is optional.

e Through profile options. Two profile options, PV: Default CM TimeOut and
PV: Default Partner TimeOut, control timeout periods. If timeouts are not set up at
the country level, these profile options are used to specify channel manager and
partner timeout periods. The default timeout periods apply to opportunities offered
through semi-automatic and fully-automatic matching and manual matching.

Setting up Country-Specific Timeout Periods

This procedure sets up timeout periods at the country level. Timeouts set at the country
level have precedence over default timeouts that are specified through profile options.

To set up country specific timeouts, navigate to Opportunity Routing > Timeout Setup
and follow the on-screen instructions.

Setting Up Channel Types

A vendor organization can create channel types that reflect its business processes. In
addition, Oracle Partner Management seeds several channel types.

Channel types are used by the lead engine and partner matching engine to identify
which opportunities are indirect and should be assigned to partners. Each channel must
be defined as either a direct or an indirect channel

Navigation

Navigate to Opportunity Routing > Channel Setup.
Prerequisites

None.

Notes

e Precedence: Precedence is used to determine the winner if there is a tie between
channels for an opportunity.

Specifying Status Notification Recipients

Oracle Partner Management provides a built-in workflow system that triggers automatic
e-mail notifications to certain groups of people (as determined by role) at different stages
in the opportunity and routing processes. Notifications are sent out to the following
users whenever the status changes:

The user types are:
¢ Channel manager
* Assignment Manager - User that initiates the opportunity routing to partner.

e Partner - Partner contacts on the opportunity sales team.
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e Other - Internal sales representatives that are neither channel managers nor
assignment managers.

Note: The system checks for the appropriate e-mail address in

User Registration (under administration). This is a mandatory
requirement for the status notification to work. In addition, while
creating users, please ensure that appropriate roles are defined. This
means that at least one partner contact should have the
permission: OPPTY_CONTACT. This permission is assigned by
default to the user who registers the partner organization.

From the Status Notification page, the channel manager can add and remove user
types from the list of recipients. To access the Status Notification page, navigate to
Opportunity Routing > Status Notifications.

Modifying Status Notifications

The status notification messages that are sent to recipients in response to changes in
opportunity and routing status are created and stored in Oracle Workflow Builder. You
might be able to implement the notifications that have been seeded for Opportunity
Management without modification. However, if you need to make changes to the seeded
notifications, you will need access to Oracle Workflow Builder version 2.6.2 and the
Oracle 9i database. You can not add new notifications for opportunities.

For more information about modifying status notifications, refer to Setting up
Notifications in Oracle Workflow Builder, page 3-8. []

Opportunity Events

Oracle Partner Management supports the ability to write interactions into a table visible
to channel managers in the channel manager dashboard. The list of events that are
tracked in the interaction table are:

*  Opportunity <opportunity number> has been assigned

*  Opportunity <opportunity number> approved by Channel Manager

*  Opportunity <opportunity number> approved by Channel Manager for Partner

¢ Opportunity <opportunity number> approval by channel manager bypassed

¢  Opportunity <opportunity number> match rejected by Channel Manager

*  Opportunity <opportunity number> approval by channel manager timed out

* Opportunity <opportunity number> offered has been accepted by another partner
*  Opportunity <opportunity number> matched has been withdrawn

*  Opportunity <opportunity number> is offered to <partner>. Opportunity routing
status changed to <opportunity status>.

* Opportunity <opportunity number> offered has been withdrawn
*  Opportunity <opportunity number> abandoned
*  Opportunity <opportunity number> accepted

* Opportunity <opportunity number> created by partner
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Opportunity <opportunity number> declined by partner

Opportunity <opportunity number> awaiting partner acceptance timed out
Opportunity <opportunity number> is closed as won. Status is <opportunity status>
Opportunity <opportunity number> is closed as lost. Status is <opportunity status>

Order is placed from won opportunity. Customer <customer> placed order for
opportunity <opportunity number>

Opportunity <opportunity number> status changed to <opportunity status>

Users and Security

In Oracle Partner Management, users’ access to opportunities is based on the Oracle
Sales team security model.

Opportunity Owner

When a user creates a lead or opportunity, the user is added to the sales team
automatically, with the Do Not Reassign flag selected. The user is identified as the
opportunity owner.

Opportunity Access Security

There are two levels of access to opportunity information:

Full: The user has Update access for all opportunities.

Sales Team: The user has Update access to all opportunities for which he is on the
sales team with the Full Access flag selected. The user has read-only access for all
opportunities for which he is on the sales team with the Full Access flag deselected.

The levels of access that a user has are determined by the setting of the profile option
ASN: Opportunity Access Privilege:

Vendor Users: The profile option should be set to Full at the Responsibility level for
each responsibility that is assigned to vendor users.

Partner Users: The profile option should be set to Sales Team at the Responsibility
level for each responsibility that is assigned to partner users.

Customer Access Security

There are two levels of access to customer information:

Full: The user has Update access for all customers.

Sales Team: The user has Update access to all customers for which he is on the
customer sales team with the Full Access flag selected. The user has read-only
access for all customers for which he is on the customer sales team with the Full
Access flag deselected.

The levels of access that a user has are determined by the setting of the profile option
ASN: Opportunity Access Privilege:

Vendor Users: The profile option should be set to Full at the Responsibility level for
each responsibility that is assigned to vendor users.
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e Partner Users: The profile option should be set to Sales Team at the Responsibility
level for each responsibility that is assigned to partner users.

Partner Contact Security

A partner user with the PV_OPPTY_CONTACT permission is designated as the partner’s
opportunity contact, and is always added to the sales team of an opportunity. By
default, the partner with the PV_PARTNER_PRIMARY_USER permissions-based role
has this permission.

Profile Options

There are certain system profile options that must be set for Opportunity Management to
function properly. In addition to the profile options mentioned in this chapter, there are
additional profile options that may need to be set. Refer to Appendix A, “System Profile
Options”, page [AHI for a completé|list of profile options for Opportunity Management.

Concurrent Programs

There are several concurrent programs that need to be run periodically for Opportunity

Management. Refer to Appendix C, “Summary of Concurrent Programs", page |CH1 for
information about setting up and running the programs.
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Overview

Setting Up Referral Management

This chapter covers the following topics:

e  Overview |

* [Setting Up Budgets

Setting Up Offers

Setting Up Claims

Enabling [Profile] Attributes|for Referrals

Defining [Produ¢t Categories

Setting up Approvals

Setting up Notifications

Setting up Territories

Setting up Data Quality Management (DQM)

Setting up Notes

Creating a Referral Benefit

Specifying a Sales Channel

Users and Security
Profile Options | |

Lookups |

Concurrent [Programs \

Referral Management enables partners to refer leads and opportunities to the vendor
that the partners cannot fulfill directly. For example, if a customer is interested in one of
the vendor’s products that the partner does not sell, the partner can submit a referral

to the vendor and receive a percentage of the revenue.

When a partner user submits a referral, it is routed to the appropriate vendor
approver(s). Approvers are notified of the referral and they review it and

approve, reassign or decline it. The vendor also performs customer and contact duplicate
checking using Oracle Data Quality Management to determine if the same lead or
opportunity already exists in the system. If the referral is unique and meets other vendor
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qualifications, it is approved, and a lead or opportunity is generated. The new lead or
opportunity contains a link to the original referral information.

After an order is generated, and the product is shipped to the customer, a claim is
generated in the system. After the claim is approved internally, the partner receives
notification to review and accept compensation. After a partner user accepts the
compensation, the vendor pays the commission.

Referrals are integrated with Oracle Sales and Oracle Leads Management, which allow
opportunity routing and lead qualification processes to occur successfully for referrals.

Vendor and partner users can access a summary list of referrals to which they have
access. They can build personal views to quickly find referrals that they are most
interested in.

Setting Up Budgets

A budget is a pool of money that vendors can use to execute trade promotion activities
such as offers and campaigns. Because partners receive compensation for referrals, one
or more budgets must be specified to fund referral compensation. Referral budgets are
fixed budgets and have to be active in to be selected in the referral benefit. Accruals
are created for each order line that matches between customer orders and referred
products submitted.

An organization can create budgets specifically for referrals, or fund referrals from
an existing budget. Use the following procedure to create a fixed budget for referral
compensation.

Navigation

Log into Oracle Trade Management as the Oracle Trade Management User and navigate
to Budget > Create, and then click Create to display the Create Budget page.

Prerequisites

A set of books must be defined.
Notes
e Setup Type: Select Fixed Budget.

e Number: If you leave the budget number field blank, a unique number is generated
automatically for the budget.

* Business Unit: Business units are organizations that are set up in Oracle Human
Resources with Type - Business Unit. Business units are used mainly for classification
purposes. Business units can also affect approval rules.

e Category: Select the appropriate category for the referral budget. An approval rule
for a budget can use category as one of its criteria.

¢ Holdback Amount: The amount of funds to be reserved and not allocated to lower
levels. A budget administrator can choose to reserve or release the holdback amount
at any time by manually reducing the original holdback amount.

* Owner: By default, the owner is the user creating the budget. A different owner
can be specified.

e Start Date and End Date: These dates are mapped in the Oracle General Ledger
calendar, and limit the start and end dates of budgets.
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Setting Up Offers

When a partner referral request is approved, an offer is created in Trade
Management. The seeded custom setup Net Accrual Offer is used with partner
referrals. When a partner’s referral request is approved, a net accrual offer based on
this custom setup is created automatically. The offer is used to track funds committed
for the referral request.

By default, the Budget Approval process has been disabled for the New Accrual
offer. Depending on business requirements, budget approval can be enabled for the
offer, and then the vendor can set up an approval process for partner referral budgets.

It is not recommended that you create additional offers for partner referrals.

Setting Up Claims

A default claim (which is called Claims) is available in Trade Management as a custom
setup. This default claim is used for all flows that require a party (for example, a partner)
to submit a claim to be reimbursed for a marketing activity or other situation.

When a referral request is approved, a Net Accrual offer is created. The offer creates
an authorization code. When a partner user submits a claim for reimbursement for
closed business resulting from her referral, she must include the authorization code on
the claim to link the claim with the offer and the approved funding request. Claims are
processed through Oracle Accounts Payable or Oracle Accounts Receivable.

The default claim specifies that a number of items will be included in the claim

form, including team information, notes, and request history. An organization can also
create a customized claim, if required. Creating a custom claim provides the following
benefits:

¢ Since all claims that use the default custom setup have the same prefix, identifying
the type of partner request a claim is associated with could become difficult. Creating
a customer claim allows you to set up a new prefix that can be used to easily identify
partner referral claims.

* Allows you to set up a different approval routing process for different types of
claims. The default claim does not implement a claims approval process.

¢ Allows you to set up a different claim validation process.

Refer to the Oracle Trade Management Implementation Guide for additional information on
creating custom claims.

Enabling Profile Attributes for Referrals

When a referral benefit is created, the channel administrator can create questions that

a partner user must answer when submitting a referral request. The questions are
associated with partner profile attributes, and the answer the partner user provides for
the questions are used to populate the profile attributes for the partner. In addition, some
of the partner profile attributes can be mapped to the opportunity or lead generated

as a result of a referral.

The following table lists the seeded partner profile attributes that are enabled for use
with referral benefits. The channel administrator can also create custom attributes that
can be used with referrals. To enable a custom attribute for referrals, the Lead Referral
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checkbox must be selected for the attribute. For more information on working with
partner profile attributes, refer to Setting up Partner Profile Attributes, page [FH1. I

Seeded Partner Profile Attributes Enabled for Referral Benefits

Partner Profile Attribute Map to Opportunity Map to Lead
Industry - -
Source (Campaign) X X
DUNNS - -

Lead Description - -
Number of users - -
Opportunity Description - -
Opportunity Size - -
SIC - -
Total employees - -
Information Verified - -

Customer Annual Revenue - -

Time Frame (Purchase - X
Timeframe)

Budget Status - X
Total Budget X X
Response Channel X X
Sales Stage X -
Close Date X -
Offer X X

Defining Product Categories

When the channel administrator creates a referral benefit, she specifies one or more
product categories for the benefit. The product categories determine for which products
a vendor can refer a lead or opportunity.

The product categories that a channel administrator can choose from are presented
in a hierarchy that is relevant for the referral. This information is used as the basis
for approving a referral, identifying orders that directly result from a referral, and

computing the compensation amount due to the partner.
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Product categories are set up in the Oracle Advanced Pricing application, and are
common across all of an organization’s product lines. For information on defining
product categories, see Oracle Advanced Product Catalog User Guide.

Setting up Approvals

Partner lead and opportunity referral requests are subject to an approval process. When
a partner user submits a referral request, it is routed to an approver, who is a vendor
user. The approver can approve, reassign, or reject the request. The partner referrals
approvals process is set up and managed through the Oracle Approvals Management
application.

In addition to validating the information submitted by a partner user, referral approvers
must perform checks for duplicate referrals, duplicate customers, and duplicate
customer contacts. If a duplicate referral is identified, the referral request is rejected. If a
duplicate customer or customer contact is identified, the approver links the referral with
the existing customer information. He must also make sure that the referral is not for a
lead or opportunity that already exists.

The seeded transaction for partner referral requests is PV: Referral Management
Approvals. Numerous attributes have been defined for this transaction. A default
referral request approver can be identified using the PV: Default Referral Approver
profile option. For more information on setting up approvals for lead and opportunity

referrals, refer to Creating Approval Rules in Oracle Approvals Manager, page 32.

Setting up Notifications

Notification messages are sent to vendor and partner users in response to a number
of partner referral request status changes. Notification messages for partner referral
requests are created and stored in the Oracle Workflow Builder application. An
organization might be able to implement the notifications that have been seeded for
referrals without modification. However, if you need to make changes to the seeded
notifications, such as changing the message text, adding URLs to messages, or even
creating additional notifications, you will need access to Oracle Workflow Builder
version 2.6.2 and the Oracle 9i database.

In Workflow Builder, the item type for referral notifications is PVREFFRL. The following
table lists the notifications seeded for referrals and lists the types of users that are eligible
for each notification and the referral request status that is applicable for the notification.
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Notifications for Partner Referrals

Notification Name User Referral Request Status
Referral Created - Partner Partner Contact, Referral Pending Approval
Notification Superuser (Partner)

Referral Created - Vendor Vendor Approvers, Vendor Pending Approval
Notification Channel Managers, Referral

Superuser (Vendor)

Referral Approved - Requires DQM Approver, Vendor Pending Customer Review
Customer Deduplication Channel Managers, Referral

Vendor Notification Superuser (Vendor)

Acceptance Letter /Referral Referral Superuser (Partner),  Awaiting For Partner
Commission - Partner Partner Contact (Partner Acceptance

Notification contact must have the Accept

Compensation permission)

Referral Declined - Partner Partner Contact, Referral Declined
Notification Superuser (Partner)

Referral Accepted - partner Partner Contact, Referral Approved
Notification Superuser (Partner)

Setting up Territories

A territory hierarchy must be set up for lead and opportunity referral requests. For
referrals, a territory hierarchy allows the vendor organization to offer different referral
benefits based on customer country. For example, the vendor might want to allow
referrals on different products in Canada than in the United States, or source referral
compensation from different budgets for different countries. The territories must be set
up at the country level.

The territory hierarchy is set up through the Oracle Territory Management

application. As part of implementation, the vendor must set up a territory with the
Partner Management usage to create and populate channel teams. The territory that is set
up for referrals is a different territory, and is created with the Trade Management usage. If
a vendor organization has already implemented Oracle Trade Management, setting up
another Trade Management territory is not required. For more information on creating a

territory hierarchy, refer to Setting up Territories in Oracle Territory Manager, page 3-6.

Setting up Data Quality Management (DQM)

DQM is a tool from the Oracle Trading Community Architecture (TCA) group that is used
to check for potential duplicate customers or contacts for a given customer or contact.

When a lead or opportunity referral is created, the referral request approver must
compare the customer or reseller name entered with existing records in TCA. If there are
no matches for the customer or the customer contact, a new customer and/or contact are
created. If there are matches for the customer, the approver can review and decide to
create a new organization or use an existing organization. If the approver creates a new
organization, she also creates a new contact.
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The approver also uses DQM to identify whether or not the lead or opportunity being
referred already exists in the system. If it matches an existing lead or opportunity, the
referral request might be declined.

As part of implementation, the channel administrator may need to set up matching
rules in DQFor more information on using DQM and creating rules, refer to Setting up
Matching Rules with Oracle Data Quality Management, page BH10.

Note that, for successful partner contact deduplication for referrals, a matching rule
containing the "contact name" attribute must be created. If seeded matching rules are
being used, the channel administrator may use the SAMPLE_SEARCH rule to enable
partner contact deduplication, as contains the "contact name" attribute.

Setting up Notes

Notes can be created for a referral request. By default, all note types that are not
specifically associated with another business object are available for referrals. A vendor
can create a note type for referral requests to limit the note type choices that a user
sees when creating a note for a referral.

For more information about setting up notes and note types, refer to Setting up Notes.

Creating a Referral Benefit

The channel administrator is responsible for creating referral benefits, which channel
managers can add to partner programs.

There are three basic types of referral benefits, and they are based on the type of sales
transactions that result from the approval of the referral:

* Opportunity: When the referral is approved, an opportunity is created and linked to
the referral.

* Opportunity assigned to partner: When the referral is approved, an opportunity
is created and is subsequently routed to the partner that originally submitted the
referral. The referral is linked to the opportunity.

* Lead: When the referral is approved, a lead is created and linked to the referral. The
lead can subsequently be qualified, and the resulting opportunity routed to the
correct channel.

Use this procedure to set up a referral as a benefit.
Navigation

Log in as the channel administrator and navigate to Programs > Benefits, select Referral
from the Create Benefit drop-down list, and click Go.

Prerequisites

For a benefit to become active, the following items must exist:

* At least one budget has been set up for referral compensation.
* The Net Accrual Offer is present.

* At least one product category has been set up.

¢ Atleast one territory has been defined with the Trade Management usage.
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Notes

* Sales Transaction: Select Opportunity, Opportunity assigned to Partner, or Lead
from the list depending on desired outcome of the referral benefit.

* Budgets region: Select one or more budgets that will provide funds to compensate
partners for referrals.

¢ Budget Name: Select the name of the budget to be used from the drop-down
list. The list displays fixed budgets that are active and that the channel
administrator has access to. A user has access to a budget if he is the budget
owner or is on the access list for the budget.

* Requested Budget Amount: The requested budget amount is the amount of
money that should be used to fund referrals created from the benefit. The
amount entered here is marked as Committed funds in the budget.

If the profile option OZF: Allow committed budget to exceed total amount is
set to No, the requested budget amount can not exceed the amount in the
budget. If the profile option is set to Yes, the benefit pass validation in spite
of the difference in funds.

* Request Status: This is populated by the system. When the budget passes the
validation process, the status is Approved.

* Additional Details region: In this section you create questions that will be used by
approvers to evaluate the referral. The partner’s responses are captured and stored
in the partner’s profile. In addition, some responses are used to populate fields on
the lead or opportunity that is generated upon referral approval. For each question
that you add, specify the following:

¢ Label: This is the label displayed in the referral details under the additional
details section when the partner is creating a referral.

e Profile Attribute: Select a profile attribute. The profile attributes list displays
seeded attributes that have been seeded for lead or opportunity referrals and
custom attributes that are defined to be valid for referrals.

®  Order: The order in which the questions will appear on the referral request.
* Mandatory: Select to make a question mandatory.

* Products region: The referrals requests created from this benefit are restricted to the
product categories specified here. Select the product category and then provide the
following information for each category included in the benefit:

* Compensation Percentage: Specifies the referral compensation to be paid to the
partners based on a percentage of the net sales amount.

¢ Maximum: Sets a cap on the referral compensation on a product-by-product
basis. For a specific product, the referral compensation for the referral cannot
exceed this amount regardless of the compensation percentage specified.

* Territories region: In the territories region, you select one or more territories for the
benefit from the drop-down list of territories that have been set up for referrals. The
customer associated with the referred lead or opportunity must be located in one of
the geographic regions specified for the benefit. Territories must be specified for the
benefit. Select the territory and then provide the following information:

e Threshold: The threshold is the minimum amount that is allowed for a referral
request.
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The threshold is the total unit price for all the products listed on the request. For
example, a referral for the sale of five laptop computers at a unit price of $1000
each and 10 desktop computers at unit price of $500 each has a threshold amount
of $1500, or the total unit price of all the products included in the request.

® Currency: Select the currency used for the territory.

* Action: Select the error or warning that is used when a referral request does not
meet the threshold amount:

e Display Error: An error is displayed, and the request can not be submitted.

* Warning to Approver: The referral request can be submitted for
approval, but the approver sees a warning about the threshold.

*  Warning to Partner and Approver: The referral request can be submitted
for approval, but both the approver and the partner submitting the request
see a warning.

e Expiration (Days): Optionally, you can specify the number of days that the
territory qualifications are in effect.

* Notifications region: Select the notifications that will be set to partner and
vendor users in response to status changes on referral requests generated from
this benefit. For each referral status that for which you want to provide a
notification, specify the following:

® Status: Referral status change that requires notification.

e User Role: Group of users that needs to be notified for the corresponding
status change.

* Notification Name: The workflow notification message that the user will
receive.

e Apply: Click to save the benefit.

e Activate: Click to run the benefit validation process.

The Benefit Validation Process

During the creation process, a benefit goes through a number of benefit
statuses: Active, Inactive, Draft, Failed Validation. When the process completes, the
status is updated to Active or to Failed Validation.

When a benefit is created, it can be saved in the draft status by clicking Apply. At this
point, no validation is done on the budget. When the channel administrator clicks
Activate, a Net Accrual Offer is created in the background and budget validation

is performed on the offer. Budget validation involves ensuring that the products

and territories information specified in the benefit setup screen correspond and fall
under their counterparts specified in the budget. Budget validation also ensures that
each of the budget requests has a valid amount. If any one of the above items failed
the validation, the benefit status becomes Failed Validation. Otherwise, it becomes
Active. When the benefit status becomes Failed Validation, it can still be re-activated by
correcting the failed item(s) and reapplying the changes. This process can be repeated
until the benefit becomes active.

Once a benefit becomes active, the following conditions hold:

* Budget lines cannot be removed, but new lines can still be added.
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¢ Products and territories can neither be removed nor added.
e New Additional Detail lines cannot be added.

¢ Notification lines can be added or removed.

Specifying a Sales Channel

When a referral request is approved, an unqualified lead, an unmatched opportunity, or
an opportunity for a specific partner is created. The system automatically specifies a
sales channel for each lead or opportunity created from a referral request.

When a lead is created, the system assigns the Direct channel to the lead. The lead is
then routed to the lead engine, which subsequently qualifies the lead and then assigns
a channel to the resulting opportunity.

When an unmatched opportunity is created, the channel is determined by the profile
option OS: Default Sales Channel. This profile option is part of the Oracle Sales
application. For additional information on this profile option, refer to the Oracle Sales
Implementation Guide

When a referral generates an opportunity for a specific partner, the system assigns an
indirect sales channel to the opportunity. The profile option PV: Default Indirect Channel
Type determines the name of the indirect channel that will be used by default for all
opportunities that are routed to partners as a result of a referral.

Users and Security

Users who are granted access to all leads and opportunities within the sales application
can access all referrals that generated a lead or an opportunity. In addition, there are two
permissions that are associated with partner referral requests:

* Super User Permission - [PV_REFERRAL_SUPERUSER] - Allows a vendor user
to view and update all referrals and allows a partner user to view and update all
referrals owned by their organization.

¢ Compensation Approver - [PV_REF_COMP_APPROVER] - This permission enables
partners to view and accept compensation for referrals.

Profile Options

There are certain system profile options that must be set for partner referral requests to
function properly. In addition to the profile options mentioned in this chapter, there are
additional profile options that may need to be set. Refer to Appendix A, “System Profile
Options”, page |AH1 for a complete list of profile options for referral requests.

Lookups

There are some Lookups that can be modified for referral requests. Refer to Appendix
B, "Lookups", page Bl for information about Lookups related to referral requests.
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Concurrent Programs

There are several concurrent programs that need to be run periodically for referral

requests. Refer to Appendix C, “Summary of Concurrent Programs", page [CH1 for

information about setting up and running the programs.
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Overview

Setting Up Deal Registration

This chapter covers the following topics:

e  Overview |

Enabling [Profile] Attributes for Deal Registration

Defining [Produ¢t Categories

Setting up Approvals

Setting up Notifications

Setting up Territories

Setting up Data Quality Management (DQM)

Setting up Notes

Creating a Deal [Registration Benefit

Specifying a Sales Channel

Users and Security
Profile Options | |

Lookups |

Concurrent [Programs \

When partners resell your products, there is often a conflict between your direct
sales force and your partner network. Deal Registration enables partners to submit
opportunities and receive your commitment not to compete with them directly and to
support them on the deal. You increase partner loyalty and gain visibility into partner
activity.

When partners register a deal, it is routed to the appropriate approver(s). Approvers
are notified of the deal registration and they review it and approve, reassign, or decline
it. When the deal registration is approved, a new opportunity is created in the system
and assigned to the partners’ organization for fulfillment.

Vendors and partners receive notifications about deal registration activity and can
navigate directly from the notification into the associated deal registration. Notifications
are configured by the vendor and sent when the status changes, for example, when a
deal registration is approved.
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Enabling Profile Attributes for Deal Registration

When a deal registration benefit is created, the channel administrator can create
questions that a partner user must answer when submitting a registration request. The
questions are associated with partner profile attributes, and the answer the partner user
provides for the questions are used to populate the profile attributes for the partner. In
addition, some of the partner profile attributes can be mapped to the opportunity
generated as a result of a registration.

The following table lists the seeded partner profile attributes that are enabled for use with
deal registration benefits. The channel administrator can also create custom attributes
that can be used with registrations. To enable a custom attribute for registrations, the
Deal Registration checkbox must be selected for the attribute.

Seeded Partner Profile Attributes Enabled for Deal Registration

Question Map to Opportunity
Industry -
Source (Campaign) X

Number of users -
Opportunity Description -
Opportunity Size -
SIC -
Total employees -
Information Verified -

Customer Annual Revenue -

DUNNS -
Total Budget X
Response Channel X
Sales Stage X
Close Date X
Offer X

Defining Product Categories

When the channel administrator creates a deal registration benefit, she specifies one or
more product categories for the benefit. Partners can then register opportunities that
include these products.
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The product categories that a channel administrator can choose from are presented in
a hierarchy that is relevant for deal registration. This information is used as the basis
for approving a deal registration request.

Product categories are set up in the Oracle Advanced Pricing application, and are
common across all of an organization’s product lines. For information on defining
product categories, see Oracle Advanced Product Catalog User Guide.

Setting up Approvals

Partner deal registration requests are subject to an approval process. When a partner
user submits a registration request, it is routed to an approver, who is a vendor user. The
approver can approve, reassign, or reject the request. The partner deal registration
approvals process is set up and managed through the Oracle Approvals Management
application.

In addition to validating the information submitted by a partner user, deal registration
request approvers must perform checks for duplicate opportunities, duplicate
customers, and duplicate customer contacts. If the opportunity that the partner is
trying to register is already in the system, the registration request might be rejected. If a
duplicate customer or customer contact is identified, the approver links the information
on the registration request with the existing customer information.

The seeded transaction for registration requests is PV: Deal Registration
Management. Numerous attributes have been defined for this transaction. A default
registration request approver can be identified using the PV: Default Deal Registration
Approver profile option. For more information on setting up approvals for deal

registrations, refer to Creating Approval Rules in Oracle Approvals Manager, page 312.

Setting up Notifications

Notification messages are sent to vendor and partner users in response to a number

of deal registration request status changes. Notification messages for deal registration
requests are created and stored in the Oracle Workflow Builder application. An
organization might be able to implement the notifications that have been seeded without
modification. However, if you need to make changes to the seeded notifications, such

as changing the message text, adding URLs to messages, or even creating additional
notifications, you will need access to Oracle Workflow Builder version 2.6.2 and the
Oracle 9i database.

In Workflow Builder, the item type for deal registration notifications is PVDEALRN. The
following table lists the notifications seeded for deal registrations and lists the types

of users that are eligible for each notification and the registration request status that is
applicable for the notification.
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Notifications for Deal Registrations

Notification Name

User

Deal Registration Request
Status

Deal Registration Created
- Vendor Notification

Deal Registration Created
- Partner Notification

Deal Approved - Requires
Customer Deduplication
- Vendor Notification

Deal Registration Declined
- Partner Notification

Deal Registration Accepted
- Partner Notification

Vendor Approvers, Vendor
Channel Managers, Referral
Superuser (Vendor)

Partner Contact, Referral
Superuser (Partner)

DQM Approver, Vendor
Channel Managers, Referral
Superuser

Partner Contact, Referral
Superuser (Partner)

Partner Contact, Referral
Superuser (Partner)

Pending Approval

Pending Approval

Pending Customer Review

Declined

Approved

The following table lists deal registration statuses and the corresponding code.

Deal Registration Statuses

Deal Registration Status

Deal Code

Closed. Dead Lead

Closed. Lost Opportunity

CLOSED_DEAD_LEAD

CLOSED_LOST_OPPTY

SUBMITTED_FOR_APPROVAL

Expired EXPIRED

Draft DRAFT

Closed by Vendor MANUAL_CLOSE
Pending Approval

Extended by Vendor MANUAL_EXTEND

Pending Customer Review
Declined

Approved

APPRVD_PENDNG_CSTMR_DQM
DECLINED

APPROVED

Setting up Territories

A territory hierarchy can be set up for deal registrations. For deal registrations, a
territory hierarchy allows the vendor organization to offer different registration benefits
based on customer country. For example, the vendor might want to allow registrations
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on different products in Canada than in the United States. The territory must be set
up at the country level.

A territory hierarchy is optional for deal registrations. If no territory is defined, deal
registration is enabled for all countries. However, when a territory is used for deal
registrations, countries that are not linked to a territory are unavailable.

The territory hierarchy is set up through the Oracle Territory Management
application. As part of implementation, the vendor must set up a territory with the
Partner Management usage to create and populate channel teams. The territory that

is set up for deal registration is a different territory, and is created with the Trade
Management usage. If a vendor organization has already implemented Oracle Trade
Management, setting up another Trade Management territory is not required. For more
information on creating a territory hierarchy, refer to Setting up Territories in Oracle
Territory Manager, page 346. |]

Setting up Data Quality Management (DQM)

DQM is a tool from the Oracle Trading Community Architecture (TCA) group that is used
to check for potential duplicate customers or contacts for a given customer or contact.

When a registration request is submitted for approval, the deal registration request
approver must compare the customer or reseller name entered with existing records in
TCA. If there are no matches for the customer or the customer contact, a new customer
and/or contact are created. If there are matches for the customer, the approver can
review and decide to create a new organization or use an existing organization. If the
approver creates a new organization, she also creates a new contact.

The approver also uses DQM to identify whether or not the opportunity being registered
already exists in the system. If it matches an existing opportunity, the registration
request might be declined.

As part of implementation, the channel administrator may needs to set up matching
rules in DQM. For more information on using DQM and creating rules, refer to Setting
up Matching Rules with Oracle Data Quality Management, page BHL0. [

Setting up Notes

Notes can be created for a deal registration request. By default, all note types that are not
specifically associated with another business object are available for deal registrations. A
vendor can create a note type for deal registration requests to limit the note type choices

that a user sees when creating a note for a registration.

For more information about setting up notes and note types, refer to Setting up Notes,
page B313. il

Creating a Deal Registration Benefit

The channel administrator is responsible for creating deal registration benefits, which
channel managers can add to partner programs.

Use this procedure to create a deal registration benefit.

Navigation
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Log in as the channel administrator and navigate to Programs > Benefits, select Deal
Registration from the Create Benefit drop-down list, and click Go.

Prerequisites
For a benefit to become active, the following items must exist:

® At least one product category has been set up.

Notes

* Additional Details region: In this section you create questions that will be used
by approvers to evaluate the deal registration request. The partner’s responses are
captured and stored in the partner’s profile. In addition, some responses are used to
populate fields on opportunity that is generated upon registration approval. For
each question that you add, specify the following;:

¢ Label: This is the label displayed in the registration details under the additional
details section when the partner is creating a registration request.

e Profile Attribute: Select a profile attribute. The profile attributes list displays
seeded attributes that have been seeded for deal registrations and custom
attributes that are defined to be valid for deal registration.

®  Order: The order in which the questions will appear on the deal registration
request.

* Mandatory: Select to make a question mandatory.

* Products region: The deal registration requests created from this benefit are
restricted to the product categories specified here.

* Territories region: In the territories region, you select one or more territories for
the benefit from the drop-down list of territories. The customer associated with the
registered opportunity must be located in one of the geographic regions specified for
the benefit. Territories are optional for deal registration.

Select the territory and then provide the following information:

e Threshold: The threshold is the minimum amount that is allowed for a deal
registration request.

The threshold is the total unit price for all the products listed on the request. For
example, an opportunity for the sale of five laptop computers at a unit price

of $1000 each and 10 desktop computers at unit price of $500 each has a
threshold amount of $1500, or the total unit price of all the products included

in the opportunity.

¢ Currency: Select the currency used for the territory.

* Action: Select the error or warning that is used when a registration request
does not meet the threshold amount:

* Display Error: An error is displayed, and the request can not be
submitted.

* Warning to Approver: The registration request can be submitted for
approval, but the approver sees a warning about the threshold.

* Warning to Partner and Approver: The registration request can
be submitted for approval, but both the approver and the partner
submitting the request see a warning
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¢ Notifications region: Select the notifications that will be set to partner and
vendor users in response to status changes on registration requests generated
from this benefit. For each deal registration request status for which you want to
provide a notification, specify the following:

e Status: Deal registration request status.

e User Role: Group of users that needs to be notified for the corresponding
status change.

¢ Notification Name: The workflow notification message that the user will
receive.

e Apply: Click to save the benefit.

e Activate: Click to run the benefit validation process.

The Benefit Validation Process

During the creation process, a benefit goes through a number of benefit
statuses: Active, Inactive, Draft, Failed Validation. When the process completes, the
status is updated to Active or to Failed Validation.

When a benefit is created, it can be saved in the draft status by clicking Apply. At this
point, no validation is done on the benefit. When the channel administrator changes
the benefit’s status to Active and clicks Apply, the benefit validation process runs. If
the benefit passes validation, its status changes to Active. If the benefit does not pass
validation, the status becomes Failed Validation. The benefit can still be re-activated by

correcting the failed item(s) and reapplying the changes. This process can be repeated
until the benefit becomes active.

Once a benefit becomes active, the following conditions hold:
¢ Products and territories can be neither removed nor added.
e New additional detail lines cannot be added.

¢ Notification lines can be added or removed.

Specifying a Sales Channel

When a deal registration request is approved, an opportunity is created and routed to
the partner that registered the deal. When the system creates the opportunity, it assigns
it to an indirect sales channel. The profile option PV: Default Indirect Channel Type
determines the indirect channel that will be used by default for all opportunities that
created from deal registrations.

Users and Security

Users who are granted access to all opportunities within the sales application can access
all registration requests that generated an opportunity. In addition, the Super User
Permission (PV_DEAL_SUPERUSER) allows a vendor user to view and update all

deal registrations and allows a partner user to view and update all deal registrations
owned by his organization.
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Profile Options

There are certain system profile options that must be set for deal registration requests to
function properly. In addition to the profile options mentioned in this chapter, there are
additional profile options that may need to be set. Refer to Appendix A, “System Profile
Options”, page [AHI for a completé|list of profile options for deal registration requests.

Lookups

There are some Lookups that can be modified for deal registration requests. Refer
to Appendix B, “Lookups”, page BH1 for informatigh about Lookups related to deal
registration requests.

Concurrent Programs

There are several concurrent programs that need to be run periodically for deal
registration requests. Refer to Appendix C, “Summary of Concurrent Programs”, page
1 for information about setting up and running the programs.
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Setting Up Special Pricing Management

Overview

This chapter covers the following topics:

e  Overview |

e [Setting up Special Pricing Budgets]
Offers |

Claims |

Trade Profiles | \

Setting up Special Pricing Product Security |

Creating the Special [Pricing Responsibility

Creating the Special [Pricing Benefit

Setting up Approvals

Setting Up Notifications

Setting up Data Quality Management (DQM)

Setting up Notes

OAM Transaction Types and Attributes
Profile Options | |

User Security

Lookups |

Concurrent [Programs \

Special Pricing Management enables partners to submit and check the status of special
pricing requests and claims online. A special pricing request enables partners to request
discounted pricing from the vendor. Partners can request discounts on competitive
sales deals, specific end-customer deals, and on inventory that they have not been

able to move.

When a request is submitted, it gets routed to the appropriate approver(s). Approvers
are notified of the request and they review the request and approve or decline

it. After the special pricing request has been approved, and the partner has closed the
sale, he/she can submit a claim to receive the discount that was approved. The claim
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is routed to the claim approver who then validates the claim. When the claim gets
approved, the vendor pays the discount amount.

Partners receive notifications about the special pricing request activity and can link
directly from the notification into the associated special pricing request. Notifications
are configured by the vendor and sent when the status changes, for example, when a
special pricing request is approved.

Partners can access a summary list of all the special pricing requests that they have
access to, in the system. They can build personal views to quickly find the special pricing
requests that they are most interested in.

Liability Calculation

In case of special pricing requests, the liability gets created upon approval for each of
the products for the total approved discount amount. When a request is linked with
another request, the liability is created only for amounts in products, which exceeds the
current liability for that product.

For example:

A special pricing request (SPR1234) has been submitted to sell products mentioned in the
table below, to a Customer A for the Existing Inventory scenario.

Product Discount Amount Units Discount
Laptop $120 10 1000
Desktop $100 60 6000

A special pricing request (SPR1235) has been submitted to sell products mentioned in the
table below, to a Customer A for the Existing Inventory scenario.

Product Discount Amount Units Discount
Laptop $120 11 1100
Desktop $100 55 5500

If SPR1234 is approved first and SPR1235 gets linked to SPR1234 because it is a request
for the same end-customer deal, when request SPR1235 gets approved, it creates an
additional $100 liability for laptops and an additional liability is not created for desktops.

In the above scenario, the same underlying offer authorization code would be used to
track liabilities for both requests and both would have same agreement numbers.

Setting up Special Pricing Budgets
Special pricing requests are funded from one or more budgets. Budgets are set up

in the Trade Management application, by a user with the Oracle Trade Management
User responsibility.

A special pricing budgets are fixed budgets. A fixed budget is a pool of money with
a value greater than zero. When you create a fixed budget, you decide the maximum
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amount of funds that it can include (although additional funds can be specified later if
needed).

A fixed budget allows the vendor to track the amount of funds that have been
committed, used, earned, and paid for from the budget. When the budget is set up, an
account can be specified and then used to track liability for the budget.

A budget is specified as a special pricing budget through the OZF: Default budget for
special pricing requests. Depending on an organization’s business needs, a single special
pricing budget can fund all special pricing requests, or multiple budgets can be set

up. This option needs to be set for each budget that will fund special pricing requests.

Creating a Special Pricing Budget

Use this procedure to create a new special pricing budget.
Navigation

Log on to the Trade Management application with the Oracle Trade Management User
responsibility, and navigate to Budget > Create to access the Create Budget page.

Prerequisites
None

Notes
* Setup Type: Select Fixed Budget.

* Category: Select the appropriate category for the special pricing budget. An
organization can create a category to organize special pricing budgets. Refer to
the Oracle Trade Management Implementation Guide for additional information on
categories.

* Owner: By default, the owner is the user creating the budget. A different owner
can be specified.

¢ Create button: When you click Create, the Budget Detail page appears. From
that page, you can specify accounting information, including an accrual liability
account and a sales/expense/charge account. Refer to the Oracle Trade Management
Implementation Guide for additional information.

Identifying Special Pricing Budgets

Offers

After the special pricing budget or budgets have been set up, the OZF: Default budget
for special pricing profile option must be set to identify the budgets appropriately.

If an organization is going to use a single special pricing budget, the profile option is
set at the Site level. The value is the name of the budget.

If an organization is implementing multiple begets for special pricing, the profile
option must be set for each budget at the Responsibility level, where the responsibility
corresponds to a business unit or geographic entity. The value is the name of the budget.

When a special pricing request is approved, an offer is created in Trade Management. The
type of offer created is determined by the type of special pricing request:
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e ScanData Offer: This offer is generated when a partner requests special pricing for
products that already exist in the partner’s inventory. The offer enables vendors
to reimburse partners for the discounted amount on products that partners have
already bought. The partner will need to submit a claim to be reimbursed for
the product discount.

e Off Invoice Offer: This offer is generated when a partner requests special pricing
for products that it plans to purchase and the vendor approver indicates that the
partner will receive the discount at the time an order is placed. This offer acts as
a pricing modifier for future orders. Vendors can see the Offer Type field during
approval if the Ship from Stock check box is not selected. If the vendor approver
specifies this type of offer, partners do not have to submit a claim. An authorization
code is generated for the partner upon approval, which needs to be used when
booking the order to receive the discount. The authorization code is displayed on
the approved special pricing request.

® Accrual Offer: This offer is generated when a partner requests special pricing
for products that it plans to purchase and the vendor approver indicates that the
partner will need to submit a claim to receive the discount. This offer acts as a
pricing modifier for future orders. Vendors can see this field during approval
if the Ship from Stock check box is not selected. If the vendor approver specifies
type of offer, partners have to submit a claim to receive the approved discount. An
authorization code is generated for the partner upon approval, which needs to be
used when booking the order to receive the discount. The authorization code
is displayed on the approved special pricing request.

The three offers used with special pricing are seeded in Trade Management as custom
setups. It is not recommended that additional offers be created for special pricing.

Tracking Financial Liability

Claims

Each budget has five kinds of the budgeted amount. They are Planned, Committed,
Utilized, Earned, and Paid. The planned amount increases when a request is made on
that budget. When the budget request is approved, the committed amount increases. If
a Scan Data offer is generated, the utilized and earned amounts increase when the
offer is approved. If an Accrual or Off-Invoice offer is generated, the utilized amount
increases when an order is booked and the earned amount increases after the order is
shipped. For Scan Data and Accrual offers, the paid amount increases after claims are
closed. For Off-Invoice offer, the paid amount increases after an invoice is generated for
that order. In this flow, liabilities are earnings that are tracked based on the offer types.

In the Existing Inventory scenario, accruals are created that can be paid upon completion
of the sale.

In the New Inventory scenario:

*  When a request is approved with Accrual offers, utilizations are created after orders
are placed and become available for payments once they are shipped.

*  When a request is approved with Off-invoice offers, liabilities are not tracked as the
discount is taken directly off the invoice.

For more information on liabilities, see the Oracle Trade Management User Guide.

A claim is used for partner reimbursement in two special pricing scenarios:
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e When a partner is requesting special pricing on existing inventory. When a request
of this type is approved, a Scan Data offer is created and an agreement number is
generated. The partner uses the code when submitting a claim.

*  When a partner requests special pricing on new inventory and the vendor approver
indicates that the partner will need to submit a claim to receive the discount. With
an Accrual request, an Accrual offer is created and an agreement number and an
authorization code are generated. The partner uses the authorization code when
booking the order and the agreement number when when submitting a claim.

When a Scan Data or an Accrual special pricing request is approved, a claim is
automatically generated in Trade Management. A default claim (which is called Claims)
is available in Trade Management as a custom setup.

The default claim specifies that a number of items will be included in the claim

form, including team information, notes, and request history. An organization can also
create customized claim, if required. Creating a custom claim provides the following
benefits:

e Since all claims that use the default custom setup have the same prefix, identifying
the type of partner request a claim is associated with could become difficult. Creating
a customer claim allows you to set up a new prefix that can be used to easily identify
special pricing claims.

e Allows you to set up a different approval routing process for different types of
claims. The default claim does not implement a claims approval process.

e Allows you to set up a different claim validation process.

Refer to the Oracle Trade Management Implementation Guide for additional information.

Trade Profiles

Trade Profiles allow defaulting of payment methods, vendor and vendor site mapping
for a partner and batch level, line level threshold limits for error margins of special
pricing claims submitted through the Indirect Sales Management module. Trade profiles
are setup from Oracle Trade Management User > Administration > Trade Management >
Customer > Trade Profile.

For more information, see Oracle Trade Management Implementation Guide.

Setting up Special Pricing Product Security

A vendor might want to limit the products or product categories for which partners can
request special pricing. By default, all products are enabled for special pricing. Limiting
the products eligible for special pricing involves first enabling product security through
the OZF_SP_ENABLE_PRODUCT_SECURITY profile option, and then specifying
product categories for a partner from the partner’s profile tab.

Setting the OZF_SP_ENABLE_PRODUCT SECURITY Profile Option

The OZF_SP_ENABLE_PRODUCT_SECURITY profile option is set at either the Site
or the Responsibility level, where the responsibility corresponds to a business unit
or geographic entity. An organization would set the profile at the Responsibility, for
example, if it wanted to enable security for partners for one country but disable it for
partners in different country.
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If the value is set to No, partners can request special pricing for all products. If the value
is set to Yes, partners can request special pricing for products specified in the Special
Pricing Product Categories attribute only.

Specifying Product Categories for Special Pricing

The product categories that can be used for special pricing requests are specified
individually for each partner from the Profile tab on Partner Details page. The categories
that are listed come from the Product Catalog.

Creating the Special Pricing Responsibility

To make the Special Pricing link available in the Quick Links bin, a custom responsibility
must be created and this responsibility can include the special pricing function in the
menu structure.

Menus tied with the Partner Super User responsibility can be used as a reference to
create menus for custom responsibilities. For defining menus that can be used with the
Quick Links bin, see the Oracle iStore Implementation Guide.

Use this procedure to create a custom responsibility for accessing a special pricing
request, with root menu and menu exclusions.

Navigation

Log into Oracle Forms as the system administrator and navigate to Security >
Responsibility > Define.

Prerequisites
None.

Notes
* Responsibility Name: Partner Special Pricing

e Application: Partner Relationship Management
* Responsibility Key: PV_SPECIALPRICE

e Description: Responsibility for Special Pricing
¢ Name: Standard

e Application: Partner Relationship Management
¢ Menu: Root menu name

¢ Submenu: OZF_SPECIAL_PRICE_OTHER

Creating the Special Pricing Benefit

Special pricing is made available to partners as a benefit of partner program
membership. A special pricing benefit is created by the channel administrator as a
benefit of the type Other.

A channel manager can assign the Special Pricing benefit to a partner
program. Subsequently, the channel administrator maps the program with the Special
Pricing responsibility, which provides the partner users access to special pricing pages.
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Setting up Approvals

Special pricing requests are subject to an approvals process. When a partner user submits
a special pricing request, it is routed to an approver, who is a vendor user. The approver
can approve or reject the request. The special pricing approvals process is set up and
managed through the Oracle Approvals Management application.

The seeded transaction for special pricing approval is OZF Special Pricing

Request. Numerous attributes have been defined for the transaction. A default special
pricing approver can be identified using the OZF: Default Special Pricing Request
Approver profile option. For more information on setting up approvals for special

pricing, refer to Creating Approval Rules in Oracle Approvals Manager, page 3-2.

Setting Up Notifications

Notification messages are sent to vendor and partner users in response to a number
of special pricing request status changes. Notification messages for special pricing are
created and stored in the Oracle Workflow Builder application. An organization be
able to implement the notifications that have been seeded for special pricing without
modification. However, if you need to make changes to the seeded notifications, such
as changing the message text, adding URLs to messages, or even creating additional
notifications, you will need access to Oracle Workflow Builder version 2.6.2 and the
Oracle 9i database.

In Workflow Builder, the item type for special pricing notifications is OZFSPBEN. The
following table lists the notifications seeded for special pricing, and lists the types of
users that are eligible for each notification and the special pricing request status that is
applicable for the notification.

Seeded Notifications for Special Pricing

Notification Name User SP Request Status

Request Created - Channel Channel Manager Draft
Manager Notification

Request Submitted - Partner =~ Partner Contact, Special Pending Approval
Notification Pricing Super User
Request Submitted - Vendor =~ Vendor Channel Manager, Pending Approval
Notification Vendor Approvers, Special

Pricing Super User
Request Approved - Partner Partner Contact, Special Approved
Notification Pricing Super User
Request Returned - Partner Partner Contact, Special -
Notification Pricing Super User

Request Cancelled - Partner Partner Contact, Special -

Notification Pricing Super User
Request Declined - Partner Partner Contact, Special Declined
Notification Pricing Super User
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The following table lists special pricing statuses and the corresponding special pricing
code.

Special Pricing Request Statuses

Status Code

Draft DRAFT

Pending Approval SUBMITTED_FOR_APPROVAL
Approved APPROVED

Declined DECLINED

Closed CLOSED

Selecting Notification Messages for Special Pricing Requests

The notification messages listed in the Seeded Notifications for Special Pricing are
available for use with special pricing requests, but are not enabled by default. The
channel administrator is responsible for selecting which of the seeded, as well as any
additional custom notifications created by the vendor, will be used by the vendor.

Navigation

Log in as the channel administrator and select Special Pricing Notifications. Then, click
Add Another Row.

Prerequisites
None

Notes

* Any combination of special pricing request status, user type, and notification
message can be created. Use the Seeded Notifications for Special Pricing table as
a guide to make sure that you have associated notifications, users, and special
pricing statuses appropriately.

Setting up Data Quality Management (DQM)

DQM is a tool from the Oracle Trading Community Architecture (TCA) group that is used
to check for potential duplicate customers or contacts for a given customer or contact.

When a special pricing request is created, the end-customer name and reseller entered
can be matched to an existing record in TCA.

If a duplicate record exists, the approver selects the existing end customer or partner
record, and the system links the selected record with the special pricing request. If the
system finds an exact match with one and only one party, then the system automatically
links the selected record with the special pricing request. If a duplicate record does not
exist, the approver creates a new end customer or partner record.

Users with the permission OZF_SPECIAL_PRICE_DQM and OZF_SPECIAL_PRICE_
SUPERUSER can identify DQM approvers. Any user with this permission and with
access to the special pricing function can look up requests that need party matching
from the entire request list by filtering requests. In the Create View page, add the
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Customer Data Merged column in the search query to filter data and view requests for
which DQM is required to be run.

For more information on setting up matching with DQM, refer to Setting up Matching
Rules with Oracle Data Quality Management, page BH10. []

Setting up Notes

Notes can be created for a special pricing request. By default, all note types that are not
specifically associated with another business object are available for with special pricing

notes. A vendor can create a note type for special pricing limit the note types choices that
are available for a special pricing request.

For more information about setting up notes and note types, refer to Setting up Notes,
page 3-13. il

User Security

Two permissions are associated with special pricing. The permissions can be assigned
to an existing role, or a new permissions-based role can be created and assigned to
selected special pricing users.

* OZF_SPECIAL_PRICE_SUPERUSER: Vendor users with this permission can
view, update, approve and have DQM access to all requests. Partner users with this
permission can view and update all requests made by their organization.

e OZF_SPECIAL_PRICE_DQM: Vendor users with this permission can match a party
record to a master TCA record or create a new party record. Anyone with this
permission can see the DQM flag in the Personalize screen and select records where
DQM has not been run and then select an existing or create a new record.

OAM Transaction Types and Attributes

The transaction type for special pricing is seeded and the value is OZF: Special Pricing
Request.

The following mandatory attributes are seeded.

e ALLOW_DELETING_RULE_GENERATED_APPROVERS

e ALLOW_REQUESTOR_APPROVAL

e AT _LEAST _ONE_RULE_MUST_APPLY

e EVALUATE_PRIORITIES_PER_LINE_ITEM

Special Pricing Management has header and line level attributes.

The following table describes the header attributes.
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Header Attributes

Attribute

Description

Requiring Approval Types

ALLOW_EMPTY_AP
PROVAL_GROUPS

CURRENCY_CODE

END_CUSTOMER _
COUNTRY

END_CUSTOMER_NAME

IS_VAD

MEMBERSHIP_TYPE
PARTNER_COUNTRY
PARTNER_INDUSTRY
PARTNER_LEVEL
PARTNER_NAME
PARTNER_TYPE
REQUESTED_AMOUNT
REQUEST_TYPE_CODE

SHIP_FROM_STOCK

Whether to allow approval
groups not to have members.

Currency Code

End Customer Country

End Customer Name

To find whether the partner is
a distributor

Partner Membership Type
Partner Country

Partner Industry

Partner Level

Partner Name

Partner type

Total Discount Amount
Discount Type

Ship From Stock

approval-group chain of
authority, post-chain-of-
authority approvals, pre-
chain-of-authority approvals

None

None

None

None

None
None
None
None
None
None
None
None

None

The following table describes the line level attributes.

Line Level Attributes

Attribute

Description

Requiring Approval Types

DISCOUNT_AMOUNT
DISCOUNT_TYPE
PRODUCT
REQUESTED_QUANTITY

REQUESTED_UOM

Requested Discount Amount
Discount Type

Product

Requested Quantity

Requested UOM

None

None

None

None

None
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Interactions

Interactions are logged whenever the status changes for a special pricing request.

The following table provides information on seeded interaction messages that would be
logged for the corresponding status changes.

Interaction Messages

Message Name Status Logged
OZF_SP_PENDING_LOG Pending Approval
OZF_SP_REJECTED_LOG Declined
OZF_SP_APPROVED_LOG Approved
OZF_SP_CLOSED_LOG Closed
OZF_SP_DRAFT_LOG Draft

Profile Options

Lookups

There are certain system profile options that must be set for special pricing to function
properly. In addition to the profile options mentioned in this chapter, there are additional
profile options that may need to be set. Refer to Appendix A, “System Profile Options”,
page |AHI for a compléte/list of profile options for special pricing.

There are some Lookups that can be modified for special pricing. Refer to Appendix
B, “Lookups”, page BH1 for informatigh about Lookups related to special pricing.

Concurrent Programs

There are several concurrent programs that need to be run periodically for special

pricing. Refer to Appendix C, “Summary of Concurrent Programs”, page [CH1 for

information about setting up and running the programs.
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Overview

Setting Up Partner Funds Management

This chapter covers the following topics:

e  Overview |

Setting up Partner Fund Budget Categories and Budgets
Offers |

Claims |

Trade Profiles | \

Creating a Budget Approval [Process ||

Setting Performance Objectives

Setting up Return and Decline Options

Geography \

Setting Up Partner Fund Benefits

Setting up Approvals

Setting Up Notifications

Setting up Notes

User Security |
OAM Transaction Types and Attributes
Profile Options | |

Lookups |

Concurrent [Programs \

Partner Funds Management enables partners to submit and check the status of fund
requests and claims online. Partners can request funds for specific marketing activities
that are intended to increase sales of the vendor’s products.

When a partner submits a fund request, it gets routed to the appropriate

approver(s). Approvers are notified of the request and they review, approve, decline, or
return the request. The approver can return the request asking the partner to provide
additional information. After the partner resubmits the request and the request is
approved, it executes the marketing activity and, subsequently, submits a claim to
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redeem money from the vendor. When the partner submits a claim, it is routed to
the claim approver who then validates the claim. When the claim gets approved, the
vendor pays the amount.

Partner and vendor users receive notifications about the fund request activity and can
navigate directly from the notification into the associated fund request. Notifications are
configured by the vendor and sent when the status changes, for example, when one of
the fund requests is approved.

Partners can access a summary list of all the fund requests that they have access to in
the system. They can build personal views to quickly find the fund requests that they
are most interested in.

Setting up partner funds involves creating budgets, budget categories, activities, and
media in Oracle Trade Management. Additional Oracle Trade Management set ups
include creating a custom claim and budget approval rules. Other partner fund set ups
include creating fund approval rules, notifications, and geographic criteria.

Tracking Financial Liability

Each budget has five kinds of budgeted amounts. They are Planned, Committed,
Utilized, Earned and Paid. The planned amount increases when a request is made
on that budget. When the budget request is approved, the committed amount
increases. The utilized and earned amounts increase when the offer is approved. The
paid amount increases after claims are closed. In this flow, liabilities are earnings that
are tracked at the expense lines.

Setting up Partner Fund Budget Categories and Budgets

Partner funds are intended for marketing campaigns. The channel administrator
must set up budgets and budget categories to fund marketing activities. Budgets

and their related items are set up and managed in the Oracle Trade Management
Application. When a budget is created for marketing purposes, activities and media
items must be associated with the budget. An activity is a marketing activity, such as a
mass mailing or an advertisement in a trade publication. A media item is a component
of an activity; for example, a mass mailing activity might include media items such as
postage, design, and printing.

Activities are associated with budget categories. When a partner funds budget is
created, it is associated with a budget category, which automatically associates activities
and their corresponding media items with the partner funds budget. Liability is then
tracked at the media item level for the budget, and partners must report their expenses
at the media item level when requesting compensation for marketing activities.

This section provides basic procedures for setting up media items, activities, budget
categories, and budgets. For more information, refer to the Oracle Trade Management
Implementation guide.

Creating a Marketing Media Item

Use this procedure to create marketing media items.

Navigation
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Log on to Oracle Trade Management with the Oracle Trade Management User
responsibility, and then navigate to Administration > Trade Management > Marketing
Medium > Create. The Marketing Medium page appears.

Prerequisites
None

Notes

*  Activity: Select an activity with which to associate the marketing medium. If a media
item is associated with an activity, it is available for that activity only. Otherwise, a
media item can be associated with any activity.

* Preferred Vendor: Allows the vendor to identify an organization that it prefers to
use to create a particular type of medium. Examples of preferred vendors include a
preferred printer or a preferred design firm.

Creating a Marketing Activity

Use this procedure to create a marketing activity.
Navigation

Log on to Oracle Trade Management with the Oracle Trade Management User
responsibility, and then navigate to Administration > Trade Management > Activity >
Create and then click Create. The Create Activity page appears.

Prerequisites
None

Notes
* Active: Select to enable the activity for use with a budget category.

* Marketing Media: Select the marketing media to be associated with the activity.

Creating a Budget Category

Use this procedure to create a budget category.
Navigation

Log on to Oracle Trade Management with the Oracle Trade Management User
responsibility, and then navigate to Administration > Trade Management > Category >
Create and then click Create. The Create Category page appears.

Prerequisites
None.

Notes:
¢ Created for: Select Budget. The Activity list appears.

¢ Enabled: Select to make the budget category active.

* Sales/Expense/Charge Account: Use the lookup to select an Oracle General Ledger
account for tracking purposes.

* Accrual Liability Account: Use the lookup to select Oracle General Ledger account
for liability tracking.

* Activity: Use the search to add an activity to the budget category.
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Creating a Budget

Budgets for partner funds can be either fixed or accrual budgets:

Fixed Budget: A fixed budget contains a specific amount of funds. A fixed
budget allows the vendor to track the amount of funds that have been
committed, used, earned, and paid for the budget. Companies generally use fixed
budgets for Marketing Development Funds (MDF) budgets. Companies generally
create MDF budgets in which they plan to spend a certain amount of channel
marketing dollars in a particular time frame (for example, a quarter or a year).

Accrual Budget: An accrual budget starts with zero funds. The budget is then built
up based on actual partner sales. For example, $100 is added to the budget each
time a partner sells 10 units of a specified product. Companies generally use accrual
budgets for co-op budgets, Co-op budgets are used to offer partners a percentage
of their sales revenue via channel marketing funds.

There are two types of accrued budgets:

e Accrue funds for customers: Money is accrued by a partner over a period of
time. The partner can later request some or all of the funds by submitting
a claim or short paying an invoice.

® Accrue funds for sales: Money is accrued by partner over time. A sales
representative can request some or all of the funds to support marketing
activities or to reward a partner.

Setting up a Fixed Budget

Use this procedure to set up a fixed budget for partner funds.

Navigation

Log on to the Trade Management application with the Oracle Trade Management
User responsibility, and navigate to Budget > Create, and then click Create to display
the Create Budget page.

Prerequisites

A budget category for partner or marketing funds should be available. Activities and
marketing media should be associated with the category.

Notes

Setup Type: Select Fixed Budget.
Category: Select the appropriate category for the partner funds budget.

Owner: By default, the owner is the user creating the budget. A different owner
can be specified.

Refer to the Oracle Trade Management Implementation guide for information on other
fields, if necessary.

Setting up an Accrual Budget
Use this procedure to set up an accrual budget for partner funds.

Navigation

Log on to the Trade Management application with the Oracle Trade Management
User responsibility, and navigate to Budget > Create, and then click Create to display
the Create Budget page.
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Offers

Claims

Prerequisites

A budget category for partner or marketing funds should be available. Activities and
marketing media should be associated with the category.

Notes

* Setup Type: Accrual Budget.

* Category: Select the appropriate category for the partner funds budget.

* Budget Amount: For an accrual budget, the amount should be zero.

* Holdback Amount: For an accrual budget, the amount should be zero.

* Owner: By default, the owner is the person creating the budget. Use the search
to specify a different owner.

e Accrue To: Select Customer or Sales

e Accrual Basis: Select Accrual Per Order or Cumulative Order Volume.
¢ Discount Level: Select Line

¢ Liability Flag: Deselect if the budget is an Accrue to Customer.

When you click Create, the Budget Detail page appears. From this page, you can specify
accounting information (from the General Ledger application), including an accrual
liability account and a sales/expense/charge account.

Click Request Approval to begin the budget approval process.

When a partner fund request is approved, an offer is created in Trade

Management. Partner funds uses the seeded custom setup Soft Fund - Lumpsum offer
for partner funds. When a partner’s fund request is approved, a lump sum offer
based on this custom setup is created automatically. The offer is used to track funds
committed for the fund request.

By default, the Budget Approval process has been disabled for the Soft Fund - Lumpsum
offer. Depending on business requirements, budget approval can be enabled for the
offer, and then the vendor can set up an approval process for soft fund budgets.

It is not recommended that you create additional offers for partner funds.

A default claim (which is called Claims) is available in Trade Management as a custom
setup. This default claim is used for all flows that require a party (for example, a partner)
submit a claim to be reimbursed for an marketing activity or other situation.

When a partner fund request is approved, a Soft Fund - Lumpsum offer is created. The
offer creates an authorization code. When a partner user submits a claim for
reimbursement for marketing activities, she must include the authorization code on the
claim to link the claim with the offer and the approved funding request.

The default claim specifies that a number of items will be included in the claim

form, including team information, notes, and request history. An organization can also
create customized claim, if required. Creating a custom claim provides the following
benefits:
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e Since all claims that use the default custom setup have the same prefix, identifying
the type of partner request a claim is associated with could become difficult. Creating
a customer claim allows you to set up a new prefix that can be used to easily identify
partner fund claims.

e Allows you to set up a different approval routing process for different types of
claims. The default claim does not implement a claims approval process.

* Set up a different claim validation process.

Refer to the Oracle Trade Management Implementation Guide for additional information on
creating custom claims.

Trade Profiles

Trade Profiles allow defaulting of payment methods, vendor and vendor site mapping
for a partner. Trade profiles are setup from Oracle Trade Management User >
Administration > Trade Management > Customer > Trade Profile.

For more information, see the Oracle Trade Management Implementation Guide.

Creating a Budget Approval Process

Depending on an organization’s business requirements, a separate approval process can
be created for the allocation of budget funds associated with a partner fund request. The
budget approval process is set up in Oracle Trade Management, and is initiated when a
Soft Fund - Lumpsum offer is created upon the approval of a partner fund request. Note
that the budget approval process is a separate process from the partner fund request
approval process, which is set up and administrated from the Oracle Approvals
Manager application.

In the background, the concurrent program AMS Marketing Generic Approval runs to
manage the approval workflow set up in this procedure.

Navigation

Log in to Oracle Trade Management with the Oracle Trade Management User
responsibility, and navigate to Administration > Trade Management > Approval
Rule, and then click Create to display the Approval Rule Details page.

Prerequisites
Before creating a budget approval process, make sure that:
¢ Budget Approval is enabled for the Soft Fund - Lumpsum custom setup.

¢ The appropriate budget approver Role Types and Roles have been created as part of
the Oracle Trade Management implementation process.

Notes
* Approval Rule For: Select Budget Request.

* Budget Category: Optionally, a budget approval process can be associated with a
budget category.

¢ Minimum Amount: Depending on business requirements, budget approval might
be required for requests that are over a certain amount. Either enter a minimum
amount here, or enter zero if all budget requests must be approved.
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e Approvers: The approvers list appears after the Create button is clicked. Add one or
more approvers to the list. We recommend that you select approvers of type User.

Setting Performance Objectives

A performance objective is the expected outcome for a marketing activity. Performance
objectives appear on a fund request and its related claim(s). When a partner user submits
a fund request, he is required to indicate the performance that is expected as a result of
the marketing activities for which he is requesting fundin., Then, when the user submits a
claim for the funding, he must indicate the actual performance for the marketing activity.

Performance objectives appear in a drop-down list, which is populated from a
Lookup. The performance objectives Leads and Revenues are seeded; the channel
administrator can add additional objectives as well.

Performance objectives are set up from the Oracle Trade Management
Administration application. The lookup that is used for performance objectives is
OZF_PARTNER_PERFORMANCE.

Setting up Return and Decline Options

Geography

When a fund request approver either returns a request to a partner or declines a request
outright, he must provide a reason. Return and decline reasons appear in drop-down
lists that are populated by Lookups. Return and decline reasons are set up from the
Oracle Trade Management Administration application.

The Lookup OZF_SF_DECLINE_CODE provides decline reasons. The following values
are seeded for the Lookup:

* COLLATERAL: The collateral submitted with the request did not meet the vendor’s
criteria.

e DUPLICATE: The request is a duplicate.
¢ INVALID: The request is invalid.

The Lookup OZF_SF_RETURN_CODE provides return reasons. The following values
are seeded for the Lookup:

* COLLATERAL: The collateral submitted with the request did not meet the vendor’s
criteria.

¢ OTHER: The request was returned for another reason.

¢ MISS_INFO: The request is missing information.

For partner funds, geography provides informational data. Geography is set up
in Oracle Marketing by an user with the administrator responsibility. Up to eight
geographic levels can be specified.

Geography may already be set up for your implementation, since geography is used
in Partner Programs as well as in Oracle Marketing. However, if you need to set up
geographic information, refer to the Oracle Marketing Implementation and Administration
Guide for further details.
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Setting Up Partner Fund Benefits

The ability to request funding for marketing activities is made available to partners as a
benefit of partner program membership. A partner funds benefit is created by the
channel administrator as a benefit of the type Soft Funds.

A channel manager can assign the partner funds benefit to a partner
program. Subsequently, the channel administrator maps the program with a partner
responsibility, which provides the partner users access to fund request and management

pages.

Use this procedure to set up a partner fund benefit.

Navigation

Log in as the channel administrator and navigate to Programs > Benefits.

Prerequisites

A budget must be set up for partner funds.

Steps:

1. Select Soft Fund from the Create Benefits drop-down list and click Go.
The Create Benefit: Soft Fund page appears.

2. In the Budget region, select the budget that will be used to fund partner
requests. More than one budget can be used to fund the benefit.

3. In the Notifications region, select the notification messages to be used for this benefit.

Setting up Approvals

Partner fund requests are subject to an approvals process. When a partner user submits a
funding request, it is routed to an approver, who is a vendor user. The approver can
approve or reject the request. The partner fund approvals process is set up and managed
through the Oracle Approvals Management application.

The seeded transaction for partner fund approvals is OZF Soft Fund Request. Numerous
attributes have been defined for the transaction. A default fund request approver can be
identified using the OZF: Default Soft Fund Request Approver profile option. For more
information on setting up approvals for partner funds, refer to Creating Approval Rules
in Oracle Approvals Manager, page [3-2. I

Setting Up Notifications

Notification messages are sent to vendor and partner users in response to a number of
partner fund request status changes. Notification messages for partner fund request are
created and stored in the Oracle Workflow Builder application. An organization might
be able to implement the notifications that have been seeded for partner funds without
modification. However, if you need to make changes to the seeded notifications, such
as changing the message text, adding URLs to messages, or even creating additional
notifications, you will need access to Oracle Workflow Builder version 2.6.2 and the
Oracle 9i database.

In Workflow Builder, the item type for partner fund notifications is OZFSFBEN. The
following table lists the notifications seeded for partner funds and lists the types of
users that are eligible for each notification and the partner fund request status that is
applicable for the notification.
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Notifications for Partner Funds

Notification Name User Partner Fund Request
Status
Request Created — Channel Channel Manager Draft
Manager Notification
Request Submitted — Partner Partner Contact, Soft Fund Pending Approval
Notification Super User
Request Submitted — Vendor ~ Vendor Channel Manager, Pending Approval
Notification Vendor Approvers, Soft Fund
Super User
Request Approved — Partner Partner Contact, Soft Fund Approved
Notification Super User
Request Returned — Partner Partner Contact, Soft Fund Returned
Notification Super User
Request Cancelled — Partner Partner Contact, Soft Fund Void
Notification Super User
Request Declined — Partner Partner Contact, Soft Fund Declined

Notification

Super User

The following table lists fund request statuses and the corresponding fund request code.

Fund Request Statuses

Status Code

Draft DRAFT

Pending Approval SUBMITTED_FOR_APPROVAL
Returned RETURNED

Approved APPROVED

Declined DECLINED

Closed CLOSED

Void VOID

Setting up Notes

Notes can be created for a partner fund request. By default, all note types that are

not specifically associated with another business object are available for partner fund
notes. A vendor can create a note type for partner fund requests limit the note types
choices that are available for a request.

Setting Up Partner Funds Management
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For more information about setting up notes and note types, refer to Setting up Notes,
page BH13.

User Security

The OZF_SOFT_FUND_SUPERUSER permission provides vendor and partner users
with super user privileges for partner fund requests. Vendor users with this permission
can view, update and approve all requests. Partner users with this permission can view
and update all requests made by their organization.

OAM Transaction Types and Attributes

The transaction type for fund requests is seeded and the value is OZF: Soft Fund Request.
The following mandatory attributes are seeded.

* ALLOW_DELETING_RULE_GENERATED_APPROVERS

e ALLOW_REQUESTOR_APPROVAL

* AT _LEAST ONE_RULE_MUST_APPLY

* EVALUATE_PRIORITIES_PER_LINE_ITEM

e USE_RESTRICTIVE_LINE_ITEM_EVALUATION

Partner Funds Management has header and line level attributes.

The following table describes the header attributes.

14-10 Oracle Partner Management Implementation Guide



Interactions

Header Attributes

Attribute

Description

Requiring Approval Types

ALLOW_EMPTY_AP
PROVAL_GROUPS

CURRENCY_CODE

IS_VAD

MEMBERSHIP_TYPE
PARTNER_AMOUNT
PARTNER_COUNTRY
PARTNER_INDUSTRY
PARTNER_LEVEL
PARTNER_NAME
PARTNER_TYPE
REQUESTED_AMOUNT
SOFT_FUND_BENEFIT
TOTAL_AMOUNT

ACTIVITY

Whether to allow approval
groups not to have members.

Currency Code

To find whether the partner is
a distributor

Partner Membership Type
Partner Amount

Partner Country

Partner Industry

Partner Level

Partner Name

Partner Type

Requested Amount

Soft Fund Benefit

Total Amount

Activity

approval-group chain of
authority, post-chain-of-
authority approvals, pre-
chain-of-authority approvals

None

None

None
None
None
None
None
None
None
None
None
None

None

The following table describes the line level attributes.

Line Level Attributes

Attribute Description Requiring Approval Types
PRODUCT Product None
GEOGRAPHY Geography None
PERFORMANCE OBJECT Performance Objectives None

IVES

Interactions are logged whenever status changes for a fund request.

The following table provides information on seeded interaction messages that would be
logged on the corresponding status changes.
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Interaction Messages

Message Name Status Logged
OZF_SF_PENDING_LOG Pending Approval
OZF_SF_REJECTED_LOG Declined
OZF_SF_APPROVED_LOG Approved
OZF_SF_RETURNED_LOG Returned
OZF_SF_CLOSED_LOG Closed
OZF_SF_DRAFT_LOG Draft

Profile Options

There are certain system profile options that must be set for partner fund requests to
function properly. In addition to the profile options mentioned in this chapter, there are
additional profile options that may need to be set. Refer to Appendix A, “System Profile
Options”, page |AHI for a complete list of profile options for partner funds.

Lookups

There are some Lookups that can be modified for partner funds. Refer to Appendix
B, “Lookups", page [BH1 for informatidn about Lookups related to partner funds.

Concurrent Programs

There are several concurrent programs that need to be run periodically for partner

funds. Refer to Appendix C, “Summary of Concurrent Programs”, page /CH1 for
information about setting up and running the programs.
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Overview

Setting up the Partner Locator

This chapter covers the following topics:

e  Overview |

Defining a Hyperlink for the Locator
Enabling Partner [Profile Attributds|for Advanced Search

Setting Profile Options

Running Concutrent Programs

The Partner Locator allows a potential customer to search for partners, resellers, and
value-added resellers (VADs) that are registered with your organization through Oracle
Partner Management. Partner Locator integrates with your organization’s Web portal, so
you can make it available to your partners’ potential customers independent of the
Partner Dashboard or Oracle Partner Management.

Partner Locator identifies partners that are located a certain distance from a customer’s
starting address. The search distance is determined by the vendor, and is set through
two profile options:

e PV: Locator Distance: Specifies the distance within which the Partner Locator
will search for partners

e PV:Locator Default Distance Unit: Specifies the unit of measure (for example, miles
or kilometers) used for the distance specified in the PV: Locator Distance option

For each partner match identified, the Partner Locator returns the partner’s street, web
address, and phone number. The Partner Locator also provides a map showing the
partner’s location and driving directions from the customer’s starting address to the
partner’s address.

The Partner Locator performs an address confirmation check on the starting address
entered by the customer. If the Partner Locator is unable to find an exact match, the
customer is asked to select an address from a list of potential addresses or locations.

The Partner Locator also provides an advanced search tool to further help potential
customers find the right partner. Refer to “Enabling Partner Profile Attributes for
Advanced Search” for additional information.
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Defining a Hyperlink for the Locator

To make the Partner Locator available through a portal, a hyperlink needs to be
added to the portal. The hyperlink should point to the machine where Oracle Partner
Management is installed and the URL should look similar to the following:

http://<server_address><: server_port if any>/OA_HTML/ pvxLoctrSea
rch.jsp

Enabling Partner Profile Attributes for Advanced Search

The Partner Locator provides potential customers with an advanced search tool that they
can use to locate partners that meet certain criteria. The criteria that are available for the
advanced search map to partner profile attributes. An attribute is available for use in the
Partner Locator advanced search if it is active and if it has been enabled for the Locator.

For more information on partner profile attributes, refer to Setting up Partner Profile
Attributes, page |AHL. | ]

Setting Profile Options

There are certain system profile options that must be set for the Partner Locator. For
the profile options for Partner Locator, refer to Appendix A, “System Profile Options",
page |A-l. I

Running Concurrent Programs

Certain concurrent programs must be run to set up and maintain the Partner Locator. For
a list of the concurrent programs for the Partner Locator, refer to Appendix C, “Summary
of Concurrent Programs", page (CHI. \

15-2 Oracle Partner Management Implementation Guide



16

Oracle Sales Integration

This chapter covers the following topics:

e  Overview |

* [Enabling Businéss Events

* Modifying the Assignment Routing Stage Lookup

* Modifying the Assignment Type Lookup
* Modifying Menlis

* Migrating Exterhal Sales Team Data

* [Personalizing Oracle Sales Pages

Overview

Oracle Partner Management can be integrated with Oracle Sales to improve an
organization’s ability to manage indirect sales opportunities. The procedures described
in this chapter must be performed by an organization when integrating Oracle Partner
Management with Oracle Sales. (Specifically, these procedures apply to integrations
with Oracle Sales Patchset B. If you are integrating with Oracle Sales Online or Oracle
Field Sales, these procedures are not required.)

Before performing the procedures in this chapter, it is recommended that you have
reviewed the Read Me file or About document provided with the release, and have
performed any software and patch installations described in those documents.

Enabling Business Events

Two Oracle Sales business events and their subscriptions need to be enabled: opportunity
post-create and opportunity pre-update. To enable business events, log in to the Oracle
Workflow application with the Workflow Administrator Web Applications responsibility
and navigate to Workflow > Find Events/Event Groups.

Notes:

e Enable the event oracle.apps.asn.opportunity.postcreate (the
opportunity post-create event). Then, enable the event subscription
oracle.apps.pv.oa.opportunity.util.server.PVCreatOppSub.

e Enable the event oracle.apps.asn.opportunity.preupdate (the
opportunity pre-update event). Then, enable the event subscription
oracle.apps.pv.oa.opportunity.util.server.PvUpdateOppSub.
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Modifying the Assignment Routing Stage Lookup

Modifications need to be made to two of the codes in the Assignment Routing Stage
Lookup (Lookup type PV_ROUTING_STAGE). To modify the Lookup, log on to Oracle
Forms with the Application Developer responsibility, and navigate to Application >
Lookups > Common.

Notes
e Make the following changes to the PV_ROUTING_STAGE Lookup:

¢ Change the Meaning field for the lookup code ACTIVE from Active to
Completed.

¢ Change the Meaning field for the lookup code MATCHED from Matched to
Pending Approval.

Modifying the Assignment Type Lookup

Modifications need to be made to codes in the Assignment Type Lookup (Lookup
type PV_ASSIGNMENT_TYPE). To modify the Lookup, log on to Oracle Forms with
the Application Developer responsibility, and navigate to Application > Lookups

> Common.

Notes
e Make the following changes to the PV_ASSIGNMENT_TYPE Lookup:

e Change the Meaning and the Description fields for the lookup code
BROADCAST from Multiple - Parallel to First Come First Serve.

¢ Change the Meaning and the Description fields for the lookup code SERIAL
from Multiple - Serial to Single - Serial.

Modifying Menus
Modifications need to be made to menus in both Oracle Partner Management and
Oracle Sales. In addition, a submenu needs to be removed from the Channel Manager

responsibility. To modify menus, log on to Oracle Forms with the System Administrator
responsibility, and navigate to Application > Menu.

Steps:
1. Add Oracle Sales submenus to Oracle Partner Management menus:

1. Add ASN_OTHER_MENU as a submenu to PV_OPPORTUNITY_OTHER

2. Add ASN_OTHER_MENU as a submenu to PV_PARTNER_OPPORTUNITY_
OTHER

2. Add PV_ASN_MENU_OTHER as a submenu of ASN_OTHER_MENU.

3. Remove the Opportunity prompt from the PV_OPPORTUNITIES function under the
PV_OPPORTUNITIES menu.

4. Remove the ASF_OPPORTUNITY_REPORTS submenu from the
PV_OPPORTUNITIES menu.

5. Remove the row containing the Opportunity Reports prompt from the
PV_PARTNER_SUPER_USR_OPPTY menu.
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6. Navigate to Security > Responsibility > Define, and display the Channel Manager
responsibility.

7. Exclude the ASF_TRANS_FORWD function from the Channel Manager
responsibility.

8. Navigate to Security > Responsibility > Define, and display the Partner Super
User responsibility.

9. Exclude the ASF_TRANS_FORWD function from the Partner Super User
responsibility.

Migrating External Sales Team Data

Earlier implementations of Oracle Partner Management allowed a partner contact to
exist on an opportunity, a lead, and a customer sales team after the partner organization
was removed from the opportunity, lead, or sales team. As of Patchset B, a partner
contact is accessed through the partner organization, and thus a contact can not be
accessed if the partner organization has been removed.

The concurrent program PV - External Sales Team migration should be run to make sure
that partner organizations are reassociated with opportunities, leads, and customer
sales teams if the partner contacts are still associated with the objects after the partner
organization has been removed. The concurrent program should be run during the
upgrade process (that is, during an upgrade that implements Patchset B) and as part

of the Oracle Sales and Oracle Partner Management integration process, and then
periodically afterwards. For more information about the concurrent program, refer to
"Appendix C, Summary of Concurrent Programs", page CH. I

Personalizing Oracle Sales Pages

Some personalizations need to be made to Oracle Sales opportunity pages to enable
integration with Oracle Partner Management. The personalizations primarily involve
enabling features that are used by an indirect sales organization, for example adding a
Partners subtab to the Update Opportunity page and adding a Partners region to the
Sales Team.

All the personalizations listed in this section are performed at the Responsibility
level. Depending on business requirements, an organization might choose to enable
partner-specific items for Oracle Partner Management-related responsibilities

only. Other organizations might choose to enable the items for Oracle Sales users as
well. The personalizations for vendor users of Oracle Partner Management and Oracle
Sales are the same. Some different personalizations are required for partner users.

Personalizations for Vendor User Responsibilities

Perform these personalizations for vendor users, that is, users who are employees of the
implementing organization. The seeded responsibilities for vendor users are:

¢ Sales User
* Sales Manager
¢ Channel Manager

Notes
* Enable the Partners tab on the Update Opportunity page.
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* Enable the Referral Code field on the Update Opportunity page.

* Enable the Partners region on the Sales Team tab on the Update Lead page.

* Enable the Partners region on the Sales Team tab on the Update Customer page.
¢ Enable the Assignment Status column on the Opportunity Search results page.

* Enable the Assignment Status column on the Opportunities page.

Personalizations for Partner User Responsibilities - Opportunities Pages

The opportunity-related pages that partner users see are the same pages that are used
by vendor users. There are some changes that must be made to these pages to make
them appropriate for use by partner users. The changes are made through use of the
Oracle Applications Personalization feature.

Perform these personalizations for partner users, that is, users who are employees of the
implementing organization’s partners. The seeded responsibilities for partner users are:

¢ Default Partner User
* Partner Super User

The personalizations will need to be performed for each additional partner responsibility
implemented.

Notes
* Enable the Abandon button on the Update Opportunity page.

* Make the Vendor Sales Team information read-only:
* Make the items in the Sales Team table read-only.
¢ Disable the Add Person button.
¢ Disable the Select radio button.
¢ Disable the Remove icon.

¢ Hide the Oracle Sales Notes and Tasks region and expose the Oracle Partner
Management Notes region.

¢ Change the name of the Notes & Tasks midtab to Notes.
* Enable the Referral Code field on the Update Opportunity page.

Personalizations for Partner User Responsibilities - End Customer pages

A vendor organization can choose to give its partners access to end-customer
information. When a vendor makes end-customer information available to its
partners, there are some flows and other items that must be disabled because they
are not currently supported by Oracle Partner Management, and these are listed in
this section. This section also provides some additional personalizations that are
recommended for successful implementation.

Perform these personalizations for partner users, that is, users who are employees of the
implementing organization’s partners. The seeded responsibilities for partner users are:

¢ Default Partner User

* Partner Super User
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The personalizations need to be performed for each additional partner responsibility
implemented.

Mandatory Customer Page Personalizations

It is mandatory that the following items be disabled because they can cause errors or
conflicts with currently supported flows within Oracle Partner Management.

Notes:

* Disable the Create Lead button. Oracle Partner Management does not support
partner creation of leads.

¢ Disable the Create Opportunity button. Oracle Partner Management does not
support partner creation of opportunities.

¢ Disable the Update Customer Details button.

The Update Customer Details button provides users with access to
additional functionality including editing customer profiles, business
relationships, classifications, and sales teams. This is information that partners
should not have access to

* Hide the Business Activities section. Business Activities are not supported for
partner flows.

* Hide the Notes section. Notes are not supported for partner flows.

¢ Hide the Tasks section. Tasks are not supported for partner flows.

Recommended Customer Page Personalizations

A vendor organization needs to consider carefully the level of access to and the
actions allowed for partner users in the Contacts, Addresses, Phone Numbers, and
Attachments sections associated with customers. The information that partner users
can see in these sections is not limited to the information created by or relevant to their
partner organizations; instead, partner users can see all contacts, addresses, and phone
numbers that are available for a customer, and can also see all attachments created by
both vendors and other partners. For each of these sections, the vendor must determine
whether or not to disable the Create, Update, and Remove or Delete buttons. The
deploying company must also determine whether or not to disable Contact Name links.
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System Profile Options

This appendix covers the following topics:

e [Before You Begih

Setting Profile Options
Profile Options fdr the Channel Manager Dashboard
Profile Options fdr Deal Registration

Profile Options fdr Enrollments
Profile Options fdr Partner Funds |

Profile Options fdr Opportunities

Profile Options fdr the Partner Dashboard
Profile Options fdr the Partner Locator
Profile Options fdr Partner Profile Attributes

Profile Options fdr Partner [Programsg \
Profile Options fdr Referral Management

Profile Options fdr Special Pricing

Before You Begin

Before making Oracle Forms settings, ensure that all Oracle Applications server
processes are up and running. In particular, if you stopped concurrent managers
before applying Oracle Applications patchsets, restart them now by changing to
$COMMON_TOP/admin/scripts , and executing adcmctl.sh<APPS username? Apps
password>start.

Setting Profile Options

Use the following procedure to set a profile option.

Prerequisites
None.
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Steps
1. Log in to Oracle Forms as a CRM Administrator and navigate to Functions >
Profile > System.

2. In the Find System Profile Values window, check the level(s) at which you want to
set the profile option. The available levels are listed below:

¢ Site: Indicates that profiles are set at the site level. This site level setting affects
the entire database.

* Application: If you select this level, choose the application from the Application
LOV for which you want to set the profile option.

* Responsibility: If you select this level, choose the responsibility from the
Responsibility LOV for which you want to set the profile option.

* User: If you select this level, choose the user from the User LOV for whom
you want to set the profile option.

3. In the Profile field, enter the profile name, such as IBE: Item Validation
Organization , or a wildcard search criterion such as IBE%.

4. Click Find.
The System Profile Values form opens with the results of your search.

5. Verify or set the profile option(s) at the levels that you selected.

Profile Options for the Channel Manager Dashboard

To implement the Channel Manager dashboard, set the profiles listed in the following
table.

Profile Options for the Channel Manager Dashboard

Profile Name Required Level Setting Description
PV New Partners Yes Site Numeric value. Used in the Key
Time Window . Metrics bin in
Application ?e;(c)ied Value the New Partners
Responsibility B statistics. The
bin shows
User

the number

of partners
registered in the
system in the last
N days, where
N is the seeded
value.
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Profile Name

Required

Level Setting

Description

PV: Inactive
Partners Time
Window

PV: Territory
Assignment
Online

PV: Batch size
for territory
assignment
processing

Yes

Yes

Yes

Site Numeric Value.

Seeded Value
=90

Application
Responsibility

User

Site Yes/No

Seeded Value
= Yes

Application
Responsibility

User

Site Numeric value

Seeded Value
= 1000

Application
Responsibility

User

Used in the Key
Metrics bin in the
Inactive Partners
statistics. The
bin displays

the number of
partners in the
system that have
not placed orders
in thelast N days,
where N is the
seeded value.

If the value is
Yes, the channel
team assignment
occurs
automatically
when a partner
is created or
updated.

If the value is No,
the channel team
is assigned when
the concurrent
program PV:
Channel Team
Assignment

for Partner

in TOTAL/
INCREMENTAL
Mode is run.

Note: If you

are importing
alarge number of
partners from

an external
system, it is
recommended
that you set the
option to No.

Calculates the
number of child
processes that
are created
when the PV:
Channel Team
Assignment

for Partner
concurrent
program is run
in TOTAL/
INCREMENTAL
mode.
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Profile Options for Deal Registration

To implement deal registration, set the profiles listed in the following table.

Profile Options for Deal Registration

Profile

Required

Level

Setting

Description

PV: Default
Indirect Channel

Type

OS: Opportunity
Access Privilege

Yes
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Application
Responsibility

Site
Responsibility

User

Name of an
indirect sales
channel

Full

This profile
option specifies
the indirect sales
channel to which
all opportunities
generated from
deal registrations
will be assigned.

This profile
drives the
behavior of
opportunity
access. This
profile is defined
within the Sales
Application but
Oracle Partner
Management
uses it to drive
access to deals.

If this profile
is set to Full,
users can view
all the deals
that have been
approved and
converted into
opportunities
or linked to
opportunities
that the users can
access.

If this profile is
set to another
value, users can
only view deal
registrations
linked to
opportunities
for which they
are on the sales
team.



Profile

Required

Level Setting

Description

PV: Default Deal
Registration
Approver

PV: Default DQM
Approver

Site A user
Application

User

- A user

Specifies a user
as the default
deal registration
request approver
if the Oracle
Approvals
Management
approval rule
does not return
an approver.

Alternatively, an
organization can
use this profile
option to specify
an approver
instead of setting
up approval
rules in Oracle
Approvals
Management.

Specifies a user
as the default
Data Quality
Management
approver

if Oracle
Approvals
Management
does not return
an approver.

Alternatively, an
organization can
use this profile
option to specify
an approver
instead of setting
up approval
rules in Oracle
Approvals
Management.
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Profile

Required

Level

Setting

Description

PV: Assign
Approvers
to lead or
opportunity

PV: Assign
Channel
Manager to sales
transactions
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Site
Application
Responsibility

Site
Application
Responsibility

Yes
No

Yes
No

When set to
Yes, the deal
registration
approvers are
automatically
added to the
sales team if the
deal registration
generates an
opportunity or
lead.

When a lead

is created, the
owner of the lead
is set to the first
approver for the
deal registration.

If the PV:
Assign Channel
Manager to sales
transactions
profile option

is also set to Yes,
the owner of the
lead is set to one
of the channel
managers for the
deal.

When set

to Yes, the
channel manager
assigned to

the partner
that submitted
the request is
added to the
sales team if the
deal registration
generates an
opportunity or
lead.

When a lead

is created, the
channel manager
also becomes
the owner of
the lead. If
multiple channel
managers are
assigned to the
partner, the
owner is selected
randomly.



Profile Required Level Setting Description
PV: DQOM Site DQM rule name  This profile
Contact Match Applicati stores the
Rules pphication Data Quality
Responsibility Management
rule that is
used to perform
contact matching
for the customer.
PV: DQM Site DQM rule name  Stores the
Customer Match Applicati Data Quality
Rules pphication Management
Responsibility rule that is
used to perform
customer
matching.
PV: Contact Site Contact Of Used to
Relationship Applicati determine the
Codes pplcation relationship of
Responsibility the contact with
the customer.
PV: iStore Login Site <hostname>: Partner Login
URL <port> URL link sent
with workflow
notification for
partner users.
PV: Self Service Site <hostname>: Vendor
URL with <port> Self Service
Workflow Applications
Notification URL sent with

a workflow
notification for
vendor users.
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Profile Required Level Setting Description
HZ: Generate Site Yes If this profile is
Party Number - set to Yes, as part
Application No of the customer
Responsibility de-duplication
User process for
deals, a new
customer and
its corresponding
party number
are created in
the system if
no match is
identified.
HZ: Generate Site Yes If this profile is
Party Site - set to Yes, as part
Number Application No of the customer
Responsibility de-duplication
User process for

deals, a new
customer and its
corresponding
party site
number are
created in

the system if
no match is

identified.
Profile Options for Enrollments
To implement enrollments, set the profiles listed in the following table.
Profile Options for Enroliments
Option Required Level Setting Description
PV: Program Yes Site Default=15 If the enrollment
Enrollment Avplication request approver
Request PP does not act upon
Reminder an enrollment
Notification request in the
Duration number of days
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specified by

this profile,

the request is
forwarded to the
default approver.



Option Required

Level

Setting

Description

PV: Default Yes
Enrollment

Request

Approver

PV: Allow Yes
Approval
Without Contract

Site
Application

Site

A user

Yes

Specifies a user
as the default
enrollment
request approver
if the Oracle
Approvals
Management
approval rule
does not return
an approver.

Alternatively, an
organization can
use this profile
option to specify
an approver
instead of setting
up approval
rules in Oracle
Approvals
Management.

Determines
whether or not a
partner program
enrollment
request can be
approved before
a signed contract
is received from
the partner.

Yes: Approval
without signed
contract is
allowed.

No: A signed
contract must be
received before
a request can be
approved.
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Option

Required

Level

Setting

Description

PV: Default
Salesperson used
for Orders

PV: Order Cancel
Reason

Yes

Yes
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Site

Site

CRM resource

Reason codes
form the

Oracle Order
Management
CANCEL_CODE
Lookup

Oracle Order
Management
requires that a
sales person be
identified for
each order. This
profile option
allows you to
specify a CRM
resource as the
sales person for
each enrollment
request order. A
sales quota will
be associated
with the person
specified; enter a
fictional resource
if a sales quota
should not

be associated
with orders
generated from
partner program
enrollments.

Provides

an order
cancellation
reason for a
partner program
enrollment
request. This
reason will
be used when
an enrollment
request is
cancelled
because:

® The partner
chose to
cancel the
request

e The
maximum
number
of credit card
authorization
requests was
exceeded

¢ The
approver
rejected the
enrollment
request



Option

Required

Level

Setting

Description

PV: Order
Transaction Type

PV: Max number
of credit card
authorization

OM: Payment
method for
Credit Card
Transactions

Yes

Optional

Yes

Site

Site

Site

Application
Responsibility

User

BILL ONLY

Default =3

Numeric value

Merchant ID

This profile

is used by
Oracle Order
Management

to specify the
order for the
partner program
enrollment is a
bill-only order
(as a partner
program is not a
shippable item).

Specifies the
number of times
that a credit card
authorization
can fail. If

the number
specified has
been exceeded,
the enrollment
request ends,
and the user

is returned to
the Partner
Dashboard. The
registration is
saved, including
the contract
information. In
addition, billing
information

is saved by
Oracle Order
Management.

This credit card
transaction
method is
used to figure
out merchant
ID from
Receivables,
which is required
when getting
credit card
authorizations
from iPayment.
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Option Required Level Setting Description
PV: Secure URL ~ Optional Site This profile If this profile
option needs to  is set, payment
be set to secure  pages use this
server and port secure (https)
that should be server and port.
used in payment Otherwise, the
pages regular port
in payment
page is used.
Example of this
profile option
value: https:
/lgapache.
us.oracle.
com:2000/0A_
HTML/
PV: Non Secure ~ Optional Site This profile If the profile is

URL
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option needs
to be set to non
secure server
and port that
should be used
after processing

payment

set, the server
and profile
mentioned is
used to switch to
a nonsecure url
once payment
has been
processed.
Otherwise, the
same port that is
used in payment
pages are used.
Example of this
profile option
value: http:
/lgapache.
us.oracle.
com:1111 /
OA_HTML/



Option Required Level Setting Description
Sequential Yes Site Always Used Specifies that
Numbering Applicati orders created
pphication in Order
Responsibility Management
are numbered
sequentially.
MO: Operating  Yes Responsibility Default Specifies the

Unit

operating unit

operating unit
against which
users place
orders. The
user can view
and purchase
items that are
in the Inventory
Organization
associated with
this operating
unit only. Set
to the default
operating unit
at the customer
responsibility
level.

Profile Options for Partner Funds

To implement partner funds, set the profiles listed in the following table.

System Profile Options
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Profiles Options for Partner Funds

Profile Option Required Level Setting Description
OZF_SF_ Optional Site Numeric value Specifies a grace
GRACE_DAYS Responsibility Default =0 period for a
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partner fund.
The system uses
the number of
days specified
in this profile
to determine
for how long
after the fund
approval date

a fund request
remains active.
Once the grace
period has
passed, the
status of the fund
request changes
to Closed,

and claim

can no longer
be submitted
against the fund
request.

Note: By default,
this profile is set
to zero, which
specifies up a
grace period of
one day. You
must change this
profile to provide
for a realistic
grace period.



Profile Option Required Level Setting Description
OZF_SF_ Optional Site List of fund Used to set up
DEFAULT_ R bilit request benefits ~ default benefit
BENEFIT esponsibrity for fund requests.
For deployments
that do not
use partner
programs, this
profile can be
used to set up
a partner fund
benefit.
OZF_SF_ Optional Site A user Specifies a user as
DEFAULT_AP Responsibilit the default fund
PROVER P y request approver

if the Oracle
Approvals
Management
approval rule
does not return
an approver.

Alternatively, an
organization can
use this profile
option to specify
an approver
instead of setting
up approval
rules in Oracle
Approvals
Management.

Profile Options for Opportunities

To implement opportunities, set the profiles listed in the following table.

System Profile Options
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Profile Options for Opportunities

Option Required Level Setting Description
PV: Partner Optional Site Default is Stop at Possible Values:
Matching Type first rule at site
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level

Exhaust all
rules - The
partner matching
engine evaluates
each rule (that
matches the
conditions
specified in the
Opportunity
Selection section
of each rule),

by order of
precedence, until
it finds a partner.
If there was a
preferred partner
specified on the
opportunity, the
evaluation stops
at the first rule
regardless of
whether the first
rule evaluated
returned any
partner.

Stop at first rule
- The partner
matching engine,
after finding a
rule that matches
the conditions
specified in the
Opportunity
Selection of

that rule, uses
only that rule in
finding partners.



Option

Required

Level

Setting

Description

PV: Enable
Full Access on
Opportunity to
Partner

PV: Filter
Partner Search
by Identifying
Address

Optional

Optional

Site

Site
Application
Responsibility

Yes

Yes
No

This profile

is used to
determine
whether partner
contacts are
added to the
opportunity
sales team
with full access
or read-only
access during
opportunity
routing.

If set to Yes, the
partner, after
accepting the
opportunity
can update the
opportunity
details.

If set to No, the
partner user

has read-only
access to the
opportunity.

In addition,

the partner can
create notes and
add attachments.

If the profile

is set to Yes,
the partner
Simple Search,
Advanced
Search, and
Generate
Partner List
return partner
identifying
addresses

only, and the
results pages
display partner
identifying
addresses only.
If the profile is
set to No, all
partner address
are returned by
the searches, and
the pages display
all partner
addresses.
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Option Required Level

Setting

Description

PV: Active Optional User
Notification Flag

PV: Bypass Yes Site
CM Approval

for Campaign

Routing

PV: Common Yes Site
Currency for
Rules Engines
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Yes

Yes

Any available
currency

User can enable
or disable
notifications
when the
partners accepts
an opportunity.

If set to Yes,

the partner
contact receives
a notification
when the routing
status changes
from Offered to
Active.

Determine
whether channel
manager
approval is
required for
partners matched
by a campaign.
This profile
option is used
along with

PV: Enable
Automatic
Routing by
Campaign. The
default value is
No.

Base currency
used for currency
comparison

in partner
matching. If
the currency
specified for the
rule is not the
same as the base
currency, it is
converted to the
base currency
and then the
comparison

is performed.
This profile is
also used by
the concurrent
program PV
Refresh Attribute
Text Table.

The default is
usD.



Option

Required

Level

Setting

Description

PV: Default Batch Optional

Assignment User

PV: Default CM
TimeOut

PV: Default
Partner TimeOut

PV: Default
Routing Type

Optional

Optional

Yes

Site

Site

Site

Site

A User

Numeric value

Numeric value

Default = Single
Multiple-Serial
Multiple-Parallel

Joint

This user is
added to the
sales team of

an opportunity
which failed to
complete the
full automated
background Lead
to Opportunity to
Routing process.

Default channel
manager timeout
in hours if not
specified at the
country level.

Sets the time
period available
to channel
managers to
review and
approve partner
matching and
selection. If the
channel manager
does not respond
in the given
time, the
default response
is Match
Approved.

Default partner

timeout in hours
if not specified at
the country level.

Sets the time
period available
to Partner
Contacts to
accept the offered
opportunity. If
no response, the
default response
is Offer Declined.

Default
assignment

type used by
the background
partner routing.
Partners default
assignment type.
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Option

Required

Level

Setting

Description

PV: Default
Unassigned
Opportunity
TimeOut

PV: Default
Vendor User
(Channel
Manager)

PV: Default for
Bypass Channel
Manager

approval
checkbox

Optional

Optional

Optional
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Site

Site
Application
Responsibility

Numeric value

Sets the time
period an
unassigned
opportunity
may have the
Unassigned
routing status.
At the expiration
of the time
period, a
concurrent
manager
program, PV
Unassigned
Opportunity
Process After
Timeout,
performs
automatic
matching and
routing.

Default channel
manager used if
none found for
partner.

Determines

the display

of the Bypass
channel manager
approval flag on
the opportunity
assignment page.

Possible Values:

Bypass CM -
Allow update

Bypass CM - No
Update Allowed

Do not Bypass
CM - Allow
Update

Do not Bypass
CM - No update
Allowed



Option

Required Level Setting

Description

PV: Display
Submit Routing
Button

PV: Enable
Automatic
Routing by
Campaign

Optional Site Yes/No
Application
Responsibility

User

Optional Responsibility Yes/No

Enable and
disable ability for
user to submit
or withdraw
assignment
routing.

When set to
Yes, a Submit
Routing button
is displayed on
the opportunity
assignment page.
This profile is
not available to
partner users.

The default is
No.

Enables
automatic
routing based
on campaigns.
When the
campaign field
is completed,
the system
adds associated
partners to the
sales team,
opportunity
routing list and
starts the routing
process. The
default is No.
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Option

Required

Level

Setting

Description

PV: Enable
Partial Matching
of Attributes

PV: Enable
Workflow to
send e-mails

PV: Enforce
Address Filters
in Partner LOV

PV: Java Class
to Restrict ORG
Access Privilege

Optional

Yes

Yes

Optional

A-22 Oracle Partner Management Implementation Guide

All

Site

Site

Site

No

Yes/No

Yes/No

Java Class
Filename

Enables the
partner matching
engine to return
partners even if
an exact match
is not found

for manual
matching. The
algorithm used
is: if no partners
are returned

for the search
conditions
specified, the
lowest ranked
condition is
dropped and the
engine performs
the search again.
This process
continues until at
least one partner
is found or all the
search conditions
are exhausted.

Enable or disable
notifications

in indirect
opportunity
management.

If set to Yes,
the partner
LOV allows to
search based on
partner name
and address.

Customizable
Java Class is
available to
restrict partners
from accessing
customer
details from
the opportunity
pages by clicking
the customer
link.



Option

Required

Level Setting

Description

PV: Locator
Default Distance
Unit

PV: Locator
Proxy Port

PV: Locator
Proxy Server

PV: Locator
Server Timeout

PV: Matched
Notification Flag

Yes

Yes

Yes

Yes

Optional

Site Distance Unit
Application
Responsibility

User

Site -

Site -

Site Time in
Application milliseconds
Responsibility

User

User Yes

Default distance
unit for manual
search. Also used
for automatic
matching if rule
selected did not
specify distance
unit. This is
also used by the
reseller locator.
The default value
is Mile.

Proxy server
port. The default
value is 80.

Proxy server
address. The
default value is
WWW.Proxy.
us.oracle.

com.

Timeout for
the eLocation
Request used in
reseller locator.
The default
value is 20000
milliseconds.

User can enable
or disable the
notification when
an opportunity is
matched.

If set to Yes, the
user receives

an e-mail
notification when
an opportunity
is matched with
a partner. The
default is Yes.
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Option Required Level

Setting

Description

PV: Matching Yes User
Rule Selected by
Engine

PV: Max Number Yes Site
of Matched
Partners

PV: Offered Optional User
Notification Flag

PV: Require Optional Resp
Opportunity

Contact for

Manual Routing
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Yes/No

Yes/No

Yes/No

If set to Yes, the
matching rule is
selected by the
Rules Engine
in automatic
matching. If
set to No, a user
is able to select
the rule to use
for opportunity
matching. The
default value is
No.

See Profile
PV: Rule for
Automatic
Matching.

Maximum
number of
partners
returned during
partner matching
(manual and
automatic).

If the value is
not specified,
the number

of partners
returned is 10.

If set to Yes, the
user receives

an e-mail
notification when
an opportunity
routing status
changes to
Offered.

Do not allow, or
allow assignment
routing if

there are no

opportunity

contacts.

When set to Yes, a
contact name for
the opportunity
is required for
manual and
batch routing to
start. If set to No,
a contact name is
not required. The
default is No.



Option

Required

Level

Setting

Description

PV: Restrict Sales
Team Partner
Contact LOV

PV: Rule for
Automatic
Matching

PV: Trace for
Auto Matching

PV: Unassigned
Notification Flag

PV: Withdrawn
Notification Flag

Optional

Yes

Optional

Optional

Optional

Site

User

Site
Application
Responsibility

User

User

User

Yes

Yes

Yes
No

Yes

Yes

For customer
external sales
team, if "Yes’,
restrict the
display of
contacts to those
partners that
the sales team
member can
access.

If the profile,
PV: Matching
Rules Selected
by Engine is

set to No, this
profile is used

to determine
which rule to
use for automatic
matching.

If set to Yes,
automatic
partner
assignment
process trace

is displayed

in the Ul for
debugging. The
default value is
No.

If set to Yes,
user receives

a notification

for a new
opportunity with
routing status
"Unassigned’.
The default is
Yes.

If set to Yes, the
user receives

an e-mail
notification when
an opportunity
routing status
changes from
Offered to
Withdrawn.

The default is
Yes.

System Profile Options  A-25



Option

Required

Level

Setting

Description

Applications
Server-Side
Proxy Host and
Domain

HZ: Spatial
Provider URL

HZ: Web Server
Proxy Host
Name

HZ: Web Server
Proxy Port

OS: Auto
Convert Lead
to Opportunity

OSO: Default
Sales Group and
Role

Optional

Yes

Optional

Optional

Yes

Yes
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Site

Site
Application
Responsibility

User

Site
Application
Responsibility

User

Site
Application
Responsibility

User

Site

Site

A URL

Web Server
Proxy Name

Web Server
Proxy Port

Yes/No

User Defined

This is used

by the TCA
concurrent
program, Spatial
Information for
Locations Batch
Update.

A URL for Spatial
Information

on Location
(Default at site
level is http:/
/elocation.
oracle.com/
elocation/

Ibs ). This is
used by the
TCA concurrent
program, Spatial
Information for
Locations Batch
Update.

This is used

by the TCA
concurrent
program, Spatial
Information for
Locations Batch
Update.

This is used

by the TCA
concurrent
program, Spatial
Information for
Locations Batch
Update.

If Yes, the
system converts
indirect leads
to opportunities
and performs
automated rule-
based partner
assignment.

Default Sales
Group and Role

For more
information,
see the Oracle
Sales Online
Implementation
Guide.



Option Required

Level

Setting

Description

OS: Opportunity ~ Yes
Access Privilege

PV: Locator Yes
Server URL

PV: Skip
eLocation for
Partner Matching
Service

Optional

PV: Unassigned  Yes
Opportunity
Timeout (Days)

PV: Abandon
Notification flag

Optional

Site

Site

Site
Application
Responsibility

User

Site

User

Sales Team

http://
elocation.
oracle.com/
servlets/Ibs

Yes
No

10

Default = Yes
No

This profile
drives the
behavior of
opportunity
access. This
profile is defined
within the Sales
Application.

The profile
should be set

to Sales Team,

to make sure
that partners

see only those
opportunities for
which they are
on the sales team.

PV Locator URL
used to get the
eLocation service

If "Yes’, system
skips eLocation
server and
perform geo-
proximity
analysis based on
radial distances
only.

If value is not
set, the system
defaults to No.

Number of
days an indirect
Opportunity
has stayed
unassigned.
Used by
concurrent
program PV
- Unassigned
Opportunity
process after
timeout.

User can enable
or disable
notification when
opportunity is
abandoned.
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Option Required Level Setting Description
PV: Recycled Yes User Default = Yes User can enable
notification flag No or disable
notification when
the opportunity
is recycled.
PV:iStore Login  Yes Site http:// Defines a URL
URL Machine for an iStore.
Name:Port The URL is
No/OA_HTML/ embedded
ibeCAcdLogin. in workflow
jsp?ref= notifications that
ibeCZzdMinisites. are received by
jsp?grp= partner users.
PARTNER
PV: Self Service  Yes Site http:// Defines the URL
URL with Machine for self-service
Workflow Name:Port log in that is
Notifications No/OA_HTML/ embedded in
ibeCAcdLogin. the program
jsp?ref= approval request
ibeCZzdMinisites. notifications that
jsp?grp= are received by a
PARTNER vendor user.
ASN: Yes Site Full Determines
Opportunit . which
AIc)g:ess Priv?lege Application Sales Team opportunities
Responsibility a user can access.
User If set to Sales

Team, a user
can only access
opportunities
where the user
is on the sales
team or at least
one of the user’s
subordinates is
on the sales team.
Sales Team is the
default.

If set to Full, a
user can access
all opportunities.

Profile Options for the Partner Dashboard

To implement the Partner Dashboard, set the profiles listed in the following table.
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Profile Options for the Partner Dashboard

Option Required Level Settings Description
PV: Default Yes This canbe setup - Used during
Vendor at the application the self-service
Organization or site level if registration
there is only one and Customer
internal vendor to Partner
organization that conversion
should be used to identify
to create partner which internal
of relationship. organization
This should should be used
be set up for or creating
p tner-of
the default partt .
e relationship
responsibility between
that is derived
from partner partner .and
p dor internal
geography when Vendo i
a new partner is orgamization.
registered.
FUNCTION_ Yes Responsibility PV_PARTNER_  Needs to be
SECURITY_REG FUNC_SEC_ set up for each
ION REGION partner user
responsibility
that will be
assigned to
users who will
need to access
Oracle Partner
Management
transactional
pages.
PV: Filter Yes If the profile
Partner Search No is set to Yes,
by Identifying the partner
Address Simple Search,
Advanced
Search, and
Generate

System Profile Options

Partner List
return partner
identifying
addresses

only, and the
results pages
display partner
identifying
addresses only.
If the profile is
set to No, all
partner address
are returned by
the searches, and
the pages display
all partner
addresses.
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Option Required Level Settings Description

IBE: Enable Optional Responsibility Yes Enables or
Shopping Cart N disables the
Global Icon ° Shopping Cart

global icon.

Set this option

to No for

partner site

responsibility.
IBE: Enable Optional Responsibility No Enables or
Order Tracker disables the
Global con Order Tracker

global icon for
partner sites.
This needs to
be disabled
for the partner

dashboard at the
responsibility
level.
IBE: Enable Optional Responsibility No Enables or
Quick Search disables the

Quick Search
for partner sites.
This needs to
be disabled

for the partner
dashboard at the
responsibility
level.

IBE: Use Web Yes - - Needs to be
Placements set to View
eMerchandising
Postings in
the marketing
postings bin.

The Marketing
postings

bin requires
additional
implementation
steps to see the
eMerchandising
postings in the
partner site.

For more
information, see
Oracle iStore
Implementation
Guide.
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Option

Required

Level

Settings

Description

IBE: Quick Links
Menu

IBE_USE_
ORDER_
TRACKER

Yes

Optional

Responsibility

Site
Application
Responsibility

User

This is a
mandatory
profile if the
Quick Links
bin needs to

be displayed
when logging in
with a particular
responsibility.

Needs to be setup
to the correct
FND menu from
which quick links
are rendered.
This needs to

be setup at
responsibility
level for

partner site
responsibility.

Partner

Super User
responsibility
should have this
profile option
setup as Partner
User Sub Menu.

The order tracker
icon is displayed
by default in

the global icons
section of any
site. The icon can
be disabled using
this profile.

This profile has
the site level
value seeded as
Yes.

Customers can
turn off this
profile at the
application level
if Oracle Partner
Management and
Oracle iStore are
not implemented
together in one
site.

If Oracle
iStore and
Oracle Partner
Management
are both
implemented,
this profile
should be set to
No at the partner
responsibility
level.
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Profile Options for the Partner Locator

To implement the partner locator, set the profiles listed in the following table.

Profile Options for the Partner Locator

Profile Name Required Level Setting Description
PV: Locator Yes Site Default = Mile Default distance
Default Distance unit used to
Unit search for a
partner.
PV: Locator Yes Site number Proxy Server port
Proxy Port . number
Application
Responsibility
User
PV: Locator Yes Site address Proxy Server
Proxy Server . address
Application
Responsibility
User
PV: Locator Yes Site http:/ /elocation. PV Locator URL
Server URL Aoplicati orcle.com/ used to get the
pphication servlets/lbs eLocation service
Responsibility
User
PV: Locator Skip ~ Yes Site Default = No If set to Yes,
eLocation Server Avplication system sill skip
pp the eLocation
Responsibility server and
User perform geo-
proximity
analysis based on
radial distances
PV: Locator Yes Site Default = 10 The Reseller
Distance Apolication Locator will
pp search for
Responsibility partners within
this distance.
User
PV: Locator Yes Site number The maximum
Maximum No. Aoplicati number of
Of Partners pplication partners
Responsibility returned with the
User Partner Locator
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is searching for
partners. If not
specified, the
default is 20.



Profile Name Required Level Setting Description
PV: Locator Yes Site number Number of
Partners Per Page Applicati partners that
pplication can be displayed
Responsibility per page in the
User Partner Loga}tor.
If not specified,
the default is 10.
Applications Yes Site host and domain  Used by the
Server-Side TCA concurrent
Proxy Host and program Spatial
Domain Information for
Locations Batch
Update.
HZ: Spatial Yes Site a URL A URL for Spatial
Provider URL Application Information
pp on Location
Responsibility (Default at site
User level is http:/
/elocation.
oracle.com/
elocatio n/
Ibs ). This is
used by the
TCA concurrent
program, Spatial
Information for
Locations Batch
Update
HZ: Web Server  Yes Site a web server Used by the
Proxy Host Applicati proxy name TCA concurrent
Name pplication program Spatial
Responsibility Information for
User Locations Batch
Update.
HZ: Web Server  Yes Site a web server Used by the
Proxy Port Application proxy port TCA concurrent
program Spatial
Responsibility Information for
Locations Batch
User

Update.

Profile Options for Partner Profile Attributes

To implement partner profile attributes, set the profiles listed in the following table.
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Profile Options for Partner Profile Attributes

Profile Name Required Level Setting Description
OS: Forecast Optional Site - This profile sets
Calendar the accounting
calendar that
is used to
determine the
start and end
dates for the
company’s fiscal
year.
OS: Default Optional Site - Default
Period Type Period Type
for Currency for Currency
Conversion Conversion
PV: Common Optional Site - Used by the
Currency for Application concurrent
Rules Engines pp program
Responsibility PV: Refresh
Partner Trend
User

PV: Partner
Trend Last
Refresh

PV: Refresh
Search Attributes
Last Update Date
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Values and PV
Refresh Attribute
Text Table to
convert and
store all currency
attributes in this
currency. This
enables currency
comparison to
be performed
accurately.

Can not be
updated.

Used by Refresh
Partner trend
concurrent
program to
determine the
last incremental
refresh time.

Not updatable
by the users.
Used by Refresh
Partner trend
concurrent
program to
determine the
last incremental
refresh time.



Profile Name Required Level Setting Description
PV: Vad /Partner Site Default =N This profile
Full Access To Applicati determines
Profile Screens pphication whether a
Responsibility partner or
distributor
User
can update
their company
profile and their
own profile
information
from the partner
dashboard.
PV: Attribute Site Default = 100 Used by
Percentage Total Avplication attributes with
pp a display style
Responsibility of Percentage to
U determine the
ser

percentage that
its values should
add up to.

For example, if 80
is specified, the
values for the
attribute must
add up to 80
percent.

Profile Options for Partner Programs

To implement partner programs, set the profiles listed in the following table.

Profile Options for Partner Programs

Option Required Level

Setting Description

PV: Default
Program for New
Partner

Optional Site

AMS : Item Yes Site
Validation

Master

Organization

Program name When this profile
option is set,
every time a new
partner is created
in the system,
the partner gets
automatically
enrolled into this
program after
registration.

A valid master
inventory
organization

Creates a partner
program as

an item in
Oracle Inventory
under the
specified master
organization.
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Option Required Level Setting Description
PV:Self Service  Yes Site http:/ Defines the URL
URL with servername: for the self-
Workflow port/OA_ service log that
Notification HTML/US/ICX is embedded
INDEX.htm in the program
approval request
notifications that
are received by a
vendor user.
PV: Is External Optional Responsibility Yes When set
Responsibility N to Yes for a
o oy
responsibility,
the responsibility
can be mapped
to a partner
program. When
a partner
user joins the
program, he is
assigned the
responsibility
specified.
When set to No,
the responsibility
is not available
for partner users.
PV:iStore Login  Yes Site http:// Defines a URL
URL Machine for an iStore.
Name:Port The URL is
No/OA_HTML/ embedded
ibeCAcdLogin. in workflow
jsp?ref= notifications that
ibeCZzdMinisites. are received by
jsp?grp= partner users.
PARTNER
PV: Allow Yes Site Yes Specifies
Approval No whether or not a

without Contract
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partner program
enrollment
request can be
approved before
a signed contract
is received from
the partner

Yes: An
enrollment
request can

be approved
without a signed
contract

No: A signed
contract must be
received before
an enrollment
can be approved.



Option

Required

Level

Setting

Description

IBC: Use Access
Control

QP: Source
System Code

OKC: Contract
Report

Optional

Yes

Yes

Site

Application

Application

Yes
Null
No

Default = Oracle
Special Pricing

Oracle
Application
Name

OKC: Partners
Contract:

Partners Terms
and Conditions

Determines
whether a
security check
is required
when a vendor
user accesses
Oracle Content
Manager to set
up a Program
Overview.

No or Null:
Disables the
security check.

Yes: Enables

the security
check. When
Yes is specified,
addition security
set up is
required within
Oracle Content
Manager.

Specifies

the Oracle
application that
will be the source
of the price lists
used by Partner
Programs.

Specifies how
the contract
associated with a
partner program
will appear
when the partner
user previews

it during the
enrollment
process.
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Option Required Level Setting Description

Self Service Yes Site Screen Reader A rich text editor

Accessibility Optimized can be used to

Feature create a Program
NONE Overview. The
Standard editor offers
Accessibility the ability to
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add images and
formatting to
an Overview,
which can cause
accessibility
challenges for
some users.
This profile
option allows
you to enable
or disable the
rich text editor,
and to select
an editor that
provides greater
accessibility for
users.

Three settings are
available for the
editor:

NONE: Enables
the rich text
editor, and
makes the
accessibility-
specific features
unavailable

Screen Reader
Optimized:
Content is
optimized for
reading on a
computer screen

Standard
Accessibility:
Accessibility
compliant mode



Option

Required

Level

Setting

Description

PV:
Concatenated
Inventory Flex
Segments for
Program

QP: Multi-
Currency Usage

Yes

Yes

Site
Application
Responsibility

Application

Free flow text

Yes

This value is
used to populate
the key flexfield
segment values
while creating
the program as
an inventory
item internally.
The value should
be in the format:

Segmentl.
Segment?2.
Segment3.
Segment4 etc.
(Etc.is just to
denote as many
segments as
implemented).
Here Segmentl,
2,3... should be
the values of
the key flexfield
segments that
are used for
inventory item
creation from
program. The
delimiter should
be the one

that inventory
uses to define
the segments.
One of the
segment values
should have
the code PV_
PRGM_FLEX_
CODE. This
code is replaced
with first five
characters of
program name
concatenated
with program_id
while creating
the inventory
item. So, for
example, the
value could be
US.SOFTWARE.
EBUS.PV_
PGRM_FLEX_
CODE where
US, SOFTWARE
are key flexfield
segment Values
and " is
delimiter.

Determines
whether or not
an application
can use multiple-
currency price
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Profile Options for Referral Management

To implement referral management, set the profiles listed in the following table.

Profile Options for Referral Management

Option Required Level Setting Description

PV: Default Yes Application Name of an This profile
Indirect Channel Responsibilit indirect sales option specifies
Type P y channel. the indirect sales

channel to which
all opportunities
that are
generated for

a specific partner
from referral will
be assigned.

Opportunities
that generated
from referrals but
are not created
for a specific
partner are
assigned a sales
channel using the
OS: Default Sales
Channel profile
option.
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Option

Required

Level

Setting

Description

OS: Opportunity
Access Privilege

OS: Sales Lead
Access Privilege

Site
Responsibility

User

Site
Responsibility

User

Full

Full

This profile
drives the
behavior of
opportunity
access. This
profile is defined
within the Sales
Application but
Oracle Partner
Management
uses it to
drive access to
referrals.

If this profile
is set to Full,
users can view
all the referrals
that have been
approved and
converted into
opportunities
or linked to
opportunities
that the users can
access.

If this profile is
set to another
value, users

can only view
referrals linked
to opportunities
where they are
on the sales team.

If this profile

is set to Full,
users can view
all referrals that
generated a lead.

If this profile is
set to another
value, users’s
views are limited
to referrals linked
to leads where
they are on the
sales team.
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Option Required

Level

Setting

Description

PV: Default
Referral
Approver

PV: Assign
Approvers
to lead or
opportunity
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Site

Site
Application
Responsibility

A user

Yes

Specifies a

user as the
default referral
request approver
if Oracle
Approvals
Management
does not return
an approver.

Alternatively, an
organization can
use this profile
option to specify
an approver
instead of setting
up approval
rules in Oracle
Approvals
Management.

When set to

Yes, the referral
approvers are
automatically
added to the
sales team if the
referral generates
an opportunity
or lead.

When a lead

is created, the
owner of the lead
is set to the first
approver for the
referral.

If the PV:
Assign Channel
Manager to sales
transactions
profile option

is also set to Yes,
the owner of the
lead is set to one
of the channel
managers for
the referral. The
owner is selected
randomly.



Option

Required

Level

Setting

Description

PV: Assign
Channel
Manager to sales
transactions

PV: Copy Lead
Owner or Sales
team members
on approval
notifications

PV: DQM
Contact Match
Rules

Site
Application
Responsibility

Site
Application
Responsibility

Site
Application
Responsibility

Yes

DQM rule name

When set

to Yes, the
channel manager
assigned to the
partner that
submitted the
referral is added
to the sales team
if the referral
generates an
opportunity or
lead.

When a lead

is created, the
channel manager
also becomes
the owner of
the lead. If
multiple channel
managers are
assigned to the
partner, the
owner is selected
randomly.

If this profile

is set to "Yes’,
notifications

are sent to lead
owners if a lead
is generated from
a referral, or

to sales team
members if an
opportunity is
generated from a
referral.

Note: The
referral benefit
must be
configured to
send notification
to those user

types.

This profile
stores the

Data Quality
Management
rule that is
used to perform
contact matching
for the customer.
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Option

Level

Setting

Description

PV: DQM
Customer Match
Rules

OZF: Validate
market and
product
eligibility
between object
and budget

QP: Source
System Code

AMS: Allow
Recalculation
of Committed
Budget
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Site
Application
Responsibility

Site
Responsibility

Site
Application

User

Site
Application
Responsibility

User

DQM rule name

Yes
No

Yes
No

This profile
stores the

Data Quality
Management
rule that is
used to perform
customer
matching.

Enables budget
validation when
a referral offer
is created. This
profile should
be set at the
responsibility
level for

the Channel
Administrator
responsibility
and it should be
set to Validate
customer and
products by each
budget.

This should

be set at the
application

level for

Oracle Partner
Management.

It should be

set to the same
value that the
Oracle Marketing
application is set
to.

If this profile

is set to Yes,
when the budget
exceeds the limit
while making
the accrual,

the accrual

is allowed

to exceed

the budget’s
committed
amount,
enabling the offer
to ask for more
fund later.



Option

Required Level

Setting

Description

OZF: Allow
committed
budget to exceed
total amount

PV: Contact
Relationship
Codes

PV: iStore Login
URL

PV: Self Service
URL with
Workflow
Notification

Site
Application
Responsibility

Site

Site

Yes

Contact Of

<hostname>:

<port>

<hostname>:

<port>

If set to Yes, the
referral benefit
can be activated
even though the
requested budget
amount exceeds
the total budget
amount.

If set to No,

the referral
benefit will fail
validation if the
requested budget
amount exceeds
the total budget
amount.

When a new
customer contact
is created, this
profile is used
to determine the
relationship of
the contact with
the customer.

Partner login
URL link sent
with workflow
notification for
the partner users.

Vendor

Self Service
Applications
URL sent with
a workflow
notification for
vendor users.
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Option Required

Level Setting

Description

PV: Default DQM
Approver

HZ: Generate
Party Number

HZ: Generate
Party Site
Number

Slte A user
Application
Responsibility

Site Yes
Application No
Responsibility

User

Site Yes
Application No
Responsibility

User

Specifies a user
as the default
Data Quality
Management
approver

if Oracle
Approvals
Management
does not return
an approver.

Alternatively, an
organization can
use this profile
option to specify
an approver
instead of setting
up approval
rules in Oracle
Approvals
Management.

If set to Yes,
as part of

the customer
deduplication
process for
referrals, a new
customer and its
corresponding
party number
are created in
the system if
no match is
identified.

If set to Yes,
as part of

the customer
deduplication
process for
referrals, a new
customer and its
corresponding
party site
number are
created in

the system if
no match is
identified.

Profile Options for Special Pricing

To implement special pricing, set the profiles listed in the following table.
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Profiles Options

Profile Option Required Level Setting Description
OZF_SP_ Optional Site Yes/No Value in the
ENABLE_ R sibilit profile controls
PROD_SECUR esponsibiitty if all products
ITY should be

displayed or
only products
belonging to
categories
assigned to

a partner in
the Special
Pricing Product
Categories field
in the partner’s
profile.

The user selects
at the product
category level.
The partner can
see all products
under that
category and
subcategories.
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Profile Option

Required

Level

Setting

Description

OZF_SP_
GRACE_DAYS

OZF_SP_
DEFAULT_AP
PROVER

Optional

Optional
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Site
Responsibility

Site
Responsibility

Numeric value

A user

Specifies a grace
period for a
special pricing
request. The
system uses

the number of
days specified
in this profile
to determine
how long (in
days) after the
request end date
a special pricing
request remains
active. Once
the grace period
has passed, the
status of the
request changes
to Closed,

and claims

can no longer
be submitted
against the
request.

Note: By default,
this profile is set
to zero, which
specifies up a
grace period of
one day. You
must change this
profile to provide
for a realistic
grace period.

Specifies a user
as the default
special pricing
request approver
if Oracle
Approvals
Management
does not return
an approver.

Alternatively, an
organization can
use this profile
option to specify
an approver
instead of setting
up approval
rules in Oracle
Approvals
Management.



Profile Option

Required

Level

Setting

Description

OZF_SP_
DEFAULT_
BUDGET

OZF_SP_
PARTY_DQM_
RULE

Optional

Optional

Site
Responsibility

Site
Responsibility

One or more
active, fixed
budgets

List of DQM
rules for party
match

Depending on
an organization’s
business needs, a
single special
pricing budget
can fund all
special pricing
requests, or
multiple special
pricing budgets
can be set up.
This profile

is used to
determine
whether or not
multiple budgets
will be used and
identifies the
budget(s).

Multiple
budgets: Each
budget is
specified at the
Responsibility
level, where the
responsibility is
a business unit
or geographic
entity. The
name of a
budget (set up
in Oracle Trade
Management) is
specified for each
responsibility.

Single budget:
Specify the
name of the
budget (set up
in Oracle Trade
Management) at
the Site level.

Used to find the
master party
record for the
reseller and end
customer names,
when submitting
a special pricing
request.
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Lookups

This appendix covers the following topics:

* [Understanding Lookups

Modifying LooKup Types

Creating a New|Lookup Type

/Adding Values to an Existing Lookup

Lookups for the|Channel Manager Dashboard

Lookups for Deal Registration

Lookups for [Partner Funds |
Lookups for the|[Plartner Dashboard
Lookups for the|[Partner Profile Attributes

Lookups for Partner Programs ||

Lookups for Referral Management

Lookups for Special Pricing [

Understanding Lookups

Lookups supply the content for many of the lists of values (LOV) in the Oracle

Partner Management user interface. Most lookups are predefined (seeded in the
application). You can use the seeded values without modification, or you can customize
them to fit your business needs. Lookup values are easy to use, and help ensure that
users enter valid data into Oracle Partner Management.

There are three ways that you can customize lookup values:
* Add new values
* Set a value’s Enable flag to No, so that it no longer appears in a LOV

® Use a value’s start and end dates to control when it appears in a list

Modifying Lookup Types

You use the Application Utilities Lookups window to add a new lookup type, add
values to an existing lookup type, or prevent existing values from appearing in a lookup
type. You must log out and log in again to see the effect of your changes.

Lookups B-1



Lookups are identified as either User, Extensible, or System Lookups. A lookup’s type
determines the modifications that you can make to it:

User: A user can both add and remove seeded items
Extensible: A user can add items, but can not remove seeded items

System: Users are unable to modify the content of the lookup

Creating a New Lookup Type

Use this procedure to define a new lookup type and lookup value.

Prerequisites

Steps

None

S A

o

10.

11.

Log in to Oracle Forms with the System Administrator responsibility.
Navigate to Application > Lookups.

Choose the access level for the lookup type.

Enter the lookup type.

Enter the user name of the lookup.

This is the name that users will see from within the application.
Select the application in which the lookup will be used.

Optionally, add a description of the lookup type.

To add lookup values specific to the security group/business group linked to your
current responsibility, uncheck the Global Security Group check box. Existing
lookup values are available to all business groups.

Enter the code, meaning, and, optionally, a description for each value. Leave the
Tag column blank.

Enter start and end dates

If you do not enter a start date, the new lookup is valid immediately. If you do not
enter an end date, the new lookup is valid indefinitely.

Save your work.

Adding Values to an Existing Lookup

Use this procedure to add a new value to an existing Lookup.

Prerequisites

Steps

None

1.

Query the lookup type to which you want to add a value.

You cannot add values if the access level is System.
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2. To add lookup values specific to the security group /business group linked to your
current responsibility, uncheck the Global Security Group check box. Existing
lookup values are available to all business groups.

3. Enter the code, meaning, and, optionally, a description for each value. Leave the
Tag column blank.

4. Enter start and end dates

If you do not enter a start date, the new lookup is valid immediately. If you do not
enter an end date, the new lookup is valid indefinitely.

5. Save your work.

Lookups for the Channel Manager Dashboard

To implement the channel manager dashboard, create or verify the lookup settings listed
in the following table.
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Lookup Values for the Channel Manager Dashboard

Lookup Name Type Value Description

PV_INTERACTION_ System ENRQ Enrollment Request

OBJECT_TYPE GENERAL General
MEMBERSHIP Membership
OPPORTUNITY Opportunity
PVDEALRN Deal Registration
PVREFFRL Referral
SOFT_FUND Partner Fund Request

PV_TRANSACTIONS System

PV_ System
CMDASHBOARD_
GRAPH

PV_TREND_DATE_ System
RANGE

PV_TREND_PER System
IOD_TYPE

SPECIAL_PRICE

TRANS_CLAIMS
TRANS_DEAL
TRANS_FUND
TRANS_OFFER
TRANS_OPPTY
TRANS_ORDERS
TRANS_REF
TRANS_SPR

M
Q

B5YEAR
L2YEAR
LYEAR
YTD

MONTH
QUARTER
YEAR

Special Pricing
Request
Claims

Deal Registrations
Fund Requests
Offers
Opportunities
Orders
Referrals
Special Pricing
Requests
Monthly
Quarterly

Last Five Years
Last Two Years
Last Year

Year to Date

Month
Quarter

Year

Lookups for Deal Registration

To implement deal registration, create or verify the lookup setting listed in the following

table.
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Lookup Values for Deal Registration

Lookup Name

Type

Value

Description

PV_REFERRAL_
DECLINE_REASON

User

CUST_DTLS_NOT_
VERIFIED

EXISTING_LEAD
EXISTING_OPPTY

MORE_INFO_REQU
IRED

Customer Details Not
Verified

Existing Lead
Existing Opportunity

More Information
Required

Lookups for Partner Funds

To implement partner funds, create or verify the lookup settings listed in the following

table.

Lookups for Partner Funds

Lookup Type Value Description
OZF_REQUEST_ System DRAFT Draft
STATUS APPROVED Approved
CLOSED Closed
DECLINED Declined
VOID Void
SUBMITTED_FOR_A  Pending Approval
PPROVAL
Returned
RETURNED
OZF_REQUEST_ System SOFT_FUND Soft Fund
CLASS SPECIAL_PRICE Special Price
OZF_REQUEST_TY System SOFT_FUND Soft Fund
PE
OZF_SF_DECLINE_ User COLLATERAL Collateral Did Not
CODE DUPLICATE Meet Criteria
INVALID Duplicate Request
Invalid Request
OZF_SF_RETURN_ User COLLATERAL Collateral Submission
CODE OTHER Requested
MISS_INFO Other
Request Missing
Information
OZF_ System AMOUNT Amount
PERFORMANCE_
UOM NUMBER Number
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Lookup Type Value Description
OZF_FUND_ System SOFT_FUND Soft Fund
SOURCE FUND Budget
CAMP Campaign
DELV Deliverable
EVEH Event
EVEO Event Schedule
OFFR Offer
EONE One Off Event
OPTN Other Partner
PTNR Partner
USER Person
PRIC Price List
CSCH Schedule
VEND Vendor
OZF_PARTNER _ User LEAD Lead
PERFORMANCE REVENUE Revenue

Lookups for the Partner Dashboard

To implement the partner dashboard, create or verify the lookup setting listed in the

following table.

Lookup Values for the Partner Dashboard

Lookup Name Type Value Description

PV_USER_ROLES User BUSINESS Business User
PRIMARY Primary User
ALL All

Lookups for the Partner Profile Attributes

To implement partner profile attributes, create or verify the lookup setting listed

in the following table.
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Lookup Values for Partner Profile Attributes

Lookup Name Type Value Description

PV_ATTRIBUTE_ User GENERAL General

CATEGORY_TYPE MARKETING Marketing
PRM PRM
RESOURCE Resource
SALES Sales

Lookups for Partner Programs

To implement partner programs, create or verify the lookup settings listed in the

following table.

Lookups for Partner Programs

Lookup Type Value Description

PV_BENEFIT_TYPE  Extensible PVDEALRN Deal Registration
PVREFFRL Referrals
OZFSFBEN Soft Funds
OTHERS Other benefit types
STORES Stores

PV_BENEFIT _ User ACTIVE Active

STATUS INACTIVE Inactive
DRAFT Draft
FAILED_VALIDAT Failed Validation
ION Inactive
INACTIVE Pending
PENDING

Lookups

B-7



Lookup Type Value Description
PV_BENEFIT_ENT System APPROVED Approved
ITY_STATUS AWAITING_FOR_ Waiting for partner
PARTNER_ACCE acceptance
PTANCE Closed by vendor
\C/IEE%E(])DIEBY— Closed - dead lead
CLOSED DEAD Closed - fee paid
LEAD - Closed - lost
CLOSED_FEE_PAID ~ OPportunity
CLOSED_LOST Op ~ Compensation
PTY - - cancelled
COMP_CANCELLED Declined
DECLINED Draft
DRAFT Expired
EXPIRED Extended by vendor
EXTENDED BY Compensation being
VENDOR negotiated
COMP_BEING._ Payment being
NEGOTIATED processed
PAYMENT BEING_ Pending approval
PROCESSED Pending customer
PENDING_AP review
PROVAL Processing
PENDING compensation
CUSTOMER_REV
IEW
PROCESSING_COM
PENSATION
PV_PROGRAM_ User AOF Access to Online
BENEFITS FPD Forms
IBB Free Product Demo
Invitations to Business
Qw Briefings
e Invitations to
PN Quarterly Workshops
PWK Partner Helpdesk
RN Partner Newsletter
Partner Welcome Kit
Regular Newflashes

Lookups for Referral Management

To implement referral management, create or verify the lookup setting listed in the

following table.
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Lookup Values for Referral Management

Lookup Name Type

Value

Description

PV_REFFERRAL_ User
DECLINE_REASON

CUST_DTLS_NOT_
VERIFIED

EXISTING_LEAD
EXISTING_OPPTY

MORE_INFO_REQU
IRED

Customer Details Not
Verified

Existing Lead
Existing Opportunity

More Information
Required

Lookups for Special Pricing

To implement special pricing, create or verify the lookup settings listed in the following

table.
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Lookups for Special Pricing

Lookup Type Code Type Value Description
OZF_REQUEST_ System DRAFT Draft
STATUS APPROVED Approved
CLOSED Closed
DECLINED Declined
SUBMITTED_FOR_A Pending Approval
PPROVAL
OZF_REQUEST _ System SOFT_FUND Soft Fund
CLASS SPECIAL_PRICE Special Price
OZF_REQUEST_TY System MEET_COMPET Meet Competitor
PE ITOR Price
BLANKET_REQUEST Blanket Request
BID_REQUEST Bid Request
OZF_SP_REQUEST_  Extensible CANNOT_MEET Cannot Meet Discount
DECLINE_CODE NEED_MORE, INFO Requested
Need More
Information
OZF_SP_REQUEST_  System % Discount Percent
DISTYPE AMT Discount Amount
NEWPRICE New Price
OZF_SP_REQUEST_  Extensible IN_PROGRESS In Progress
OUTCOME LOST Lost
WON Won
OZF_FUND_ System SPECIAL_PRICE Special Price
SOURCE FUND Budget
CAMP Campaign
DELV Deliverable
EVEH Event
EVEO Event Schedule
OFFR Offer
EONE One Off Event
OPTN Other Partner
PTNR Partner
USER Person
PRIC Price List
CSCH Schedule
VEND Vendor
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Summary of Concurrent Programs

This appendix covers the following topics:

¢ Running Concutrent Programs |

Checking Concurrent Program Status |

Concurrent [Programs for thé [Channel Manager Dashboard

Concurrent [Programs for Deal Registration

Concurrent Programs for Enrbllments

Concurrent Programs for Opportunities

Concurrent Programs for [Partner Funds

Concurrent Programs for the [Partner Locator

Concurrent Programs for Partner Progranis

Concurrent Programs for [Partner [Profile Attributes

Concurrent [Programs for Referral Management

Concurrent Programs for Special [Pricing

Running Concurrent Programs

Prerequisites

Steps

Use the following instructions for running any Oracle Applications concurrent program
or program set. You can use these procedures to run or schedule any of the Oracle
Partner Management concurrent programs.

Refer to the Oracle Applications System Administrator’s Guide for complete details on
Oracle Applications concurrent programs.

None.

Log in to the Forms application.
Select the appropriate responsibility.
Double-click Concurrent Requests.

Double-click Run.

SO e

Select the Single Request radio button.
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Click OK.
Search for the concurrent request that you want to run.
Click Submit.

Select from the search results.

. Click OK.
11.

Click OK to run the concurrent request.

Checking Concurrent Program Status

Use the following procedure to check the status of a concurrent program.

Prerequisites

Steps

None.

Log in to Oracle Forms with the appropriate responsibility. The responsibility for
each concurrent program is provided with the program description.

Choose View > Request.
The Find Request window opens.
In the Find Request window;, search for your concurrent program request.

¢ If the server is not busy, selecting Find may be the fastest way to find your
request.

o If the server is busy, it may be better to enter search criteria and look for Specific
Requests.

The Request window displays a list of submitted requests. The Oracle Marketing
concurrent programs should be listed.

Select Refresh Data occasionally to check the completion status.

Once in the “red” state or Phase = “completed,” the View Output and View Log
buttons will become active (if the log output files have been setup correctly)

Concurrent Programs for the Channel Manager Dashboard

The following table provides information about the concurrent programs used by the
channel manager dashboard.
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Concurrent Program for the Channel Manager Dashboard

Program Required

Description

Generate Territory Packages Yes

OZEF-TM: Generate Party List  Yes
for Market Qualifier

After defining new territories
or updating existing
territories, the territory
administrator must execute
this concurrent program. The
parameter values for this
program must have Oracle
Partner Manager specified for
usage, and Partner specified
as transaction type. The

new territory definitions are
available for partner channel
team assignment only after the
concurrent request is executed
successfully.

Responsibility: CRM
Administrator

Matches customer orders

to offers and populates

a denormalized table
AMS_PARTY_MARKET _
SEGMENTS with customer
segmentation information
based on territory definitions.

This program needs to be run
in two situations:

*  When a new territory
is created. Run the
program after running
the Generate Territory
Package program.

®  When a new customer is
created as the result of a
referral.

Note: This program must
be run after the Generate
Territory Packages program
and before OZF-TM: Net
Accrual Engine to ensure
that the net accrual engine
accurately matches customer
orders to offers.

Responsibility: Oracle Trade
Management Administrator
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Program Required

Description

PV:Channel Team Assignment Yes
for Partners in TOTAL/
INCREMENTAL Mode
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Parameter Name: Mode

Parameter Values: TOTAL or
INCREMENTAL

Run this concurrent program
in TOTAL mode if you have
installed Oracle Partner
Management for the first time
or have just upgraded to a
new version of Oracle Partner
Management. Before running
the program, a territory
hierarchy must be set up for
your organization. Once the
hierarchy is set up, running
this program assigns channel
teams to partners, based on
the territory hierarchy.

You might also want to run
this program in the TOTAL
mode if your organization
makes significant changes to
the territory hierarchy.

Run this program in
INCREMENTAL mode
when you have:

¢  Set the profile option
PV: Territory Assignment
Online is set to No.

* Updated any partner’s
transaction qualifiers
from an Oracle
application other
than Oracle Partner
Management.

Frequency: Run in TOTAL
mode one time after upgrading
or installing Oracle Partner
Management or when the
territory definition undergoes
a major change. Run in
INCREMENTAL mode each
day, or after making minor
changes to territories.

Responsibility: PRM
concurrent requests



Program

Required

Description

PV: Define Channel team for
specific territories

Yes

Run this concurrent program
when there is a change in:

® The assignment of
channel manager
resources for a territory
(for example, when
a channel manager
leaves or a new channel
manager is added to the
organization).

®  Territory transaction
qualifier values (for
example, when a territory
that was originally
defined to contain
partners in California
now contains partners in
California, Nevada, and
Oregon).

This program should be run
each time there is a change in
the territory setup.
Responsibility: PRM
concurrent requests
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Program Required

Description

PV: Update Partner Status Yes
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To determine if the status

of a partner is active, all the
following conditions must be
true:

1. Relationship status between
partner and vendor is active
and the relationship is not end
dated.

2. Partner Organization status
is active.

3. Vendor Organization status
is active.

4. The partner organization
resource record is not end
dated in CRM resource
manager.

Checking for partner status
in all the above-mentioned
places causes significant
performance issues. To
address this issue a STATUS
column has been added to
the PV_PARTNER_PROFILE
table. The STATUS column
consolidates the Partner Status
definition, which improves
performance. In addition,
when a partner’s status
changes, a Workflow Business
Event is raised. Any Oracle
application can subscribe to
this business event to perform
necessary action.

This concurrent program
needs to be scheduled to
update the partner status
periodically. Between the
concurrent job executions, it may
be possible for the partner status
to be in an inconsistent state as
the partner data can be updated
through other Oracle Application
products.

When the concurrent
program return status is
error or warning, use the
concurrent program’s log file
for additional information.

Frequency: Every day
(minimum)
Responsibility: PRM
concurrent requests



Program Required Description

Refresh AS period days Yes The date information that
populates the graphs that
appear on the Channel
Manager dashboard is taken
from the General Ledger
Accounting Calendar. Once
the calendar is set up, the
Refresh AS period days
concurrent program takes
information from the gl_daily_
rates table and populates the
as_period_days table. Oracle
Partner Management uses
data from this table to build
the x-axis of the dashboard
graphs.

To set up the calendar, log into
Oracle Forms as the General
Ledger Super User and
navigate to Setup > Financial
> Accounting > Calendar.

It is recommended that this
program be run once a month.

Responsibility: Oracle Sales

Administrator
Refresh Multi-Currency Yes Once the General Ledger
Conversion Rate (AS_PER Accounting Calendar is
IOD_RATES) set up, this program takes

information from the gl_daily_
rates table and populates the
as_period_rates table.

It is recommended that

this program be run once a
month. It should be run after
the Refresh AS period days
concurrent program is run.

Responsibility: Oracle Sales
Administrate

Concurrent Programs for Deal Registration

The following table provides information about the concurrent programs used by
deal registration.
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Concurrent Program for Deal Registration

Program Required

Description

PV - Update Referral /Deal Yes
Status

Evaluates all approved deal
registrations to update the
status to one of the following
closed or expired statuses:

Closed. Dead Lead
Closed. Lost Opportunity
Closed. Opportunity Won

Expired

Responsibility: PRM
concurrent requests

Concurrent Programs for Enroliments

The following table provides information about the concurrent programs used by

enrollments.

Concurrent Program for Enrollments

Program Required

Description

PV: Send enrollment Yes
notifications to partner user
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Sends notifications to partner
primary users when either of
the following occurs:

The partner’s
membership in a
particular program is
about to or has expired
(based upon a partner
program’s criteria). The
primary user receives a
Renewal notification.

The signed contract for
a program that a partner
wants to join has not
been received within

a specified period of
time. The primary user
receives a Contract Not
Received notification.

It is recommended that you
run this program daily.
Responsibility: PRM
concurrent requests



Program Required Description

PV: Expire Ended Program Yes Changes a partner’s program
Membership, and Renew membership status to Expired
Early Renewed Program if the partner’s membership
Memberships end date is past the current

system date. When the status
of a global partner’s program
membership status is Expired,
the program membership

of each of its subsidiaries
changes to Expired as well.

The program also changes

a partner’s program
membership status to Renew
for all early renewals with a
start date in the past.

It is recommended that you
run this program daily.
Responsibility: PRM
concurrent requests

PV: Process the errored Yes If the Oracle Approval
enrollment requests for Manager application
approval encounters an error, it is

possible that partner self-
service enrollment requests
will not be routed for approval.
This program identifies and
processes orphaned approval
requests and routes them to
their appropriate reviewer(s).

It is recommended that you
run this program bi-weekly.
Responsibility: PRM
concurrent requests

Concurrent Programs for Opportunities

The following table provides information about the concurrent programs used by
opportunities.
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Concurrent Programs for Opportunities

Program Required Description
PV Unassigned Opportunity =~ Optional This concurrent program
Process After TimeOut invokes the partner matching

engine to route indirect
opportunities that have been
unassigned for more than

a specified number of days
since the opportunity was
created. The number of days
after which an opportunity
is routed is determined by
the profile PV: Unassigned
Opportunity Timeout. (Days)

The parameters of the
concurrent program are:

Country - Process
opportunities only for country
specified.

User Name - The user that
is determined to be the
assignment manager for the
opportunity routing.

From Date - Consider only
those opportunities that have
been created after this date.
Responsibility: PRM
concurrent requests

PV - Initial Build for Partners  Yes This program initially builds

Open/Won Opportunities or rebuilds the materialized
view to display the values in
the Opportunity Open and
Won Bin.

The parameters of the
concurrent program are:

No_of_process - For systems
with multiple CPUs, this
sets the number of parallel
database processes that are
started to build materialized
views.

Next_extent - Database extent
size to allocate whenever more
space is needed to store the
data.

Responsibility: PRM
concurrent requests
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Program

Required

Description

Spatial Information for
Locations Batch Update

Workflow Background Process
- POL Assignment Routing

Yes

Yes

Acquire latitude and longitude
values for locations in the TCA
registry.

For addresses that already
have spatial data, the program
updates the records with
the latest information

from eLocation. (For

more information, see
Oracle Trading Community
Architecture eLocation Spatial
Data Integration User Guide.)
This is needed for partner
matching to determine the
radial distances between a
customer on the opportunity
and the partners.

Responsibility: Trading
Community Manager

Process channel manager
time-out and partner time-out
activities in opportunity
routing.

The parameters of the
concurrent program are:

Item_type: POL Assignment
Routing

Process Deferred: N
Process Timeout: Y
Process Stuck: N

Responsibility: Workflow
Administrator
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Program Required

Description

Workflow Background Process Yes
- POL Automated Partner
Matching
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When a lead is created, and
the channel selection engine
selects an indirect channel
based on the profile OS: Auto
Convert Lead to Opportunity,
the lead is converted to an
indirect opportunity. Then,
this concurrent program
starts the workflow process
that initiates the automatic
background matching process,
which automatically matches
and routes opportunities to
partners.

This concurrent program also
performs routing to partners
on the campaign specified on
the opportunity if the profile
option PV: Enable Automatic
Routing by Campaign is set
to Y. If the profile option

PV: Enable Automatic
Routing by Campaign is

set to N, program instead adds
partners participating in the
campaign to the external sales
team.

Item_type: POL Automated
Partner Matching

Process Deferred: Y
Process Timeout: N
Process Stuck: N

Responsibility: Workflow
Administrator



Program Required

Description

Workflow Background Process Yes
- POL NotifyParty

PV - External Salesteam Yes (Patchset B only)
Mibration

Sends a notification to a
channel manager when

an indirect opportunity is
routed to one of the channel
manager’s partners and the
partner also submitted the
deal registration that resulted
is the creation of the same

opportunity.

The parameters of the
concurrent program are:

Item_type: POL Notify Party
Process Deferred: Y

Process Timeout: N

Process Stuck: N

Responsibility: Workflow
Administrator

Organizations that implement
that Patchset B need to run
this program.

Earlier implementations of
Oracle Partner Management
allowed a partner contact

to exist on an opportunity
or a lead, or to be included
in a customer’s external
sales team, even when the
partner organization was not
associated with the object. As
of Patchset B, a partner
contact is accessed through
the partner organization, and
thus can not be accessed

if the partner organization
has been removed from an
object. Run this program to
add the partner organization
to opportunities, leads, and
customer external sales teams
for which a partner contact is
associated independently of
its partner organization.

Responsibility: PRM
concurrent requests

Concurrent Programs for Partner Funds

One concurrent program is required for Partner Funds: OZF - TM: Release Committed
Budget Amount After Grace Period. This program closes a soft fund request after the
grace period has passed, disables the Submit Claim button on a fund request, and
reconciles liabilities. It can be scheduled to run periodically. The responsibility is Oracle

Trade Management Administrator.
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Concurrent Programs for the Partner Locator

The following table provides information about the concurrent programs used by
the partner locator.

Concurrent Program for the Partner Locator

Program Required Description

Spatial Information for Yes Acquire latitude and longitude

Locations Batch Update values for locations in the TCA
registry.

For addresses that already
have spatial data, the program
updates the records with

the latest information

from eLocation.(For more
information, refer to the
Oracle Trading Community
Architecture eLocation Spatial
Data Integration User Guide.)
This concurrent program
needed for the Partner Locator
to determine the radial
distances between a customer
and a partner.

Responsibility: Trading
Community Manager

PV Refresh Attribute Text Yes Allows the attribute details

Table for a particular partner to be
used in the matching process
and to calculate performance
and derived attributes for each
partner.

There are two options for
running this program: full
refresh or new partners only
refresh. Full refresh is the
default.

The new partners only option
picks up all the partners that
have been created since the
last refresh of this type. The
last refresh date is stored in
the profile option PV: Refresh
Search Attributes Last Update
Date.

Responsibility: PRM
concurrent requests

Concurrent Programs for Partner Programs

The following table provides information about the concurrent programs used by
partner programs.
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Concurrent Program for Partner Programs

Program

Required

Description

PV: Close Ended Programs
and Memberships

PV: Refresh Partner Program
Eligibility

PV - Update user resp when
resp mapping is created or
deleted

PV: Assign/Revoke User
Responsibilities

No

Yes

Yes

Yes

Assigns a status of Closed to
programs with end dates that
are past the current system
date.

Responsibility: PRM
concurrent requests

Evaluates a partner’s
eligibility to enroll in a
partner program based on
the program’s prerequisites.
PV: Refresh Partner Program
Eligibility should be run at
least once a day to make sure
that existing partners are
evaluated for eligibility to join
new partner programs. If you
do not run this program, new
partner programs will be
available only to new partners.

Responsibility: PRM
concurrent requests

When a channel administrator
modifies the responsibility
mappings, it impacts the
responsibilities assigned to
partner users. This program
updates partner users’
responsibilities after a change
has been made to existing
responsibility mappings.
There is no fixed frequency in
which this program should be
run.

Responsibility: PRM
concurrent requests

This program is used to assign
or revoke responsibilities

of partner users based on
their organization’s program
memberships. This program
runs automatically when

the channel administrator
adds, changes, or deletes a
responsibility.

Responsibility: PRM
concurrent requests

Concurrent Programs for Partner Profile Attributes

The following table provides information about the concurrent programs used by

partner profile attributes.

Summary of Concurrent Programs
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Concurrent Program for Partner Profile Attributes

Program Required

Description

PV: Refresh Partner Trend Yes
Values

PV Refresh Attribute Text Yes
Table
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Updates partner trend values
to enable up to date attribute
matching. Retrieves or
calculates the partner trend
performance measures
summarized at a monthly
level.

The parameters of the
concurrent program are:

Start from Beginning of Month
- Identifies the starting month
to refresh (only applies to
measures that are cumulative).
Non-cumulative measures

are always calculated for the
current month only.

To Ending of Month - Identifies
the ending month to refresh
(only applies to measures
that are cumulative). Non-
cumulative measures are
always calculated for the
current month only.

New Partners Only - If set

to Yes, then only process for
new partners. New partners
are defined as partners
created after the last run of
this program (stored in the
profile PV: Partner Trend Last
Refresh).

Ignore refresh interval - If set
to Yes, process all attributes
even though the time interval
from the last refresh have not
exceeded the refresh interval
set for some attributes.

Responsibility: PRM
concurrent requests

Allows the attribute details
for a particular partner to be
used in the matching process
and to calculate performance
and derived attributes for each
partner.

There are two options for
running this program: Full
Refresh or New Partners Only
Refresh. Full Refresh is the
default.

The New Partners Only
Refresh option picks up all
the newly created partners
since the last refresh of

this type. The last refresh
date is stored in the profile
PV: Refresh Search Attributes
Last Update Date.

Responsibility: PRM
concurrent requests



Concurrent Programs for Referral Management

The following table provides information about the concurrent programs used by
referral management.

Concurrent Program for Referral Management

Program Required Description
OZE-TM: Generate Party List  Yes Matches customer orders
for Market Qualifier to offers and populates

a denormalized table
AMS_PARTY_MARKET _
SEGMENTS with customer
segmentation information
based on territory definitions.

This program needs to be run
in two situations:

*  When a new territory
is created. Run the
program after running
the Generate Territory
Package program.

®  When a new customer is
created as the result of a
referral.

Note: This concurrent
program must be run before
OZF-TM: Net Accrual Engine
to ensure that the net accrual
engine accurately matches
customer orders to offers.

Responsibility: Oracle Trade
Management Administrator
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Program Required Description

OZF-TM: Net Accrual Engine  Yes Calculates the net accruals for
all offers of type Net Accrual.
Referral management uses
the program to calculate the
commission a partner earns on
referrals.

The net accrual engine
references a customer
denormalized table that

is populated by the OZF-
TM: Generate Party List for
Market Qualifiers concurrent
program. When a referral is
created, the system may create
a new customer. The new
customer is not in the customer
denormalized table until the
OZF-TM: Generate Party List
for Market Qualifiers program
is run.

Run the OZF-TM: Net
Accrual Engine program
before you run the PV -
Referral Compensation Order
Completion program and
when you want to calculate
how much your partners have
accrued. It is recommended
that you run OZF-TM: Net
Accrual Engine once a month.

Responsibility: Oracle Trade
Management Administrator

PV - Update Referral /Deal Yes Evaluates all approved
Status referrals to update the status
to one of the following values:

® (Closed - Dead Lead
® C(Closed - Lost Opportunity

® (Closed - Opportunity
Won

*  Expired

Run this program to close
approved referrals. You

must run this program
before running the PV -
Referral Compensation Order
Completion program. It is
recommended that you run PV
- Update Referral /Deal Status
weekly to make sure that the
referral statuses are up to date.

Responsibility: PRM
concurrent requests
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Program Required Description

PV - Referral Compensation Yes Creates claims and starts the

Order Completion payment process for referrals
that have generated fulfilled
orders. It is recommended that
you run this program once a
month.

Responsibility: PRM
concurrent requests

Generate Territory Package Yes As a part of the standard
territory creation process, this
program must be run after a
territory is created.

Responsibility: CRM
Administrator

DQM Staging Program Yes Populates the search table
against which the DOM
process performs queries. You
should run this program when
a new party (hz_parties) is
created.

To run the program, you must
be able to log in with the
Trading Community Manager
responsibility.

You must provide the
following parameters to

run the DQM Staging Program
for Referral Management:

®  Number of Workers =5

® Staging Command
= STAGE_ALL_DATA

¢ Continue previous
execution = No

No additional values need to
be set.

Responsibility: Trading
Community Manager

Concurrent Programs for Special Pricing

One concurrent program is required for Special Pricing: OZF - TM: Release Committed
Budget Amount After Grace Period. This program closes a special pricing request
after the grace period has passed, disables the Submit Claim button on a special
pricing request, and reconciles liabilities. It can be scheduled to run periodically. The
responsibility is Oracle Trade Management Administrator.
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Glossary

Assignment

When an opportunity is matched to partners.

Assignment Routing

Process that routes an opportunity assignment to partners.

Attribute

Oracle Partner Management provides a flexible profiling framework to capture

and track the attributes of a partner. The profiling framework supports fixed
attributes, information entered by the partner or channel manager, and derived
attributes, information calculated based on partner data and transactions. The profiling
framework provides a central repository to capture and track all partner related
information. Channel managers can use this information to differentiate partners and
provide better services, such as soft funds, incentives, and opportunities.

Benefit

Oracle Partner Management extends benefits to partners based on their program
participation.

Campaign

A marketing effort comprising any number of different techniques for reaching
Customers or Prospects.

Channel Administrator

They have access to administrative setups to define profile attributes, program benefits
such as referral and deal registration initiatives as well as setups, notifications and
partner users accounts.

Channel Manager

They own the relationship between the vendor and the partner and bear responsibility
for managing and distributing information to partners. They work with the

partner, assign and maintain opportunities, approve assignments, approve submitted
referrals, special pricing requests, fund requests, and deals. Depending upon business
rules, they may approve or reject opportunities being assigned to partners. They can
maintain opportunities depending upon access and business rules.

Channel Manager Dashboard

The channel manager dashboard provides you an easy to use, configurable user interface
to help you with your day to day responsibilities. It provides you with a 360 degree view
of your partners and activities, thereby enabling you to make informed decisions.
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Channel Manager Timeout

This is the date by which all channel managers must approve or deny the opportunity
assignment.

Customer

A purchaser of products or services.

Compensation

If a partner’s referral results in orders in the system, they have to be compensated for the
same. The compensation rates vary from initiative to initiative and by product. Once a
partner is compensated, the referral is closed.

Concurrent Manager

The concurrent manager is a process manager that coordinates processes generated by
users’ requests to run various data-intensive programs. An Oracle applications product
group can have several concurrent managers.

Deal Registration

When a partner resells your products, there is often a conflict between your direct
sales force and your partner network. Deal Registration enables partners to submit
opportunities and receive your commitment not to compete directly and support the
partner on the deal.

Distributor

A business that buys, warehouses, ships, invoices and resells; a party that acts as an
intermediary in order and inventory management.

DQM

Data Quality Management (DQM) is a tool that is used to check for potential duplicate
customers, contacts, address and/or contact points for a given customer, contact, address
or a contact. The system finds potential duplicates using rules defined within DQM.
Enroliment

Enrollments enables you to administer and expedite the registration of partners into
Oracle Partner Management by enrolling them into programs.

Existing Inventory

When a partner has already bought the product and wants a discount for past purchases.

Expense Breakdown

This is the breakdown of expenses for the marketing activity. The line items appearing
within the Expense Breakdown are based on the Activity you selected.

Forms

Forms are a logical collection of fields, regions, and graphical components that appears
on a single window. Oracle Forms resemble paper forms used to run a business. You
enter data by typing information in the form.

Forms Server

A Forms server is a type of application server that hosts the Forms server engine. It
mediates between the desktop client and the database, providing input windows for



the Forms-based products on the desktop client and creating or changing database
records based on user actions.

Framework

A framework is a collection of collaborating classes. The interaction framework
dictates the architecture. It defines the overall structure, its partitioning into classes
and objects, the key responsibilities, how the classes and objects collaborate, and the
thread of control.

Fund Request

The request a partner submits (or a vendor on behalf of a partner) in order to request soft
fund dollars from you.

Fund Request Claim

After a fund request is approved and the partner has executed the planned marketing
activity, they can submit a claim to redeem money from you.

Hyperlink

A link to another page.

Indirect Managed Partner/IMP

Smaller partner organizations that deal with VADs to purchase and resell specific vendor
items. They do not have a direct relationship with you.

Joint Selling

In this routing option, the channel manager offers an opportunity to multiple

partners. Multiple partners can accept the opportunity and work together on it.

Joint Assignment

This routing option supports collaborative selling. The opportunity is offered to multiple
partners for fulfillment. The partners come together and bring their expertise to win

the deal.

Managed Partner

An organization or person who has a strategic agreement with you to conduct certain
transactions and is managed directly by you.

Manufacturer

A business or person that produces one or more products. (also known as vendor)

Marketing Activity (Partner Fund)

This is the marketing activity for which funding is being requested.

Membership Level

Particular levels of participation within a partner program. Membership levels exist
within a partner program and can offer partners special incentives and benefits.
Multiple-Parallel

In this routing option, you can also broadcast the opportunity to multiple partners
for review at the same time. However, only the partner who accepts it first, will win
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the opportunity. If you want to do multiple matching, you need to select at least two
partners from the partner LOV window.

Multiple Serial

This is a variation of the single routing option and you can create an ordered list of
partners. The opportunity will be offered to the first partner for review. If the partner
accepts it, the assignment is successful. If the partner declines it, it is offered to the
second partner in the list for review. You need to select at least two partners from the
partner LOV window.

New Inventory

When a partner requests a special price for a new purchase and you approve it, the
partner can close the sale to the end-customer at a discounted rate.

Note Status

There are three statuses available for notes:
e Public: Other vendor users can see comments.
e Publish: Partner users and other vendor users can see comments.

e Private: Only you can see comments.

Note Type

These are organization-defined types to used to categorize notes.

Offer

Offers are generated in the background when approving a special pricing request to
track the special pricing discount that has been approved. There are three types of offers:

e Accrual Offer - The discounted amount will be accrued and the partner will be
paid later.

e Off-Invoice Offer - The discounted amount will be paid to the partner off the invoice.

e Scan Data Offer - If the special pricing request is being fulfilled from existing
inventory, the system will generate a Scan Data offer.

Opportunity

A qualified sales opportunity with the potential to bring in revenue. An opportunity
has a life span and it eventually closes either because it turns into a sale, is lost to a
competitor, or is a bad opportunity. An opportunity is assigned to one or more territories
based on a variety of criteria and can be worked on by a single sales representative, by a
team of employees, or by a sales partner.

Partner

Partners are people or organizations with whom you can have a business
relationship. Every partner organization is a distinct legal entity with its own
challenges, market pressures, customer pressures, and intellectual capital.

Partner Administrator

The partner administrator is the primary contact of the organization and is responsible
for administering all opportunities assigned to the partner.



Partner Contact

The primary contact for a partner, (the role responsible for administering all
opportunities assigned to the partner) receives e-mail notifications and accepts or
declines opportunities on behalf of the partner.

Partner Dashboard

The partner dashboard enables partners to enroll into programs, manage
memberships, view and manage company profile, manage users, view product
catalog, place orders, view order status, submit referrals, register deals, request soft
funds, request discounts, accept opportunities, and work on assigned opportunities.

Partner Fund

Partner funds enable you to better manage and distribute channel marketing funds to
your channel partners. You can provide funds for a specific time period and base it
on fiscal periods of your organization.

Partner Funds Liability

The liability is the amount of money that you have committed to pay out to your channel
partners for marketing activities but have not yet paid out.

Partner List

Oracle Partner Management integrates with Oracle Marketing to enable you to
generate partner lists. These lists can then be used to run marketing campaigns for
partners. Based on profile attributes, you can create a list and save your search. Based on
the search criteria, partners will be displayed and this can be created as a list.

Partner Timeout Period

Partner timeout is based on a partner’s country; it is the time period during which a
partner who has been offered an opportunity is expected to respond (accept/reject the
opportunity) before the next action can occur. These time frames are user-defined and
supported by Oracle Workflow through automatic e-mails, notifications, and routing
status changes.

Partner Type

A type of partnership with specified terms and conditions, that is Value-Added
Distributor (VAD), Value-Added Reseller (VAR), System Integrator (SI), Independent
Software Provider (ISP), Supplier, Manufacturer, and so on.

Partner User

They can use the transactional system and request for a special price, request for

funds, submit referrals, and register deals. They can also request for an account via
self-service and these requests will be routed to partner administrators for approval. They
can manage a user’s profile, preferences, view their company profile, manage objects
that they have access to and can also purchase things from the store.

Personalize

A function that allows a user to customize many different pages to accommodate specific
needs.

Program

Programs are used to segment partners and provide different benefits to partners.
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Program Benefit

Programs are used to segment partners and provide different benefits to
partners. Partners enrolled in programs can enjoy special benefits like
leads, opportunities, marketing development funds, referrals, deals, and special pricing.

Prospect

Prospective customers who have not previously purchased products or services.

Record

A collection of related Fields. All of the fields in a record contain data relating to a
single item.

Referral

Partners can submit referrals and receive a commission for referring the

business. Partners can refer business opportunities that they cannot fulfill directly. For
example, the customer is interested in a product that the reseller does not resale. The
partner can then submit a referral and receive a percentage of the revenue generated.

Reseller

A business that buys goods from a manufacturer and resells them to customers
unchanged.

Similar Special Pricing Request

Special pricing provides approval with a decision support tool to compare similar
requests and link similar requests. This mechanism ensures legal compliance with

U.S. pricing laws. It essentially enables you to ensure similar pricing. Regardless of your
geography, it enables you to ensure the same or similar pricing for all special pricing
requests for a particular end-customer deal.

Special Pricing

Special Pricing enables you to automate and streamline the special pricing process in
which your partners request discounts on sales deals. You can respond quickly and
intelligently to your partners’ requests for special, discounted pricing, thus closing
more sales and increasing partner loyalty.

Special Pricing Claim

When a special pricing request is approved, partners can close the sale at the discounted
price and submit a claim to collect payment.

Special Pricing Request

A special pricing request enables partners to request discounted pricing from you. They
can request discounts on competitive sales deals, specific end-customer deals, and on
inventory that they have not been able to move.

Special Pricing Request Type

The request types are:

* Meet Competitor Price: When a partner wants to match a competitor’s price, they
can ask you to reduce the price to complete a sale.

e Bid Request: When a partner wants to win a deal for a specific end-customer.



e Blanket Request: When a partner has inventory in his warehouse and has not been
able to move it, they can ask for a discount to move the unsold inventory.

Special Pricing Liability

The liability is the amount of money that you have committed to pay out to your channel

partners for discounts but have not yet paid out.

Status

Statuses are assigned to various marketing objects to let users and the system know the

state of the object. Changes in status may be affected by the user or may be affected by

the system, particularly those status changes requiring approval.

Structured Query Language (SQL)

Sometimes pronounced Sequel, Structured Query Language is a standard for

querying, or asking questions of, a database.

Single Assignment

In this routing option, the opportunity is routed only to one partner.

Summary Page

Summary pages, which are a list of marketing objects, appear under many tabs and
horizontal navigation links. To view a marketing object’s details, click the object’s name.

Tab

Main divisions within the user interface of Oracle Partners.

TAP

Territory Assignment Program. This is a CRM common module that enables businesses
to allocate resources based on territory definitions.

TCA or Trading Community Architecture

Oracle’s single customer database architecture for all types of customers.

Vendor

A business entity that is engaged in the activity of selling products and/or providing
services to the market place.

Workflow

Oracle Workflow automates and continuously improves business processes, routing
information of any type according to business rules you can change. Oracle Workflow
manages business processes according to rules that you define. The rules, which we
call a workflow process definition, include the activities that occur in the process and
the relationship between those activities. An activity in a process definition can be an
automated function defined by:

e aPL/SQL stored procedure or an external function
* anotification to a user or role that they may request a response
* abusiness event

* asubflow that itself is made up of many activities.
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Workflow Attributes

Workflow attributes control the behavior of the workflow.

Workflow Monitor

The workflow monitor is a Java based tool used for administering and viewing
workflow process.
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